User Manual
for Leapfrog Geo version 2.1
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locating an Object From the Scene</td>
<td>28</td>
</tr>
<tr>
<td>Clicking in the Scene</td>
<td>28</td>
</tr>
<tr>
<td>Clicking in the Scene List</td>
<td>29</td>
</tr>
<tr>
<td>Using the Moving Plane</td>
<td>30</td>
</tr>
<tr>
<td>Slicing Through the Data</td>
<td>31</td>
</tr>
<tr>
<td>Measuring in the Scene</td>
<td>31</td>
</tr>
<tr>
<td>Determining an Object’s Size</td>
<td>33</td>
</tr>
<tr>
<td>Determining a Location</td>
<td>33</td>
</tr>
<tr>
<td>Using the Ruler to Measure Distances</td>
<td>35</td>
</tr>
<tr>
<td>Drawing in 3D</td>
<td>36</td>
</tr>
<tr>
<td>Drawing With the Curved Line Tool</td>
<td>37</td>
</tr>
<tr>
<td>Adjusting the Polyline</td>
<td>38</td>
</tr>
<tr>
<td>Adding Surface Tangents</td>
<td>39</td>
</tr>
<tr>
<td>Using the Surface Ribbon and Inside/Outside Labels</td>
<td>40</td>
</tr>
<tr>
<td>Flipping the Polyline</td>
<td>40</td>
</tr>
<tr>
<td>Drawing With the Straight Line Tool</td>
<td>40</td>
</tr>
<tr>
<td>Flipping the Line</td>
<td>42</td>
</tr>
<tr>
<td>Using the Surface and Normal Ribbons</td>
<td>42</td>
</tr>
<tr>
<td>Changing Preferences</td>
<td>43</td>
</tr>
<tr>
<td>Changing Display and Navigation Settings</td>
<td>43</td>
</tr>
<tr>
<td>Acceleration Mode</td>
<td>43</td>
</tr>
<tr>
<td>Font Size</td>
<td>43</td>
</tr>
<tr>
<td>Z-Axis Scale</td>
<td>43</td>
</tr>
<tr>
<td>Rotation Settings</td>
<td>44</td>
</tr>
<tr>
<td>Camera Settings</td>
<td>44</td>
</tr>
<tr>
<td>Changing Overlay Preferences</td>
<td>44</td>
</tr>
<tr>
<td>Screen Grid Settings</td>
<td>44</td>
</tr>
<tr>
<td>Axis Lines Settings</td>
<td>44</td>
</tr>
<tr>
<td>Other Settings</td>
<td>45</td>
</tr>
<tr>
<td>Changing the Colour Scheme</td>
<td>45</td>
</tr>
<tr>
<td>Changing Lighting Preferences</td>
<td>45</td>
</tr>
<tr>
<td>Changing Processing Preferences</td>
<td>45</td>
</tr>
<tr>
<td>Changing Help Preferences</td>
<td>46</td>
</tr>
<tr>
<td>Changing the 3D Acceleration Mode</td>
<td>46</td>
</tr>
<tr>
<td>Scaling the Z Axis</td>
<td>46</td>
</tr>
<tr>
<td>Visualising Data</td>
<td>49</td>
</tr>
<tr>
<td>Using the Shape List and Shape Properties Panel</td>
<td>50</td>
</tr>
<tr>
<td>Changing an Object’s Display Colour</td>
<td>53</td>
</tr>
<tr>
<td>Changing a Colormap</td>
<td>53</td>
</tr>
<tr>
<td>Editing a Continuous Colormap</td>
<td>54</td>
</tr>
<tr>
<td>Creating a Discrete Colormap</td>
<td>54</td>
</tr>
</tbody>
</table>

© 2014 ARANZ Geo Limited
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using a Colourmap to Display Dates</td>
<td>56</td>
</tr>
<tr>
<td>Importing and Exporting Colourmaps</td>
<td>56</td>
</tr>
<tr>
<td>Exporting a Colourmap</td>
<td>57</td>
</tr>
<tr>
<td>Importing a Colourmap</td>
<td>57</td>
</tr>
<tr>
<td>Displaying Drillholes</td>
<td>57</td>
</tr>
<tr>
<td>Displaying Drillholes as Lines or Cylinders</td>
<td>58</td>
</tr>
<tr>
<td>Hiding Lithologies</td>
<td>59</td>
</tr>
<tr>
<td>Displaying a Legend</td>
<td>60</td>
</tr>
<tr>
<td>Changing Colourmaps</td>
<td>60</td>
</tr>
<tr>
<td>Viewing Multiple Interval Tables</td>
<td>61</td>
</tr>
<tr>
<td>Selecting From Multiple Columns</td>
<td>61</td>
</tr>
<tr>
<td>Displaying Interval Data in the Scene</td>
<td>62</td>
</tr>
<tr>
<td>Displaying Points Data</td>
<td>63</td>
</tr>
<tr>
<td>Displaying Surfaces</td>
<td>65</td>
</tr>
<tr>
<td>Displaying Structural Data</td>
<td>66</td>
</tr>
<tr>
<td>Viewing Data with the Slicer in the Scene</td>
<td>67</td>
</tr>
<tr>
<td>Viewing GIS Data</td>
<td>67</td>
</tr>
<tr>
<td>Creating Custom Topography Views</td>
<td>68</td>
</tr>
<tr>
<td>Evaluating Objects</td>
<td>70</td>
</tr>
<tr>
<td><strong>Defining Boundaries in a Leapfrog Geo Project</strong></td>
<td>71</td>
</tr>
<tr>
<td>Setting a Clipping Boundary</td>
<td>71</td>
</tr>
<tr>
<td>Defining a Topography</td>
<td>73</td>
</tr>
<tr>
<td>Creating the Topography Using an Elevation Grid</td>
<td>74</td>
</tr>
<tr>
<td>Creating the Topography From a Surface, Points or GIS Vector Data</td>
<td>74</td>
</tr>
<tr>
<td>Setting a Fixed Elevation</td>
<td>74</td>
</tr>
<tr>
<td>Adding Height Data to the Topography</td>
<td>75</td>
</tr>
<tr>
<td>Changing Topography Settings</td>
<td>76</td>
</tr>
<tr>
<td>Changing the Size of the Topography</td>
<td>76</td>
</tr>
<tr>
<td>Changing the Resolution of the Topography</td>
<td>76</td>
</tr>
<tr>
<td>Applying a Trend to the Topography</td>
<td>77</td>
</tr>
<tr>
<td>Displaying Topography in the Scene Window</td>
<td>77</td>
</tr>
<tr>
<td>Projecting Collars Onto the Topography</td>
<td>78</td>
</tr>
<tr>
<td>Setting Object Extents</td>
<td>79</td>
</tr>
<tr>
<td><strong>Importing and Working with Drillhole Data</strong></td>
<td>81</td>
</tr>
<tr>
<td>Importing Drillhole Data</td>
<td>81</td>
</tr>
<tr>
<td>Expected Drillhole Data Format</td>
<td>84</td>
</tr>
<tr>
<td>The Collar Table</td>
<td>85</td>
</tr>
<tr>
<td>Interval Tables</td>
<td>85</td>
</tr>
<tr>
<td>The Screens Table</td>
<td>85</td>
</tr>
<tr>
<td>The Survey Table</td>
<td>86</td>
</tr>
<tr>
<td>Selecting the ODBC Data Source</td>
<td>86</td>
</tr>
</tbody>
</table>

© 2014 ARANZ Geo Limited
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connecting to an acQuire Database</td>
<td>86</td>
</tr>
<tr>
<td>Saving a Selection</td>
<td>87</td>
</tr>
<tr>
<td>Appending Drillholes</td>
<td>87</td>
</tr>
<tr>
<td>Importing Interval Tables</td>
<td>87</td>
</tr>
<tr>
<td>Importing Columns</td>
<td>88</td>
</tr>
<tr>
<td>Importing Screens</td>
<td>88</td>
</tr>
<tr>
<td>Importing Point Values Down Drillholes</td>
<td>88</td>
</tr>
<tr>
<td>Importing Downhole Structural Data</td>
<td>89</td>
</tr>
<tr>
<td>Using the Table Dialog</td>
<td>90</td>
</tr>
<tr>
<td>Drillhole Desurveying in Leapfrog Geo</td>
<td>90</td>
</tr>
<tr>
<td>Spherical Arc Approximation</td>
<td>91</td>
</tr>
<tr>
<td>Raw Tangent</td>
<td>91</td>
</tr>
<tr>
<td>Balanced Tangent</td>
<td>92</td>
</tr>
<tr>
<td>Changing Survey Table Options</td>
<td>92</td>
</tr>
<tr>
<td>Correcting Drillhole Data Errors</td>
<td>94</td>
</tr>
<tr>
<td>Exporting Drillhole Data Errors</td>
<td>94</td>
</tr>
<tr>
<td>Correcting Drillhole Data Errors in Leapfrog Geo</td>
<td>95</td>
</tr>
<tr>
<td>Checking for Missing Files</td>
<td>96</td>
</tr>
<tr>
<td>Ignoring Errors</td>
<td>96</td>
</tr>
<tr>
<td>Modifying Data</td>
<td>96</td>
</tr>
<tr>
<td>Fixing Collar Maxdepths</td>
<td>96</td>
</tr>
<tr>
<td>Replacing All</td>
<td>97</td>
</tr>
<tr>
<td>Replacing a Selection</td>
<td>98</td>
</tr>
<tr>
<td>Handling Special Values in Drillhole Data</td>
<td>98</td>
</tr>
<tr>
<td>Processing Drillhole Data</td>
<td>100</td>
</tr>
<tr>
<td>Compositing Category Data</td>
<td>101</td>
</tr>
<tr>
<td>Converting Ignored Segments</td>
<td>102</td>
</tr>
<tr>
<td>Filtering Interior and Exterior Short Segments</td>
<td>104</td>
</tr>
<tr>
<td>Compositing Numeric Data</td>
<td>105</td>
</tr>
<tr>
<td>Grouping Lithologies</td>
<td>107</td>
</tr>
<tr>
<td>Automatically Creating Lithology Groups</td>
<td>110</td>
</tr>
<tr>
<td>Splitting Lithologies</td>
<td>111</td>
</tr>
<tr>
<td>Selecting Intervals</td>
<td>114</td>
</tr>
<tr>
<td>Creating an Overlaid Lithology Column</td>
<td>117</td>
</tr>
<tr>
<td>Creating a New Category Column from Numeric Data</td>
<td>118</td>
</tr>
<tr>
<td>Back-flagging Drillhole Data</td>
<td>119</td>
</tr>
<tr>
<td>Viewing Correlation Statistics</td>
<td>119</td>
</tr>
<tr>
<td>Creating a New Merged Drillhole Data Table</td>
<td>119</td>
</tr>
<tr>
<td>Adding Core Photo Links</td>
<td>120</td>
</tr>
<tr>
<td>Setting Up the ALS Interface</td>
<td>121</td>
</tr>
<tr>
<td>Using the ALS Interface</td>
<td>123</td>
</tr>
</tbody>
</table>

© 2014 ARANZ Geo Limited
<table>
<thead>
<tr>
<th>Contents</th>
<th>v</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting Up the Coreshed Interface .................................................. 123</td>
<td></td>
</tr>
<tr>
<td>Using the Coreshed Interface .......................................................... 124</td>
<td></td>
</tr>
<tr>
<td>Deleting Drillhole Data ........................................................................ 125</td>
<td></td>
</tr>
<tr>
<td>Reloading Drillhole Data ................................................................. 125</td>
<td></td>
</tr>
<tr>
<td>Exporting Drillhole Data ....................................................................... 125</td>
<td></td>
</tr>
<tr>
<td>Exporting All Drillhole Data .............................................................. 126</td>
<td></td>
</tr>
<tr>
<td>Exporting a Single Drillhole Data Table .............................................. 126</td>
<td></td>
</tr>
<tr>
<td>Importing and Working with Other Data Types ...................................... 127</td>
<td></td>
</tr>
<tr>
<td>Importing and Working with GIS Data, Maps and Images ......................... 128</td>
<td></td>
</tr>
<tr>
<td>Importing GIS Data ............................................................................. 128</td>
<td></td>
</tr>
<tr>
<td>Importing Maps and Images ................................................................. 129</td>
<td></td>
</tr>
<tr>
<td>Georeferencing in Leapfrog Geo ......................................................... 130</td>
<td></td>
</tr>
<tr>
<td>Manual Georeferencing ....................................................................... 130</td>
<td></td>
</tr>
<tr>
<td>Automatic Georeferencing .................................................................. 134</td>
<td></td>
</tr>
<tr>
<td>Exporting a Georeferenced Image ......................................................... 134</td>
<td></td>
</tr>
<tr>
<td>Importing 2D Grids ............................................................................. 135</td>
<td></td>
</tr>
<tr>
<td>Importing a MapInfo Batch File ............................................................ 136</td>
<td></td>
</tr>
<tr>
<td>Importing Data From an ESRI Geodatabase ............................................ 137</td>
<td></td>
</tr>
<tr>
<td>Setting Elevation for a GIS Object ....................................................... 137</td>
<td></td>
</tr>
<tr>
<td>Creating a New GIS Lines Object ......................................................... 138</td>
<td></td>
</tr>
<tr>
<td>Drawing a New GIS Lines Object ......................................................... 138</td>
<td></td>
</tr>
<tr>
<td>Exporting GIS Data ............................................................................. 139</td>
<td></td>
</tr>
<tr>
<td>Importing and Working with Points Data .............................................. 140</td>
<td></td>
</tr>
<tr>
<td>Importing Points Data ......................................................................... 140</td>
<td></td>
</tr>
<tr>
<td>Appending Points Data ....................................................................... 140</td>
<td></td>
</tr>
<tr>
<td>Extracting Points from Drillhole Data .................................................. 140</td>
<td></td>
</tr>
<tr>
<td>Extracting Contact Points from Drillhole Data ....................................... 141</td>
<td></td>
</tr>
<tr>
<td>Extracting Intrusion Values from Drillhole Data ..................................... 142</td>
<td></td>
</tr>
<tr>
<td>Changing Intrusion Point Generation Parameters ................................... 143</td>
<td></td>
</tr>
<tr>
<td>Extracting Interval Midpoints from Drillhole Data .................................. 144</td>
<td></td>
</tr>
<tr>
<td>Importing Geophysical Data .................................................................. 145</td>
<td></td>
</tr>
<tr>
<td>Creating a Grid of Points .................................................................... 145</td>
<td></td>
</tr>
<tr>
<td>Exporting a Grid of Points .................................................................. 146</td>
<td></td>
</tr>
<tr>
<td>Evaluating Points Data ....................................................................... 146</td>
<td></td>
</tr>
<tr>
<td>Exporting Points Data ....................................................................... 147</td>
<td></td>
</tr>
<tr>
<td>Creating and Importing Structural Data ................................................ 148</td>
<td></td>
</tr>
<tr>
<td>Creating a New Structural Data Table ................................................... 148</td>
<td></td>
</tr>
<tr>
<td>Importing Structural Data .................................................................... 151</td>
<td></td>
</tr>
<tr>
<td>Editing Structural Data ....................................................................... 153</td>
<td></td>
</tr>
<tr>
<td>Estimating Structural Data ................................................................... 153</td>
<td></td>
</tr>
<tr>
<td>Importing, Creating and Editing Meshes ............................................... 154</td>
<td></td>
</tr>
<tr>
<td>Contents</td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>Creating the Model</td>
<td>191</td>
</tr>
<tr>
<td>Viewing the Model in the Scene</td>
<td>192</td>
</tr>
<tr>
<td>Copying a Geological Model</td>
<td>192</td>
</tr>
<tr>
<td>Creating a Static Copy of a Geological Model</td>
<td>192</td>
</tr>
<tr>
<td>Exporting Geological Model Volumes and Surfaces</td>
<td>193</td>
</tr>
<tr>
<td>Refining a Geological Model</td>
<td>194</td>
</tr>
<tr>
<td>Base Lithology</td>
<td>194</td>
</tr>
<tr>
<td>Surface Generation</td>
<td>194</td>
</tr>
<tr>
<td>Volume Generation</td>
<td>194</td>
</tr>
<tr>
<td>Surface Resolution for a Geological Model</td>
<td>194</td>
</tr>
<tr>
<td>Editing the Lithologies</td>
<td>195</td>
</tr>
<tr>
<td>Modifying the Model Boundary</td>
<td>196</td>
</tr>
<tr>
<td>Creating a Lateral Extent from a Polyline</td>
<td>197</td>
</tr>
<tr>
<td>Creating a Lateral Extent from GIS Vector Data</td>
<td>198</td>
</tr>
<tr>
<td>Creating a Lateral Extent from Points</td>
<td>199</td>
</tr>
<tr>
<td>Creating a Lateral Extent from Structural Data</td>
<td>200</td>
</tr>
<tr>
<td>Creating a Lateral Extent from a Surface</td>
<td>201</td>
</tr>
<tr>
<td>Creating a Lateral Extent from a Distance to Points</td>
<td>201</td>
</tr>
<tr>
<td>Creating a Lateral Extent from a Distance Function</td>
<td>202</td>
</tr>
<tr>
<td>Refining Extents</td>
<td>202</td>
</tr>
<tr>
<td>Creating and Refining a Base</td>
<td>203</td>
</tr>
<tr>
<td>Creating a Faulted Model</td>
<td>205</td>
</tr>
<tr>
<td>Defining Contact Surfaces</td>
<td>208</td>
</tr>
<tr>
<td>Dividing the Geological Model Volume Using the Surface Chronology</td>
<td>209</td>
</tr>
<tr>
<td>Younging Direction</td>
<td>212</td>
</tr>
<tr>
<td>Depositional and Erosional Contact Surfaces</td>
<td>212</td>
</tr>
<tr>
<td>Intrusional Contact Surfaces</td>
<td>215</td>
</tr>
<tr>
<td>Vein Contact Surfaces</td>
<td>216</td>
</tr>
<tr>
<td>Creating Depositional and Erosional Contact Surfaces</td>
<td>218</td>
</tr>
<tr>
<td>New Deposit/Erosion From the Base Lithology</td>
<td>218</td>
</tr>
<tr>
<td>New Deposit/Erosion From Other Lithology Contacts</td>
<td>222</td>
</tr>
<tr>
<td>New Deposit/Erosion From Other Data</td>
<td>223</td>
</tr>
<tr>
<td>Creating Intrusional Contact Surfaces</td>
<td>224</td>
</tr>
<tr>
<td>Compositing Intrusions</td>
<td>226</td>
</tr>
<tr>
<td>Editing Intrusions</td>
<td>226</td>
</tr>
<tr>
<td>Displaying Intrusion Points</td>
<td>226</td>
</tr>
<tr>
<td>Creating Veins</td>
<td>227</td>
</tr>
<tr>
<td>Creating Veins From Lithology Contacts</td>
<td>229</td>
</tr>
<tr>
<td>Creating Veins From Other Data</td>
<td>229</td>
</tr>
<tr>
<td>Changing Vein Surfacing Options</td>
<td>230</td>
</tr>
<tr>
<td>Setting the Vein Thickness</td>
<td>230</td>
</tr>
</tbody>
</table>

© 2014 ARANZ Geo Limited
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controlling Vein Pinch Out</td>
<td>230</td>
</tr>
<tr>
<td>Adjusting the Vein Reference Surface</td>
<td>232</td>
</tr>
<tr>
<td>Adding Data to the Reference Surface</td>
<td>233</td>
</tr>
<tr>
<td>Using a Planar Reference Surface</td>
<td>233</td>
</tr>
<tr>
<td>Changing the Vein Boundary</td>
<td>234</td>
</tr>
<tr>
<td>Adding a Polyline to the Vein Boundary</td>
<td>235</td>
</tr>
<tr>
<td>Adjusting the Vein Boundary Plane</td>
<td>235</td>
</tr>
<tr>
<td>Editing Vein Segments</td>
<td>236</td>
</tr>
<tr>
<td>Changing the Orientation of Vein Segments</td>
<td>236</td>
</tr>
<tr>
<td>Creating a Vein System</td>
<td>236</td>
</tr>
<tr>
<td>Adding Veins to the Vein System</td>
<td>238</td>
</tr>
<tr>
<td>Setting Vein Interactions</td>
<td>238</td>
</tr>
<tr>
<td>Creating Stratigraphic Sequences</td>
<td>239</td>
</tr>
<tr>
<td>Editing Contact Surfaces</td>
<td>242</td>
</tr>
<tr>
<td>The Surfacing Tab</td>
<td>243</td>
</tr>
<tr>
<td>The Trend Tab</td>
<td>243</td>
</tr>
<tr>
<td>The Value Clipping Tab</td>
<td>244</td>
</tr>
<tr>
<td>The Interpolant Tab</td>
<td>245</td>
</tr>
<tr>
<td>Copying the Surface Chronology to an Empty Fault Block</td>
<td>245</td>
</tr>
<tr>
<td>Adding Contact Surfaces to the Surface Chronology</td>
<td>245</td>
</tr>
<tr>
<td>Refining Lithological Volumes</td>
<td>247</td>
</tr>
<tr>
<td>Editing the Sub-Model</td>
<td>249</td>
</tr>
<tr>
<td><strong>Building Interpolants</strong></td>
<td>251</td>
</tr>
<tr>
<td>Interpolant Functions</td>
<td>251</td>
</tr>
<tr>
<td>The Spheroidal Interpolant Function</td>
<td>252</td>
</tr>
<tr>
<td>Spheroidal Interpolant Parameters</td>
<td>253</td>
</tr>
<tr>
<td>Sill</td>
<td>253</td>
</tr>
<tr>
<td>Nugget</td>
<td>253</td>
</tr>
<tr>
<td>Nugget to Sill Ratio</td>
<td>254</td>
</tr>
<tr>
<td>Base Range</td>
<td>254</td>
</tr>
<tr>
<td>Alpha</td>
<td>256</td>
</tr>
<tr>
<td>Drift</td>
<td>257</td>
</tr>
<tr>
<td>Accuracy</td>
<td>259</td>
</tr>
<tr>
<td>The Linear Interpolant Function</td>
<td>259</td>
</tr>
<tr>
<td>Linear Interpolant Parameters</td>
<td>260</td>
</tr>
<tr>
<td>Sill and Base Range</td>
<td>261</td>
</tr>
<tr>
<td>Nugget</td>
<td>261</td>
</tr>
<tr>
<td>Drift</td>
<td>261</td>
</tr>
<tr>
<td>Accuracy</td>
<td>262</td>
</tr>
<tr>
<td>Creating a Numeric Interpolant</td>
<td>263</td>
</tr>
<tr>
<td>Selecting the Values Used</td>
<td>263</td>
</tr>
</tbody>
</table>
Contents

Importing a Block Model in CSV Format ....................................................... 323
Exporting a Block Model .................................................................................. 325
Exporting a Block Model in a Supported Format ........................................... 325
Exporting a Block Model as Points ................................................................. 326
Creating a Block Model ................................................................................... 326

Sharing Geochemical Data with ioGAS ........................................................... 329
Sending Lithology Data to ioGAS ..................................................................... 330
Opening the Data in ioGAS ............................................................................. 330
Sending a New Data Column Back to Leapfrog Geo ....................................... 330
Importing ioGAS Data as Points ...................................................................... 331

Planning Drillholes .......................................................................................... 333
Adding Planned Drillholes .............................................................................. 333
Drillhole Planning Options .............................................................................. 335
Viewing Drilling Prognoses ............................................................................ 336
Exporting Planned Drillholes ......................................................................... 336
Importing Planned Drillholes ......................................................................... 337

Displaying and Presenting Data ....................................................................... 339
Creating and Working with Sections ............................................................... 340
Creating a Cross Section in the Scene ............................................................ 341
Creating a Cross Section from an Image ........................................................ 342
Creating a Fence Section ................................................................................ 343
Creating a Serial Section ................................................................................ 344
Setting the Base Section ................................................................................ 344
Setting the Offset Sections ............................................................................ 345
Creating the Serial Section ............................................................................ 345
Displaying a Serial Section ............................................................................. 346
Exporting a Serial Section ............................................................................. 346
Creating Section Layouts ................................................................................ 347
Creating a New Section Layout ..................................................................... 349
Using the Section Layout Editor ..................................................................... 350
Object Names and Colours ............................................................................ 353
Styling Layout Objects ................................................................................... 353
Setting Up the Page ....................................................................................... 356
Organising the Section .................................................................................. 356
Adding and Styling Models ............................................................................ 357
Adding and Styling Drillholes and Planned Drillholes ..................................... 358
Adding and Styling Surfaces .......................................................................... 361
Organising the Legend Group ........................................................................ 362
Changing the Legend Group Layout ............................................................... 363
Styling Legend Swatches ............................................................................... 363
Making Legends Visible and Invisible .............................................................. 364

© 2014 ARANZ Geo Limited
Adding and Organising Annotations ............................................. 365
Title .......................................................................................... 365
Title Block .................................................................................. 365
Scale Bar ...................................................................................... 365
Location ...................................................................................... 365
Text Boxes .................................................................................... 366
Images .......................................................................................... 366
Exporting the Section Layout ....................................................... 366
Copying a Section Layout .............................................................. 367
Exporting a Cross Section ............................................................ 367
Rendering Images ........................................................................ 368
Saving and Editing Scenes ............................................................ 369
Creating and Exporting a Movie ..................................................... 369
Exporting Scenes to Leapfrog Viewer .......................................... 371
Creating Contour Lines from a Surface .......................................... 372
Exporting GIS Contours ............................................................... 372

© 2014 ARANZ Geo Limited
Help for Leapfrog Geo 2.1

Leapfrog Geo allows rapid construction of 3D conceptual models directly from scattered drillhole and GIS data without the need for manual digitisation. Leapfrog Geo uses implicit modelling to generate geological models in hours rather than days. Leapfrog Geo uses a rapid 3D interpolation technique, FastRBF™, to construct 3D boundary models from drillhole data.

Leapfrog Geo was designed especially for geologists. Its streamlined workflow is easy to learn and use, and basic modelling techniques can be learned quickly.

To get the most out of the information in this manual, you should be familiar with Microsoft Windows™ XP, Windows™ Vista, Windows™ 7 or Windows™ 8 operating systems and with basic geological terminology. Experience with geological modelling software is not necessary.

The following conventions are used throughout this manual:

- Menu options, dialog items and buttons are in bold normal text. For example, click on the Leapfrog Geo menu and select Preferences.
- Filenames and directory paths are in monospace text. For example, C:\Program Files\Leapfrog.

Some Leapfrog Geo features are only available as part of specialist modules. See Activating Module Licences for information on installing licences for these specialist modules.

Getting Started with Leapfrog Geo

To activate a trial or dongle licence or extend an OnDemand licence, see Activating the Licence. When you first launch Leapfrog Geo, the Projects tab is displayed. See Launching Leapfrog Geo for information on using the Projects tab and managing Leapfrog Geo project files.

The Leapfrog Geo Main Window shows how the different parts of a Leapfrog Geo project are displayed in the main window and is a good starting point for getting familiar with the Leapfrog Geo user interface.

Leapfrog Geo Tutorials

Work through the Leapfrog Tutorials, which introduce basic concepts in Leapfrog Geo. The tutorials take two to four hours to complete and will get you to the point where you can start processing your own data.

Leapfrog Blog

Visit the Leapfrog blog at blog.leapfrog3d.com for geological modelling techniques and tips.
Getting Started

This section describes:

- Activating the Licence
- Launching Leapfrog Geo
- Running the Graphics Test
- Getting Support

Activating the Licence

To run Leapfrog Geo, you need a licence. There are two types:

- Trial licence. See Activating a Trial Licence.
- A dongle-based licence. See Activating a Dongle-Based Licence.

Activating a Trial Licence

When you start Leapfrog Geo without a dongle connected, a window will appear indicating that no dongle can be found:

If you wish to get a trial licence, click the first button to request a licence via the Leapfrog Geo website. If you already have a trial licence and wish to activate it, you will have received an email containing a code. Click on the Enter activation code button and enter the code in the window that appears:

Once the activation code is entered, click Activate Licence. The licence will be validated over the internet.

You can copy the activation code from the email and paste it into the first Activation Code field.

© 2014 ARANZ Geo Limited
If your organisation uses an authenticating firewall, tick the box for **Manual proxy configuration** and enter the details required.

If the code cannot be activated and you are sure you have entered the code correctly, contact Customer Support as described in [Getting Support](#).

### Activating a Dongle-Based Licence

If you have a USB dongle and need to activate your licence, plug the dongle in to your computer and start Leapfrog Geo. Leapfrog Geo will check the dongle and prompt you to start the activation process:

![Leapfrog Geo v2.1.0 activation process](image)

There are two types of dongle-based licence:

- A standard licence. Once this has been activated, the licence details will be displayed.
- An OnDemand licence. Once this has been activated, you will be prompted to check out a licence.

The activation process is the same for both types of licence.

Click **Next**. A window will appear giving you two options:

![Leapfrog Geo v2.1.0 licence selection](image)

Select the first option to install the licence over the internet. If your organisation uses an authenticating firewall, tick the box for **Manual proxy configuration** and enter the details required. Click **Install Licence**.

Select the second option to install the licence manually. You will be prompted for the file location. Navigate to the folder that contains the file and select the file. Click **Open**, then **Install Licence**.

If the licence cannot be installed, contact Customer Support as described in [Getting Support](#).

© 2014 ARANZ Geo Limited
Once the licence has been activated:

- Standard dongle-based licence. Licence details will be displayed. The Module Licences tab shows whether you have licences for any specialist modules. See Activating Module Licences for more information.

- OnDemand licence. You will be prompted to check out a licence. See Checking Out an OnDemand Licence for more information.

Checking Out an OnDemand Licence

If you have just activated your OnDemand licence, a message will appear prompting you to check out a licence:

The bars show the maximum checkout period, with each mark on the bars representing one day. Click on the bars to select days:

To install a module licence, click on the button for that licence and select the required number of days. Click Get Licence to download and install the selected licences.
Once the licence has been updated, the status of your licence will be updated and you can check out additional days:

Once Leapfrog Geo is running, you can check out additional time by selecting **Extend Licence** from the **Leapfrog Geo** menu or clicking on the button at the bottom of the main window:

### Activating Module Licences

Some Leapfrog Geo features are only available if you have a licence for a specialist module. Your module licence may be activated as part of your Leapfrog Geo licence activation. If this is the case, once the licence has been activated, the modules you are licensed for will be shown in the **Module Licences** tab:

If, however, your licence has already been activated and you wish to activate a module licence, select **Install Licence** from the **Leapfrog Geo** menu.

If you have an OnDemand licence, see [Checking Out an OnDemand Licence](#).

The process is similar to that described in [Activating a Dongle-Based Licence](#). Select whether to install the licence over the internet or from a file and then click **Install Licence**. Once the licence has been installed, the modules that have been activated will be displayed in the **Module Licences** tab.
Launching Leapfrog Geo

When you first run Leapfrog Geo, run the graphics test to test the capability of your computer’s video card. See Running the Graphics Test.

When you launch Leapfrog Geo, the main window will appear with the Projects tab displayed:

Thumbnails for the most recent projects are displayed in the Recent projects list. Click on a thumbnail to open a project.

You can also navigate directly to the required project file by clicking on Open Project File.

To start a new project, click New Project at the top of the Projects tab. The new project will be saved in the Search folder.

Once a project file has been opened, Leapfrog Geo switches to displaying the Scene View tab.

The second set of thumbnails is for projects contained in the Search folder:

- Click on the folder button ( располагается на кнопке ) to change the Search folder. The Search folder is useful if you have one folder in which you keep most of your Leapfrog Geo projects.
- Click on the Refresh button ( располагается на кнопке ) to update the list of projects in the Search folder.

See Managing Project Files for more information on Leapfrog Geo project files.
See The Leapfrog Geo Main Window for more information on how the different parts of a Leapfrog Geo project are displayed in the main window.

**Upgrading Projects**

When you open a project that was last saved in an earlier version of Leapfrog Geo, you may be prompted to upgrade the project. A list of affected objects will be displayed. For large projects with many objects that need to be reprocessed, the upgrade process may take some time.

It is a good idea to back up the project before opening it. Tick the Back up the project before upgrading button, then click Upgrade and Open. Navigate to the folder in which to save the backup and click Save.

For large projects with many objects, upgrading without backing up the project is not recommended.

**Converting Leapfrog Hydro Projects**

Leapfrog Hydro projects can be converted to Leapfrog Geo projects. However, the process is one-way, and projects opened in Leapfrog Geo can no longer be opened in Leapfrog Hydro.

When you open a Leapfrog Hydro project, you will be prompted to save a backup before converting the project:

Once a Leapfrog Hydro has been converted to Leapfrog Geo, it can no longer be opened in Leapfrog Hydro. It is strongly recommended that you back up the project before converting it.

In the Projects tab, the thumbnails for unconverted Leapfrog Hydro projects in the Search folder will be marked as Leapfrog Hydro projects:
Managing Project Files

Leapfrog Geo project files use the extension .aprod. A folder is also created that contains information used by the project.

Do not change the name of this folder or alter its contents. Doing so could render your project file unusable.

A .lock file is created when a project is opened. The .lock file protects the project from being moved while the project is open and from being opened by another instance of Leapfrog Geo, which can happen when projects are saved on shared network drives.

Saving Projects

Leapfrog Geo automatically saves an open project each time a processing task has been completed or settings have changed. Projects are also saved when they are closed so that scene settings can be restored when the project is next opened.

Saving Zipped Copies

You can save a zipped copy of a project by selecting **Save A Zipped Copy** from the Leapfrog Geo menu. You will be prompted to choose a name and location for the zipped project. Click **Save** to create the zip file.

Saving a Backup Copy of a Project

You can save a backup copy of a project by selecting **Save A Copy** from the Leapfrog Geo menu. You will be prompted to choose a new name and location for the saved project. Click **OK** to create the new project file. Leapfrog Geo will save a copy of the project in the location selected.

Once the backup copy is saved, you can open and use it from the Projects tab. Otherwise, you can keep working in the original copy of the project.

Compacting Projects

When you delete objects from a project file, Leapfrog Geo retains those objects but notes that they are no longer used. Over time, the project file will grow in size and data stored in the database may become fragmented.

Compacting a project removes these unused objects and any unused space from the database. When you compact a project, Leapfrog Geo will close the project and back it up before compacting it. Depending on the size of the project, compacting it may take several minutes. Leapfrog Geo will then reopen the project.

To compact a project, select **Compact This Project** from the Leapfrog Geo menu. You will be asked to confirm your choice.

© 2014 ARANZ Geo Limited
Reporting a Problem

If Leapfrog Geo encounters an error, the **Leapfrog Geo Problem** window will be displayed. Enter as much information as you can about the problem, then click **Send**.

Running the Graphics Test

Leapfrog Geo can run in one of three acceleration modes. These modes are selected by clicking on the button at the bottom of the main window:

See [Changing the 3D Acceleration Mode](#) for more information on these settings.

When you first run Leapfrog Geo, run the graphics test to test the capability of your computer’s video card.

To start the test, open Leapfrog Geo and select **Test Graphics** from the **Leapfrog Geo** menu:

The graphics test displays a series of image pairs that test the capabilities of your video card for the currently selected acceleration mode. For each pair, compare the images:
Even if the differences are slight, click the **Images Differ** button. If the images match, click the **Images Match** button. The next test will be displayed.

At the conclusion of the test, the result is displayed. If one or more tests have failed, information about solving problems will be displayed.

If you click on **Save Report**, you will be prompted to save the file on your computer.

If the test has failed, try switching to a different acceleration mode and running the test again. If possible, avoid using **Software Rendering** as it can be very slow.

If you cannot resolve the problem following the steps described in Troubleshooting Video Card Issues, save a copy of the graphics test report and contact technical support as described in Getting Support. Be sure to include information about your system copied from the **About > System Info** tab.

**Troubleshooting Video Card Issues**

If the graphics test fails, there are two steps you can take to correct the problem:

- Ensure your video driver is up-to-date. See Updating Your Video Card Driver.
- Check your video card's 3D/OpenGL settings. See Checking Your 3D/OpenGL Settings.

**Updating Your Video Card Driver**

The best way to update your video driver is to do this using any tools that your computer's manufacturer provides. For example, some manufacturers allow you to update drivers using a tool installed in the **Start** screen (Windows 8) or **Start** menu (Windows 7 and Windows XP). Look for items that carry the manufacturer's name. Another option is to right-click on the desktop to see if there is an update tool available. In the example below, the manufacturer has included an option for updating video drivers called "NVIDIA Control Panel":

If your computer appears to have no manufacturer-installed tools for updating drivers, you can go to the manufacturer's website and see if updates are available there. Look for parts of the website relating to support and driver downloads or driver updates.

If your computer's manufacturer does not provide information to help you update your video driver, you can run the **Hardware Update Wizard** to see if a newer driver is available. To do this:

1. Open the **Control Panel**.
2. Open the **System** option.
3. Switch to the **Hardware** tab.
4. Click on the **Device Manager** option.
5. Click to open the **Display adapters** option.
6. Right-click on the display adapter and choose the **Update Driver** option:

![Update Driver window](image)

Next, follow the steps to complete the wizard. If the wizard cannot update your software because your computer already has the latest software, it may be that your video driver is already up-to-date and that the reason the graphics test fails may lie in the card’s 3D/OpenGL settings. See [Checking Your 3D/OpenGL Settings](#).

If your video card’s driver has been updated, run the graphics test again to see if the computer passes the tests. If the test still fails, contact technical support as described in [Getting Support](#). Be sure to include information about your system copied from the **About > System Info** tab.

### Checking Your 3D/OpenGL Settings

The step or steps at which your computer fails the graphics test may indicate what 3D/OpenGL settings need to be changed. Save the graphics test report, as described in [Running the Graphics Test](#) and contact technical support as described in [Getting Support](#).

### Getting Support

Technical support is available by visiting [http://www.leapfrog3d.com/contact/support](http://www.leapfrog3d.com/contact/support).

When contacting technical support, please include your licence number and a full description of the problem or query, including any information provided in system error messages.
You can access your licence information by selecting **About** from the **Leapfrog Geo** menu:

You may also be asked to provide a copy of the log files. To find out where these are stored, select **About** from the **Leapfrog Geo** menu, then click on the **System Info** tab. Click on the link to open the folder that contains the log files:
The Leapfrog Geo Main Window

The Leapfrog Geo main window is divided into three main parts:

1. **The Project Tree** contains all the data in the project and tools for working with that data. When you want to change how this data is used in the project, work with the objects in the project tree.

2. The **Scene View** tab displays a 3D representation of selected objects from the project tree. Changing how you view objects in the scene window does not change those objects in the project tree.

3. Tools for changing the appearance of data in the scene window are available in the shape list and the shape properties panel. Changing the appearance of these objects does not change those objects in the project tree.

You can add objects to the scene window by dragging them from the project tree. You can temporarily hide them in the scene or remove them altogether using the controls in the shape list.

When you open a Leapfrog Geo project, the project is displayed in the state it was in when it was closed.

© 2014 ARANZ Geo Limited
You can split the Leapfrog Geo main window into separate parts to make better use of your screen space.
To detach a tab, click on it and drag it away from the main window. You can then move and resize the detached tab.

You can also detach a tab by right-clicking on it and selecting **Detach**.
Detached tabs can be docked by dragging them onto the main window. When the tab becomes partially transparent, release the mouse button; the tab will dock onto the main window.

To detach the project tree, right-click at the top of the project tree and select **Detach**:

To reattach the project tree, drag it to the main window as you would when reattaching a tab. You can also reattach it by clicking the red X to close the project tree.

The **Scene View** tab is made up of the scene window, the shape list and the shape properties panel. The shape list and shape properties panel can be displayed on the righthand side of the scene rather than below the scene. To do this, right-click in the shape list and select **Move List to Right**.
You can also detach the shape list and display it as a tab, which can then be detached from the main window. To do this, right-click in the shape list and select **Put List in Separate Tab**:

You can then detach the tab from the main window:

To dock the shape list to the **Scene View** tab, right-click in the **Shape List** tab and choose where you wish to dock the list:

The shape list and shape properties panel can also be minimised. Restore the shape list by clicking on the button at the bottom of the Leapfrog Geo main window:

---

**Working with the Project Tree**

The series of folders in the project tree are used to organise objects such as maps, images and data sets into categories. These folders also provide tools that let you import information into the project and generate models. Right-click on each folder to view the actions you can perform using that folder.
You can also right-click on objects within the top-level folders to view more information on that object or carry out actions specific to that object. For example, right-clicking on a table of imported drillhole data reveals a menu showing possible actions:

![Right-click menu example]

When a bold option appears in the right-click menu, as **Open** does in the menu above, that option can also be selected by double-clicking on the object.

You can select more than one object in the project tree by holding down the Shift key or the Ctrl key while clicking. This is useful for viewing or deleting multiple objects at once.

Some actions are not available until data has been imported into the project.

Some objects may appear in the project tree as restricted:

![Restricted objects example]

Restricted objects were created using features only available in modules. You can display restricted objects in the scene and change how they are displayed, but you cannot make changes to the objects themselves. Contact Customer Support as described in **Getting Support** for more information about licensing modules.

The key to working with the project tree is to realize that it is organized from the top down. In many software packages (including Leapfrog Geo), the tree is organized to start from the data and work towards the outputs or models created from the data. This works well in problems that support a defined step-by-step workflow where it is not necessary to combine data from many sources. In complicated models, though:

- It’s easy to become lost in the amount of data in the project.
- It’s often hard to know where to start.
- It’s sometimes difficult to see how the model was created.

The way folders and objects are organised in the project tree lets you reveal or hide information about an object to focus on objects you are currently working with. This is also useful when you are exploring a project and want to determine how something was put together. Leapfrog Geo projects can be complex and the number of objects in the project tree can seem overwhelming. The arrows next to objects in the project tree let you reveal
or hide an object’s details to focus on objects you are currently working with. Here, the **Topographies** folder is expanded to show a **Topography** object that is made up of a mesh:

The mesh itself is stored in the **Meshes** folder, but is hyperlinked to from wherever it is used in the project. The **Drillhole Data** folder and the **Drillholes** object have been expanded to show the drillhole data tables. Tables shown in bold are those displayed in the scene.

Folders that have no arrow have no detail stored.

Expanding a geological model reveals information about how it was built. Here, a geological model has been expanded to show the basic objects that make up a model:

The five objects underneath the geological model “GM” represent the five basic parts of a geological model:

- The **Boundary** object defines the outer limits of the geological model.
- The **Fault System** object defines faults and their interactions in the geological model.
The Lithologies object defines the lithologies in the model.

The Surface Chronology object defines the structure of the model’s contact surfaces.

The Output Volumes folder contains the generated units (outputs) that make up the geological model.

Here, boundary objects for a geological model have been expanded to show how they were created:

The Topography object is included as the model’s upper boundary. The “East boundary” object was created using a polyline from the Polylines folder and the “West boundary” object was created using a GIS data object in the GIS Data, Maps and Photos folder. Clicking on the hyperlinks will locate the object from which the extent was created.

Processing Tasks

The processing queue button shows how many tasks are currently being processed:

Objects will be added to the processing queue when you make changes to them via the project tree.

- To view the queue and progress on processing, click the queue button or press Alt + P.
- To pause processing, press Ctrl + P. To resume processing, press Ctrl + P again.

The button will turn grey when all processing is complete.

You can close a project while it is still running tasks. When you next open the project, the remainder of the tasks in the processing queue will be processed.

Prioritising Tasks

Tasks can be prioritised and their inputs processed before other objects. To prioritise a task, right-click on an object in the project tree and select Prioritise. Prioritised tasks are marked in the project tree with an arrow:
Prioritising an object is useful when you are editing it and wish to view the effect of changes without reprocessing all objects in the project. For example, you may be modifying a boundary or contact surface for a geological model. You can prioritise the surface, then run it each time you make changes.

To run only prioritised tasks, click the processing queue button, then click **Priority Only**:

The processing queue button will change to show that only priority tasks will be run:

The number of objects that have been prioritised is indicated by the button at the top of the project tree ( ![3](image) ). To view prioritised tasks, click the button. All prioritised objects will be selected and displayed in the project tree.

To reset a priority object, right-click on it and select **Clear Priority**. Click the processing queue button, then click **Run All** to resume normal processing.

**Correcting Errors**

If processing of an object fails, all other objects dependent on that object will also fail. Click the processing queue button to view the errors. To inspect the source of error, right-click on the object in the task queue and select **Go to Project Tree**:

Right-click on the object in the project tree, then select **Properties**. The **Errors** tab shows information on any processing errors for the object and may be helpful in fixing the error.
Naming and Renaming Objects in the Project Tree

When an object is created in Leapfrog Geo, it is given a default name. It is a good idea to give objects in Leapfrog Geo names that will help you distinguish them from other objects, as large projects with complicated models will contain many objects.

To rename an object in the project tree right-click on the object and select **Rename**. The **Rename Object** window will be displayed:

Enter a new name for the object. Click **Rename** to change the object’s name.

Another aid to documenting work in a project is comments. See [Commenting on Objects in the Project Tree](#).

Commenting on Objects in the Project Tree

You can record comments on any object in the project tree, which can be helpful when the project contains many objects and when several different people are working on a model. Objects that have comments are indicated in the project tree by a comment balloon (嗟). The comment will be displayed when you right-click on the object:

Tab or click to add a new comment or edit an existing one. You can also add standard information to a comment, such as date and time.

You can add information about the project as a whole using the **Notes** object (_basename_ ), which is the last object in the project tree. Double-click on the **Notes** object to open it and add information.

Viewing Object Properties

You can view the properties of most objects imported into or created in Leapfrog Geo. To do this, right-click on the object in the project tree and select **Properties**.

The information available in the **Properties** window depends on the type of object. There are three tabs that appear for each type of object:

- The **Processing** tab shows the current status of the processing (queued to process, processing, finished).
- The **Errors** tab shows errors that have occurred while processing the object. See [Processing Tasks](#).

Many objects also have a **General** tab that summarises information about the object. The amount of information in the **General** tab will vary according to the type of object. For example, for table objects, the **General** tab shows the table's data structure.

Other tabs included in the **Properties** window for some objects are:

- **The Histogram Tab**
- **The Statistics Tab**

### The Histogram Tab

When you view properties for interval tables and numeric data tables, the **Histogram** tab shows the distribution of the data in a particular column:

![Histogram](image)

If the table contains several columns, you can display histograms for each column. If so, you will be able to choose the other columns from the dropdown box. You can also:

- Adjust the number of intervals in the histogram by changing the **Bin count**.
- Remove values less than zero by ticking the **Semilog X** box.

Changes made to the way the histogram is displayed are not saved when the **Properties** window is closed.
The Statistics Tab

When you view properties for some objects, a Statistics tab is available. For example, the Statistics tab for an interpolant shows the distribution statistics for each output volume:

![Statistics Tab Example](image)

You can copy the information displayed in the Statistics tab to the clipboard for use in other applications. When a grid of points has been evaluated against interpolants and geological models, the Statistics tab for the grid will display statistics for the interpolant evaluations against geological model categories:

![Statistics Tab Example](image)

If multiple geological models and interpolants have been evaluated, you can select the evaluated models and interpolants from the dropdown lists. Copying the data only copies the data currently displayed for the selected model and interpolant.

Sharing Objects

Some objects are created as part of working with other objects and are not available elsewhere in the project. An example of this is a polyline drawn as part of creating a geological model boundary. To share such objects
within the project, right-click on the object in the project tree and click **Share**. The shared object will be copied to the relevant location in the project tree and a hyperlink added to the object it was shared from.

For example, here a polyline created as a lateral extent is shared:

The polyline is saved to the **Polylines** folder and a hyperlink to it appears as part of the geological model’s boundary.

### Finding Objects in the Project Tree

To find objects in the project tree, click anywhere in the project tree and type “Ctrl-F”. The **Find** window will be displayed:

Enter the information you are searching for, then click **Backwards** or **Forwards** to locate the object in the project tree.

### Deleting Objects

When you delete an object from the project tree, a window will be displayed listing all other objects in the project that will also be deleted and those that will be reprocessed. Consider carefully the effects on other objects in the project, as once an object is deleted, it cannot be recovered.

Deleting data from the project may cause other objects to be reprocessed, which can take some time.

To delete more than one object from the tree, hold down the Shift key or the Ctrl key while selecting objects.

### Interacting with the Scene

For information on how to display objects in the scene, see [Visualising Data](#).

The best way to navigate the 3D scene in Leapfrog Geo is using the mouse. If you are running Leapfrog Geo on a laptop, it is recommended that you plug in a mouse rather than using the laptop’s touchpad for navigation. However, you can also navigate in the scene using the keyboard.
<table>
<thead>
<tr>
<th>Action</th>
<th>Mouse</th>
<th>Keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing the viewing angle</td>
<td>Click and drag to rotate the scene</td>
<td>Press the arrow keys to rotate the scene</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For smaller steps, hold down the Shift key while pressing the arrow keys</td>
</tr>
<tr>
<td>Zooming in and out of the scene</td>
<td>Use the scroll wheel</td>
<td>Press the Page Up or Page Down keys</td>
</tr>
<tr>
<td></td>
<td>Hold the right mouse button while moving the mouse</td>
<td>For smaller steps, hold down the Shift key while pressing the Page Up or Page Down keys</td>
</tr>
<tr>
<td>Panning the scene</td>
<td>Click and hold both mouse buttons, then drag</td>
<td>Hold down the Alt key while pressing the arrow keys</td>
</tr>
<tr>
<td></td>
<td>Hold the scroll wheel and drag</td>
<td></td>
</tr>
<tr>
<td>Centre an object in the scene</td>
<td>Click the scroll wheel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Click both mouse buttons together</td>
<td></td>
</tr>
</tbody>
</table>

Use the **Look** menu above the scene window to switch to different viewing angles:

If you prefer to navigate using the keyboard, use the keyboard shortcuts shown in the **Look** menu.

The current viewing angle and scale are displayed in the lower righthand corner of the scene window:
You can change how the viewing angle and scale are displayed in the **Overlays** tab of **Preferences** window. You can save the current viewing angle as a bookmark by selecting **Bookmark Viewing Angle** from the **Look** menu or by pressing Ctrl+B. Restore the bookmark by selecting **Look > Restore Bookmark** or by pressing B.

Only one viewing angle bookmark can be saved. The bookmark is not saved when Leapfrog Geo is shut down.

The scene window displays a 3D representation of selected data from the project tree. You can add objects from the project tree to the scene in two ways:

- Click on the object and drag it into the scene. Hold down the Shift key or the Ctrl key while clicking to select multiple items, then add them to the scene.
- Right-click on the object and tick the **View Object** box.

Dragging objects into the scene window may be blocked by other applications on your computer. For example, if you are sharing a screen using Skype, you will not be able to drag objects into the scene.

Once you have added objects to the scene window, you can change the appearance of those objects using the controls in the shape list and the shape properties panel.

Changing how you view objects in the scene window does not change those objects in the project tree. **Visualising Data** describes in detail how to change the visualisation of data in the scene, which is an important part of interpreting data in the project and making modelling decisions.
**Locating an Object From the Scene**

When you have a number of objects displayed in the scene, it may not be readily apparent where you can find more information about those objects. Leapfrog Geo helps you find the object in the project tree and the shape list in two ways.

**Clicking in the Scene**

Clicking on an object in the scene displays a window that contains a summary of the data and, for many objects, a link to the corresponding data in the project tree. For example, here drillhole data is displayed in the scene and clicking on a segment displays the corresponding data:

![Drillhole data in scene](image)

Note that clicking on an object in the scene also selects it in the shape list.
Clicking in the Scene List

When you have objects displayed in the shape list and want to locate them in the project tree, simply right-click on the object in the shape list and select **Go to Project Tree**:

The object's location in the project tree will be expanded and the object will be selected.
Using the Moving Plane

In Leapfrog Geo, the moving plane is used for measuring planar structures and defining coordinate system orientations. There are two tools in the toolbar that relate to the moving plane:

To use the moving plane, click the **Show plane** button ( ) and position the plane in the scene. The main axis of the moving plane is defined by the green line. The second axis is defined to be in the plane at right angles (orthogonal) to the main axis. Third axis is perpendicular to the plane.

There are three ways to position the plane. You can:

- Use the handles in the scene window to move the plane. If you cannot see the handles, click on the moving plane.

- Use the **Plane** controls in the shape properties panel to change the **Dip**, **Dip Azimuth**, **Pitch** and **Centre Point**.

- Orient the scene to look parallel to the required plane position, then click on the **Draw plane line** button ( ). Draw the required line in the scene.

Drawing the plane line is usually the most convenient method of defining a planar structure.

There are three ways to remove the moving plane from the scene:

- Click the **Show plane** button ( ).

- Click another button to select a different tool.

- In the shape list, click the delete button ( ) for the moving plane.
Slicing Through the Data

The slicer is a powerful tool for revealing data that is concealed behind other objects and for emphasising data. Slicing can be considered a form of dynamic sectioning. Two buttons in the toolbar can be used to add the slicer to the scene:

You can add the slicer to the scene by clicking the **Show slicer** button ( ). The slicer will appear in the scene and you can adjust its position using the controls in the shape list:

You can also click the **Draw slicer line** button ( ), then click and drag in the scene to cut a slice through the scene.

The scene may appear empty because the slicer has removed all visible data. Reposition the slicer or turn it off.

You can change the way the slice appears in the scene using the controls in the shape list, and finer controls are available in the shape properties panel:
Right-click on the slicer in the shape list to view more information about each option:

The **Lock to Camera** option locks the slice to the current view, so that moving the scene changes the direction of the slice.

These options can also be controlled from the **Look** menu:

The **Set to** list in the shape properties panel contains standard views, together with any sections displayed in the scene:

To move the slicing plane in a direction orthogonal to the slicing plane, hold down the Ctrl key and the right mouse button while dragging the mouse.

To change the thickness of a thick slice, hold down the Ctrl key and the middle mouse button while dragging the mouse. If you have a two-button mouse, hold both buttons.
Measuring in the Scene

Leapfrog Geo has a number of tools for making quantitative measurements in the scene. These include:

- Using the moving plane to measure trends. See Using the Moving Plane.
- Using the ruler to measure in the scene. See Using the Ruler to Measure Distances.

Determining an Object’s Size

The easiest way to find information on the size of an object is to right-click on it in the project tree and select Properties. Information on the size of the object will be displayed in the General tab.

You can also click on any object in the scene to view more information about it. This will open a window containing more information about the object.

Determining a Location

The simplest way of measuring an approximate location in the scene is to first display an object in the scene window, then position the cursor over the location. The position of the cursor is displayed at the bottom of the Leapfrog Geo window:

The position of the cursor in the scene is calculated using the depth buffer on the graphics card and so is not an exact method of measuring in the scene.
If you require an exact position, click on the object. Leapfrog Geo will compute the exact position and display it in a pop-up window:

The point selected is highlighted in the scene.
Using the Ruler to Measure Distances

You can use the ruler to measure distances in three dimensional space and between drillholes and planned drillholes.

The easiest way to use the ruler is to click on the Ruler button and click and drag between points in the scene to start making measurements. A ruler line will appear in the scene to indicate the measurement. Information about the distance measured will appear in the scene and in the shape properties panel:

The ruler tool stays active in the scene so you can make as many measurements as required.
You can also measure the distance between drillholes or between drillholes and a point. To do this, click on the **Calculate Distance** button in the shape properties panel. The **Distance Calculator** window will appear:

You can select both drillholes and planned drillholes. Click **Calculate** to calculate the distance and update the ruler in the scene. The distance value will appear in the **Distance Calculator** window.

You can also select a point in the scene by clicking the **Select** button ( ) in the **Distance Calculator** window, then clicking in the scene. The location of the point in the scene will appear in the **Distance Calculator** window.

After measuring a distance, it is a good idea to change the viewing angle to confirm that the measurement has been made between the correct points in three dimensions.

There are two ways to remove the ruler from the scene:

- Click the **Select** button ( ).
- Click the delete button ( ) for the ruler object in the shape list.

### Drawing in 3D

In Leapfrog Geo, you can draw polylines to define many surfaces, including lateral extents and contact surfaces. You can also use polylines to make adjustments to surfaces and create new GIS lines.

Leapfrog Geo has two line drawing tools: a straight line tool and a curved line tool.

- **With the curved line tool**, click to add straight segments and click and drag to add curved segments. When generating surfaces from curved polylines, the surface tangents are created from structural disks. The curved line tool can be used for drawing polylines.

- **With the straight line tool**, add a series of nodes to define the line. When generating surfaces from this type of polyline, the lines are sampled into points and the surface tangent is implied from the plane in which it is drawn. You can use the surface and normal ribbon tools to determine the orientation of the polyline. The straight line tool can be used for drawing polylines and GIS lines.
Attempting to draw in 3D can lead to unpredictable results and so it is always best to draw in two dimensions and add depth by some other means. In Leapfrog Geo, the best way to add depth when drawing is to use the slicer, but when you draw using the straight line tool, you can also draw on other objects in the scene. Before starting to draw, it is a good idea to orient the scene and add objects to it that will aid in drawing. Do not move the scene while drawing.

See:

- [Drawing With the Curved Line Tool](#)
- [Drawing With the Straight Line Tool](#)

## Drawing With the Curved Line Tool

The curved line drawing tool is used to create curved or straight lines. The curved line tool provides greater control over the shape of a polyline than the straight line tool (see [Drawing With the Straight Line Tool](#)). When generating surfaces from curved polylines, the surface tangents are created from structural disks.

<table>
<thead>
<tr>
<th>Polyline</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polyline drawn using the curved line tool can be exported in Drawing Interchange Polylines (<em>.dxf) and CSV Text (</em>.csv) formats. Polylines drawn using the straight line tool can only be exported in Drawing Interchange Polylines (*.dxf) format.</td>
<td></td>
</tr>
</tbody>
</table>

When you first start to draw a polyline with the curved line tool, the drawing toolbar and the slicer will appear in the scene.

**Orient the slicer before starting to draw, and do not move it while drawing.**

A polyline is made up of nodes ( ), which are the points drawn, and control points ( ), which adjust the curve of the line. Straight segments have no control points. To start drawing, click on the [Draw polyline](#) button ( ).

Click in the scene to add nodes to form straight segments or click and drag to add curved segments.

While drawing, the cursor indicates what actions are possible:

<table>
<thead>
<tr>
<th>Cursor</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="drawing-with-the-curved-line-tool.png" alt="" /></td>
<td>Closing the polyline. This cursor appears over the end node of the polyline. If you click, the polyline will close.</td>
</tr>
<tr>
<td><img src="drawing-with-the-curved-line-tool.png" alt="" /></td>
<td>Joining polyline segments. This cursor appears when you are drawing a different segment and move the cursor over one of the ends of another segment. Click to join the two segments together.</td>
</tr>
<tr>
<td><img src="drawing-with-the-curved-line-tool.png" alt="" /></td>
<td>Continuing the polyline. This cursor appears when you have terminated a segment and wish to start redrawing. Move the cursor over an end node, then click to start drawing again.</td>
</tr>
<tr>
<td><img src="drawing-with-the-curved-line-tool.png" alt="" /></td>
<td>A node cannot be placed at the current position. This often occurs when there are no objects in the scene that can be drawn on. Try zooming in and out of the scene or, if necessary, changing the viewing angle.</td>
</tr>
</tbody>
</table>
Here, the topography has been hidden and the scene rotated so that the different parts of the polyline can be clearly seen. Switch to the Select tool ( ) to select and move nodes and segments. Here, one of the control points is being selected:

Delete nodes or segments by clicking on them, then clicking on the Delete button ( ) or pressing the Delete key. You can select the entire length of a polyline by double-clicking on one of the segments.

When you have finished drawing, right-click in the scene to end the polyline. You can then start drawing another segment, if required.

Delete nodes or segments by clicking on them, then clicking on the Delete button ( ) or pressing the Delete key. You can select the entire length of a polyline by double-clicking on one of the segments.

When you have finished drawing, right-click in the scene to end the polyline. You can then start drawing another segment, if required.

When you right-click to finish a polyline, the right-click does not add a new node to the polyline.

Click the Save button ( ) to save the polyline. You can edit the polyline later by right-clicking on it in the project tree and selecting Edit. If the polyline is in the shape list, click on the Edit button ( ).

### Adjusting the Polyline

The polyline is made up of nodes ( ), which are the points drawn, and control points ( ), which adjust the curve of the line. Straight segments have no control points.

You can:

- Move a node. Click on the Select button ( ), then click on a node and drag it into position.
- Adjust a curved segment. Click on the Select button ( ), then click on and drag one of the segment’s control points.
- Convert a straight segment to a curved segment. Click on the Select button ( ), then click on a segment. Next, click the Curved segment button ( ). Control points will be added to the segment and you can use them to adjust the curve.
• Convert a curved segment to a straight segment. Click on the Select button (.), then click on a segment. Next, click the Straight segment button (→). The control points will be deleted for the selected segment.

Adding Surface Tangents

When you first draw a polyline, it has no tangents. Tangents are added to the polyline by adding structural disks. To add a surface tangent:

1. Click on the Select button (.)
2. Rotate the scene so that you are looking in the direction of the dip for the tangent you want to set.
3. Click at the point along the segment where you want to set the tangent:

4. Click the Tangent button (↑).

A disk will appear on the polyline:

The polyline will be updated to show the effect of the new tangent.

Clicking to select a node then clicking the Tangent button (↑) adds a disk at the node. To add tangents at all nodes, double-click on a segment to select the whole line, then click the Tangent button (↑).

To change the dip of the tangent, change the viewing angle, then click the Tangent button (↑) once again. The disk and polyline will be updated.

To change the dip of all tangents, double-click on a segment to select the whole line, then click the Tangent button (↑). All disks will be updated.

To select multiple tangents, hold the Ctrl key while clicking on the disks.

You can add as many tangents as required, although it is best to keep them to a minimum.
Using the Surface Ribbon and Inside/Outside Labels

Once a tangent has been added to the polyline, new controls are available in the shape list and shape properties panel:

The Surface ribbon ( ) and inside/outside labels ( ) tools help you to determine the orientation of the polyline in the scene:

If you are having trouble seeing the surface ribbon, you can change its size using the Ribbon width control in the shape properties panel.

Flipping the Polyline

If the polyline is oriented incorrectly, click on the Select button ( ), then click the polyline to select it. Click on the Flip polyline button ( ). The inside and outside of the polyline will be swapped and the polyline will be updated in the scene.

Drawing With the Straight Line Tool

The straight line tool is used to create straight polylines and GIS lines. To draw using this tool, you add a series of nodes that define a line. When generating surfaces from this type of polyline, the lines are sampled into points and the surface tangent is implied from the plane in which it is drawn. You can use the surface and normal ribbon tools to determine the orientation of the polyline.

Polylines drawn using the curved line tool can be exported in Drawing Interchange Polylines (*.dxf) and CSV Text (*.csv) formats. Polylines drawn using the straight line tool can only be exported in Drawing Interchange Polylines (*.dxf) format.
When you first start to draw a polyline or GIS line with the straight line tool, the drawing toolbar and the slicer will appear in the scene. There are two drawing options:

- **Draw on the slicer.** Click on the **Draw on slicer** button ( ) and orient the slicer before you start to draw. Do not move the slicer while drawing.

- **Draw on other objects.** Click on the **Draw on objects** button ( ) and add the object to the scene you wish to draw on. When drawing on objects, you need to be careful to not draw on the wrong object. It is, therefore, best to include in the scene only the minimum number of objects needed to draw effectively.

To start drawing, click on the **Draw lines** button ( ). Click in the scene to add points to form the line:

In the shape list, you can control the colour of the positive (red) and negative (blue) surfaces of the line and of the line itself (green):

The **Surface ribbon** ( ) and **Normal ribbon** ( ) controls help you to determine the orientation of the polyline in the scene. These controls are described below.

While drawing, the cursor indicates what actions are possible:

<table>
<thead>
<tr>
<th>Drawing</th>
<th>Closing the line. This cursor appears over the end point of the line. If you click, a new point will be added and the line will close.</th>
</tr>
</thead>
</table>

© 2014 ARANZ Geo Limited
Joining line segments. This cursor appears when you are drawing a different segment and move the cursor over one of the ends of another segment. Click to join the two segments together.

Continuing the line. This cursor appears when you have terminated a segment and wish to start redrawing. Move the cursor over an end node, then click to start drawing again.

A point cannot be placed at the current position. This often occurs when there are no objects in the scene that can be drawn on. Try zooming in and out of the scene or, if necessary, changing the viewing angle.

You can also:

- **Move points.** Click on the Select button ( Bà ). Hold down the Ctrl key and click on the point. You can then drag it to a new position.
- **Add a point to a segment.** Click on the Select button ( Bà ), then click a segment to select it. Hold down the Ctrl key and click and drag to add the new point.
- **Delete a segment.** Click on the Select button ( Bà ). Click on the segment to select it, then on the Delete button ( Bà ).

When you have finished drawing, right-click in the scene to end the line. You can then start drawing another segment, if required.

When you right-click to finish a line, the right-click does not add a new node to the line.

Click the Save button (ù) to save the line. You can edit the line later by right-clicking on it in the project tree and selecting Edit. If the line is in the shape list, click on the Edit button (ù).

**Flipping the Line**

If you have drawn a line but have not obtained the results you expected, it may be that the line is not oriented correctly. You can flip the line so that the positive and negative sides are swapped. To do this, click on the Select button ( Bà ), then double-click the line to select it. Click on the Flip polyline button ( Bà ).

**Using the Surface and Normal Ribbons**

The Surface ribbon and Normal ribbon are tools that help you to determine the orientation of the polyline in the scene. For example, click on the Surface ribbon button (ù) to determine which side of the polyline is positive (red) and which side is negative (blue):
If you are having trouble seeing the surface ribbon, you can change its size using the **Ribbon width** control in the shape properties panel:

Clicking the **Normal ribbon** button ( ) displays a ribbon perpendicular to the surface ribbon. The properties of the normal ribbon can also be adjusted in the shape properties panel.

### Changing Preferences

In the **Preferences** window, you can change scene navigation, display and processing options. Open the **Preferences** window by clicking on the **Leapfrog Geo** menu and selecting **Preferences**:

![Preferences Window](image)

### Changing Display and Navigation Settings

In the **Preferences** window, click on **Scene** to change scene display and navigation settings. Select **Revert** to return to the settings in place when the **Preferences** window was first opened.

#### Acceleration Mode

See [Changing the 3D Acceleration Mode](#) for more information.

#### Font Size

This setting is the size of text used to display information on the grid and axes.

#### Z-Axis Scale

This setting determines the scale of the Z axis relative to the X and Y axes. See [Scaling the Z Axis](#) for more information.
Rotation Settings

The Geographic rotation and Free rotation settings determine whether or not the model displayed in the scene window can be “rolled”. With the Geographic rotation option, the azimuth and elevation can be varied, but the Z axis is constrained to be vertical. With the Free rotation option, however, the rotation of the model is not fixed to any axis and the model can be freely rolled around any axis. Select the option you prefer. When Leapfrog Geo is installed, Geographic rotation is set as the default option as it is the most commonly used.

The Rotate with left button and Rotate with right button settings determine how the mouse is used to rotate the scene:

- When Rotate with left button is selected, you can rotate the scene by holding down the left mouse button and dragging in the scene. Clicking and holding the right mouse button zooms in and out of the scene.
- When Rotate with right button is selected, holding down the right mouse button and dragging rotates the scene. However, zooming and rotating functions are not swapped. Instead, the left mouse button can only be used for clicking on different objects in the scene. Select this option if you tend to accidentally move the scene when you intend to click.

Camera Settings

The Orthographic projection and Perspective projection settings determine the view of the model in the scene window.

If Perspective projection is selected, you can change the Perspective angle using the slider. This is similar to adjusting the zoom setting on a camera. Higher angles make nearby objects larger and more distant objects smaller. Lower angles will compress the scene. Experiment with the settings to see the effect on objects in the scene.

Select the option you prefer.

Changing Overlay Preferences

In the Preferences window, click on Scene > Overlays to change what objects are included in the scene. Changes you make to these settings are automatically updated in the scene. Experiment to see what overlays you prefer. Select Revert to return to the settings in place when the Preferences window was first opened.

Screen Grid Settings

The Show screen grid setting determines whether or not the screen grid is displayed. Select the option you prefer. The Loose Spacing, Normal Spacing and Fine Spacing options determine the spacing of the grid.

Axis Lines Settings

The Axis Lines settings determine how X-Y-Z coordinates are displayed in the scene. When axis lines are enabled, the axes indicate the extent of data currently displayed in the scene.

Enable Show axis lines to display the east (red), north (green) and elevation (blue) axis lines.

Enable Put numbers on axes to display scale ticks along the grid. These are automatically adjusted to fit the extent of the data and the current zoom setting.

Enable Show whole box to display the axis lines as a box that encloses the current data set.
Other Settings

The scale bar, compass ball and viewing angle text are the navigation aids in the lower righthand corner of the scene window.

When the slicer is in the scene, text describing its position will be displayed in the lower lefthand corner if the Slicer position text option is enabled.

Changing the Colour Scheme

In the Preferences window, click on Scene > Colour Scheme to change the colour scheme used in the scene.

Leapfrog Geo is installed with three colours schemes: Default, Black Background and White Background. The scheme selected in the Schemes list will be used for all new Leapfrog Geo projects and for existing projects when they are next opened.

Experiment with the settings to see how they affect the scene window. Select Revert to return to the settings in place when the Preferences window was first opened.

To create a new scheme, click on an existing scheme. This is the scheme that will be used as a basis for defining the new scheme. Next, click the New Scheme button and change its settings.

You can revert to the colour schemes defined when Leapfrog Geo was first installed by clicking on Factory Reset.

Clicking on Factory Reset to revert to the original colour schemes deletes any custom colour schemes.

Changing Lighting Preferences

In the Preferences window, click on Scene > Lighting to change how visual effects are displayed in the scene window. You may be able to use these settings to emphasise significance in the data displayed in the scene.

The Ambient level setting determines the overall brightness of the scene.

The Specular brightness and Specular shininess settings determine how light appears to fall on the surfaces in the scene. The Specular brightness setting has a stronger effect when Specular shininess is soft.

You can have up to four light sources defined for a project. By default, two light sources are defined. Changes made to these settings are automatically applied to the scene. Select Revert to return to the settings in place when the Preferences window was first opened. You can revert to the lighting sources and settings defined when Leapfrog Geo was first installed by clicking on Factory Reset.

Changing Processing Preferences

In the Preferences window, click on Scene > Processing to change how background processing is used to run changes to data and models.

- For the Automatic option, the number of background processes will be set based on your computer’s CPU and RAM.
- For the Disabled option, tasks will be run in the main process and no background processes will be used.

Select Revert to return to the settings in place when the Preferences window was first opened.
Changing Help Preferences

Changing the 3D Acceleration Mode

Leapfrog Geo can run in one of three acceleration modes. Select a different acceleration mode by clicking the button at the bottom of the Leapfrog Geo main window:

In the 3D Acceleration window, select one of the acceleration modes:

- **Software Rendering** uses software only, for maximum compatibility with any hardware. This option can be very slow displaying all but the simplest scenes, and is provided as a fall-back if display issues cannot be resolved with either of the other two options.

- **Partial Acceleration** uses hardware acceleration that has been provided on graphics cards for many generations of graphics cards. In this mode, Leapfrog Geo renders scenes using “fixed function pipeline” hardware acceleration features that have been superceded in modern graphics cards by programmable shaders, but this legacy capability is widely supported and offers performance advantages over software rendering. Using **Partial Acceleration** can sometimes fix anomalies or problems encountered in **Full Acceleration** mode that may be due to bugs in old drivers, and it should work with even old or lower-featured hardware.

- **Full Acceleration** is the best option, assuming you have good hardware and up-to-date drivers. Because it makes use of programmable shaders provided by modern graphics cards, it is the fastest of the three modes and uses your available graphics memory more efficiently. It is the mode you should use, if your system supports it.

First, try using **Full Acceleration** and see how it renders scenes. If you seem to be having issues with how data is displayed in the scene, see [Running the Graphics Test](#) for information on testing your computer’s graphics capabilities. Note that especially when graphics cards are new on the market, there may be a number of driver versions released to address anomalies, so the use of a recent driver version is important. If using a laptop with dual graphics cards, use it with the power supply connected, and select the **Performance Graphics** option over the **Power Saving** option.

If that doesn’t resolve the graphics problems, then try **Partial Acceleration** mode. If possible, avoid using **Software Rendering** as it can be very slow.

If your current hardware is unable to support **Full Acceleration** mode, it may be worth considering upgrading your graphics card. Medium- to high-end home PC and gaming graphics cards are sufficient. High-end workstation grade cards also work very well, but you will also be paying for further capabilities that are not utilised by Leapfrog Geo.

Scaling the Z Axis

Scaling the z-axis lets you set a value greater than 1.0 for the z-axis relative to the x- and y-axes. This is useful when the area under study is very planar and extends over a wide area. In such cases, scaling the z-axis can accentuate the distribution of data along the z-axis.

To scale the z-axis, click the button at the bottom of the Leapfrog Geo main window:
The **Scale Z Axis** window will appear:

![Scale Z Axis window](image)

Enter a value equal to or greater than 1. The contents of the scene will be automatically scaled, so you can experiment with different values before choosing one that best accentuates the distribution of data. Click the **Close** button to dismiss the window.

You can also change this setting by clicking on the **Leapfrog Geo** menu and selecting **Preferences**. The z-axis can be changed in the **General** tab.
Visualising Data

Visualising data is an important part of interpreting and refining data and making modelling decisions. This part describes the tools available in Leapfrog Geo for visualising data. These tools are accessed via the shape list and the shape properties panel:

The tools available depend on the type of object being displayed:

- Drillholes can be displayed as lines or points and with the data associated with each segment. Data can be filtered using the shape properties panel controls and applying query filters.
- Multiple drillhole data tables can be displayed in the scene so that relationships between data in different tables can be explored.
- Some data can be displayed using a colour gradient, with the colourmap adjusted to enhance values of interest. Discrete colourmaps can also be applied to view numeric data in groups.
- Points data can be viewed as simple points or using the size of spheres to display associated values.
- GIS data can be viewed in its native form, on the topography or as part of a custom topography view.

Displaying and Presenting Data describes how to display data and create scenes, movies and scene files for presentation purposes.
Using the Shape List and Shape Properties Panel

Once objects have been added to the scene window, they will appear in the shape list, which can be treated as a working set of objects:

![Shape List](image)

You can use controls in the shape list and the shape properties panel to change the way those objects are displayed. This is useful in interpreting data and making modelling decisions.

Changing how you view objects in the scene window does not change those objects in the project tree.

All objects in the shape list have a button (🗑) that will remove the object from the scene. Most objects also have a visibility button (👁️) that can temporarily hide that object in the scene. It is often easier to make an object temporarily invisible than to remove it from the list. Some objects have an edit button (✍️) that you can click to begin editing the object.

The view list is available for objects that can be displayed in different ways. For example, a lithology data table may contain several columns and the column displayed can be selected from the view list:

![View List](image)

Geological model, interpolant and distance function evaluations are also selected from the view list. See Evaluating Objects.

The opacity slider controls the transparency of objects in the scene:
Property buttons vary according to the type of object. For example, property buttons can show or hide the triangles on a mesh, render points as spheres or display a surface clipped to a model boundary. You can always find out what a button does by holding the cursor over the button:

You can display a legend for many objects, including lithologies. To do this, click the legend button in the shape list:

To remove the legend from the scene, either click the legend button again or click the red X in the scene window:

The shape properties panel adjacent to the shape list provides more detailed control of the appearance of the selected object:

The properties available depend on the type of object, but the **Slice mode** appears for all objects. See Viewing Data with the Slicer in the Scene for more information.
When a data table is selected in the shape list, you can use the controls in the shape properties panel to apply filters to the data in the scene. If query filters are available for the selected object, they will be listed in the **Query filter** list:

You can also filter the range of values displayed by ticking the **Value filter** box, then setting the upper and lower limits of the range of data displayed:

If the data includes date information, you can use the **Value filter** option to restrict the display to a range of dates.

You can select multiple objects in the shape list and change their display properties using the shape properties panel. To do this, hold down the Shift key while clicking each object you wish to change:

Only controls common to the selected objects are available.

Click on a colour chip to change an object’s colour. See [Changing an Object’s Display Colour](#).

If your organisation uses standard colour coding for category and numeric data, you can import colormaps for these data types. See [Importing and Exporting Colormaps](#).
Changing an Object’s Display Colour

Many objects viewed in the scene are displayed using a single colour. To change the colour, add the object to the scene window, then click on the colour chip in the shape list. A window will appear in which you can change the colour:

You can:

- Click and drag the ring to pick a colour, then select the darkness or lightness of the colour from the triangle.
- Click on the eyedropper tool ( ), then click on something elsewhere on the screen to select the colour of that part of the screen.
- Select a colour chip from the palette.
- Set a random colour.
- Enter specific values for the colour to use.

Changes made are automatically applied to the scene. The Revert button changes back to the colour assigned when the window was first opened.

Changing a Colourmap

Some objects viewed in the scene are displayed using a colourmap based on continuous colour mapping or discrete categories. Leapfrog Geo automatically generates a colourmap based on the data, but manually altering the colourmap often helps in understanding the data. To change the colourmap for an object, add the object to the scene. Click on the colourmap in the shape list and select Edit Colourmaps:

The Edit Colourmaps window will display the colourmap that is currently being used to display the data. Changes you make in this window will be updated in the scene.

To save the currently displayed colourmap and return to the main window, click Close.

Clicking Revert All deletes all custom colourmaps and cannot be undone.

If your organisation uses standard colourmaps, you can import a colourmap, as described in Importing and Exporting Colourmaps.
Editing a Continuous Colourmap

For a continuous colourmap, the values that lie outside the bounds are coloured with the last colour at the appropriate end of the colourmap. The transformation of the colourmap can be changed by dragging the dots. The scene will be updated to reflect the changes you make in this screen.

It can be helpful to view the histogram of the data when adjusting the curve points. Both the Properties window and the Edit Colourmap window can be open at the same time.

If the Dynamic box is ticked, the gradient will be updated when the data is updated, such as when drillhole data is appended. If the box is unticked, the values manually set for the Minimum and Maximum Limit values will control the lower and upper bounds of the colourmap. Reducing the range of the upper and lower bounds is useful if the bulk of the data points have values in a range much smaller than the overall range of the data. This is common in skewed data.

The From Input Data button automatically adjusts the Minimum and Maximum Limit values so that the colourmap would follow the actual data distribution of the input data. Click this button and see if these values are adjusted.

Creating a Discrete Colourmap

When you create new coloumrs, there are two types to choose from: continuous and discrete.
When you create a discrete colourmap, categories are defined and applied to the data displayed in the scene:

Click the Add button to add new categories. The scene will be updated to reflect the new categories:
Using a Colourmap to Display Dates

A colourmap can be used to display date information. If a date is displayed using a continuous colourmap, the curve points represent the start and end dates:

If you use a discrete colourmap, you can use the colours to show the different stages of, for example, a drilling campaign:

Importing and Exporting Colourmaps

If your organisation uses standard colour coding for category and numeric data, you can export colourmaps and apply them in other projects.

© 2014 ARANZ Geo Limited
Exporting a Colourmap

To export a colourmap, right-click on the data object and select Colours > Export:

If more than one colourmap is associated with the selected object, you will be prompted to choose from those available. Click Export.

In the window that appears, navigate to the folder where you wish to save the colourmap. Enter a filename and click Save. The colourmap will be saved in *.lfc format.

Importing a Colourmap

When you import a colourmap:

- For category colouormaps, the existing colourmap will be overwritten.
- For numeric colouormaps, the imported colourmap will be added to those already defined.

To import a colourmap, right-click on the data object and select Colours > Import. Navigate to the folder containing the colourmap file and click Open.

If the object has more than one colourmap associated with it, you will be prompted to choose which one to overwrite.

If the column you expected is not listed, check to see if you have selected the correct file. The columns displayed are those that correspond to the type of data in the selected file (category or numeric).

Click Import. Leapfrog Geo will map the information in the file to the information in the selected data column.

Displaying Drillholes

Viewing drillhole data in the scene is an important part of refining drillhole data and building a geological model. Therefore, Leapfrog Geo has a number of different tools for displaying drillhole data that can help in making drillhole data processing and modelling decisions.

Display drillhole data in the scene by dragging the Drillholes object into the scene. You can also drag individual tables into the scene.
Once drillhole data is visible in the scene, click on a drillhole to view the data being displayed. You can also display the data associated with each interval by clicking on the Show text button (A) in the shape list. Here, data display is enabled for two interval tables:

Displaying Drillholes as Lines or Cylinders

Drillholes can be displayed as lines or as cylinders. Here, the drillholes are displayed as flat lines:

The width of the lines is set in the shape properties panel.
When the **Make lines solid** button is enabled, the drillhole data is displayed as cylinders and the property that can be controlled is the **Line radius**:

**Hiding Lithologies**

When lithology tables are displayed, you can hide some of the lithologies to help make better sense of the information in the scene. Click the **Edit Colours** button to open the lithology legend, then use the **Show/Hide** buttons to determine what segments are displayed:
Hiding lithologies in this way only changes how the data is displayed in the scene. Another way of limiting the data displayed is to use a query filter (see Building Query Filters), which can later be used in selecting a subset of data for further processing.

Displaying a Legend

To display a legend in the scene, click the Show legend button for the table:

The legend in the scene will be updated to reflect lithologies that are hidden in the scene when you click Edit Colours and hide some lithologies.

Changing Colourmaps

To change the colours used to display lithologies, click on the Edit Colours button in the shape list. In the window that appears, click on the colour chip for each lithology and change it as described in Changing an Object's Display Colour.

You can also import a colourmap, which is described in Importing and Exporting Colourmaps.
Viewing Multiple Interval Tables

When viewing multiple interval tables, use the line and point size controls and the transparency settings to see all the data at once. For example, here, the geology table has been made transparent to show the contaminant intervals inside:

Selecting From Multiple Columns

When an interval table has more than one column of data, select the column to view from the view list:

Some columns are editable, in which case you can click on the Edit button (✓) to start editing the table:
Displaying Interval Data in the Scene

Drillholes can be displayed with the data associated with each segment. For example, in the scene below, contaminant values are displayed along the drillhole:

To view data in this way, select the table in the shape list, then click on the **Format Text** button. In the **Text Format** window, click **Insert Column** to choose from the columns available:
You can display multiple columns and add text:

Click **OK** to update the formatting in the scene. You can conceal the formatting in the scene by clicking on the **Show text** button ( mù ) in the shape list:

Clear text formatting by clicking on the **Format Text** button, then on **Clear**.

**Displaying Points Data**

Points data can be displayed using a single flat colour, using a colour gradient (see Changing a Colormap) or using the points values. You can also import a colouormap, which is described in Importing and Exporting Colourmaps.
As with drillholes, points data can be displayed as flat points or as spheres. When the **Make points solid** button is enabled for points data, the data points are displayed as spheres. Here, the values are displayed as flat points:

You can restrict the range of values displayed using the **Value filter** in the properties panel. When using the spheres option, the points can be displayed using the values. To do this, the **Radius values** list displays the columns available:

Select the column that will be used to determine the point size. The **Point radius** control then determines the maximum point size displayed in the scene.
Displaying Surfaces

Leapfrog Geo assigns different colours to each side of a surface. A basic mesh will have an inside (coloured red) and an outside (coloured blue):

![Image of mesh with inside and outside shown]

In the case of contact surfaces, each side will be assigned a lithology. “Unknown” will be used if multiple lithologies are contacted. Contact surfaces can be displayed using the assigned lithologies or the younging direction:

![Image of contact surfaces with assigned lithologies]

Veins can also be displayed coloured with the thickness values. Surfaces that are part of a geological model or interpolant are, by default, displayed clipped to the model boundary:

![Image of model with clipped surfaces]

Disable the Clip to boundary button (X) to view the surface unclipped.
Displaying Structural Data

There are several ways to view structural data. In the scene below, structural data is displayed using the **Flat colour** option, with positive (red) and negative (blue) sides shown:

You can change the colours used to display the positive and negative sides using the controls in the shape list. You can also display the data points as **Thick** disks, **Flat** disks or as **Outlined flat** disks. You can change the **Disk radius** and the **Disk size** using the controls in the shape properties panel.

Another way of displaying structural data is to display the categories as different colours:
You can change the colours used to display the different categories by clicking on **Edit Colours** in the shape list.

You can also edit structural data in the scene. To do this, click on the **Edit** button (✓) in the shape list. See **Editing Structural Data**.

**Viewing Data with the Slicer in the Scene**

When you draw a slice in the scene, how objects in the scene are displayed in relation to the slicer is controlled in the properties panel:

The **From Scene** setting is the default; the object is sliced according to the properties set for the slicer.

By changing the **Slice mode** for objects in the scene, you can illustrate how a model has been constructed:

**Viewing GIS Data**

In Leapfrog Geo, there are three ways of looking at GIS data:

- In its “native” form with height data or on a fixed elevation, if no height data is provided. Add the GIS data object to the scene as you would any other object.
- On the topography. Add the topography to the scene and select the GIS data from the dropdown list.
- Combined with other data draped on the topography. See **Creating Custom Topography Views**.
The reason for having different ways of displaying GIS data is the difficulty posed by inconsistent height data. Not all height data is correct or wanted. In practice, it is important for all the data to be consistent. For this reason, a single elevation field is defined as part of the topography and available data is assigned heights from this object. The native height information is available and can be used to define the height of layers in the models.

**Creating Custom Topography Views**

In Leapfrog Geo, topography can be displayed with any of the GIS data and images available in the project. With a custom view, you can display multiple GIS data objects, maps and aerial photos.

To create a custom view, add the topography object to the scene. Select **New View** from the **GIS data** dropdown list:

The **Edit GIS Views** window will appear with a prompt asking you to enter a name for the new view:
Enter a name for the view and click **Create**. The new view will be created in the **Edit GIS Views** window, together with a list of **Available layers**. Click the **Add** button to move layers into the **Current layers** list and use the **Raise** and **Lower** buttons to arrange them:

![Edit GIS Views window](image)

Use the transparency and point and line size controls to emphasise data.

Click **Close**. The topography will be displayed in the scene with the new view applied:
Evaluating Objects

Many objects in Leapfrog Geo can be displayed evaluated against geological models, interpolants and distance functions. To do this, right-click on an object and select Evaluations:

Geological models can be evaluated on drillholes. See Back-flagging Drillhole Data.

Cross sections and fence sections can also be evaluated against surfaces. See Creating and Working with Sections.

A window will appear listing all objects in the project that can be used for an evaluation. Once you have selected one or more objects, click OK.

The evaluations will be added to the object in the project tree:

When you display objects in the scene, you can select the evaluations from the view list:
Defining Boundaries in a Leapfrog Geo Project

A newly-created project has only a basic set of X-Y-Z coordinates, and the coordinate system used by the project is determined by the data imported to the project. It is not necessary to specify what coordinate system is used; however, it is necessary to ensure that data you import into the project uses the same coordinate system.

If you are importing data that uses different coordinate systems, you will need to process the data outside of Leapfrog Geo so that it is using the same coordinate system.

Often the best way to set the coordinates for the project as a whole is to import a map or aerial photo. Adding georeference data to a map will set the location of the map in three-dimensional space and set the coordinates for the project. See Importing Maps and Images for more information.

An important consideration in defining the project space is setting the clipping boundary. See Setting a Clipping Boundary.

Part of creating many objects in Leapfrog Geo is defining the basic rectangular boundary that defines the object’s extents. See Setting Object Extents.

Setting a Clipping Boundary

An important consideration in defining the project space is setting the clipping boundary.

The default clipping boundary in a new project file encompasses everything in the project and grows as more data is added to the project. It is not necessary to set the clipping boundary. However, the clipping boundary defines the limits of the X-Y coordinates for the region in which data will be imported and models built and so defines the region in which calculations are made. Restricting the size of the clipping boundary limits the area in which calculations are made and is especially important if you are working with a large dataset.

The best way to set the clipping boundary is using an imported map or aerial photo, as this provides a visual reference that is helpful in working with data added to the project in the future. GIS data or drillhole data can also be used to set the clipping boundary.

To set the clipping boundary, add to the scene the objects you wish to reference in setting the boundary. Right-click on the Topographies folder or on the GIS Data, Maps and Photos folder and select Set Clipping Boundary. The Set Clipping Boundary window will be displayed, together with controls in the scene you can use to resize the clipping boundary:

There are three ways to define the rectangular clipping boundary:
Enter the coordinates.

Select **Enclose Object** and choose from the list of objects in the project. The clipping boundary will be updated using the selected object.

Use the controls that appear in the scene. The orange handle adjusts the centre of the clipping boundary and the red handles adjusts its size.

When you have finished adjusting the clipping boundary, click **OK**.

If you are going to import elevation data and use it to create a topography, it is important to set the clipping boundary before creating the topography. For example, here a map has been imported and a topography (yellow) created from an elevation grid. The map is displayed draped on the topography:

![Map draped on topography](image)

The red arrows and orange handle show the clipping boundary, which has been allowed to expand to encompass all data imported to the project. Because the topography was created before the clipping boundary was set, all the data in the imported elevation grid has been used and the resulting topography is larger than might be practical. Clearly, if the intention is to model within the area on the map, the clipping boundary should be limited to the region indicated by the map.

If the map is the only object in the project, it can easily be used to set the clipping boundary by selecting **<Everything>** from the **Enclose Object** list:

![Setting clipping boundary](image)
This results in a clipping boundary that is limited to the extents of the map:

Once the clipping boundary has been set, further data imported into the project will be clipped to it. For example, importing the elevation grid and using it to create a topography only after the clipping boundary has been set to the map extents will result in a topography (with the map draped) that looks like this:

Once the clipping boundary has been set, a good next step is defining the topography. See Defining a Topography.

**Defining a Topography**

It is not necessary to define a topography to model in Leapfrog Geo, but a defined topography can be used as an upper boundary for all models built in the project.

A key advantage of defining a topography is that it provides consistent elevation data for objects imported to and created in the project. The quality of elevation information can be poor compared to X- and Y-coordinates, which can create problems when using objects to build a model. A topography can be created from the most reliable elevation data, and other objects can have elevation set from this topography.

An important consideration when defining the topography is ensuring that it is large enough to encompass the models you will be building in the project. If you create a small topography but then later create a model that extends outside the topography, you will need to enlarge the topography, which can result in considerable reprocessing of all objects in the project that use the topography as a boundary.

The topography can be created from:

- An imported elevation grid
- Points data, including the collars in imported drillhole data
- Surfaces
- GIS data
It is not necessary to decide on a single source of information, as information can be combined. Once the topography has been defined, additional height data can be added by right-clicking on the topography and selecting from the options available. See Adding Height Data to the Topography for more information. You can add and remove data as required. See:

- Creating the Topography Using an Elevation Grid
- Creating the Topography From a Surface, Points or GIS Vector Data

If you don’t have any data suitable for creating a topography, you can set a fixed elevation. See Setting a Fixed Elevation.

Once defined, you can export the topography as a mesh or as an elevation grid. See:

- Exporting a Mesh
- Exporting an Elevation Grid

Creating the Topography Using an Elevation Grid

There are two ways to create the topography from an elevation grid:

- Right-click on the Topographies folder and select New Topography > Import Elevation Grid. Import the grid as described in Importing an Elevation Grid.
- Import the grid using the Meshes folder and then right-click on the Topographies folder and select New Topography > From Surface.

Enter a name for the topography and click OK. A hyperlink to the elevation grid will appear in the Topographies folder under the defined topography.

Once the topography has been defined, additional height data can be added by right-clicking on the topography and selecting from the options available. See Adding Height Data to the Topography for more information.

Creating the Topography From a Surface, Points or GIS Vector Data

To create the topography from a surface, points or GIS data, first import the data into the project.

- Import surfaces into the Meshes folder.
- Import drillhole data into the project or points data into the Points folder.
- Import GIS vector data into the GIS Data, Maps and Photos folder.

Next, right-click on the Topographies folder and select one of the New Topography options. A list of suitable objects available in the project will be displayed. Select the required object and click OK. Enter a name for the topography and click OK. A hyperlink to the source object will appear in the Topographies folder under the defined topography.

Once the topography has been defined, additional height data can be added by right-clicking on the topography and selecting from the options available. See Adding Height Data to the Topography for more information. See also Changing Topography Settings.

Setting a Fixed Elevation

If you don’t have any data suitable for creating a topography, you can set a fixed elevation. To do this, right-click on the Topographies folder and select New Topography > Fixed Elevation. In the window that appears, enter a value for the elevation and click OK. Enter a name for the new topography and click OK.
The new topography will appear in the project tree under the Topographies folder.
Once a topography has been defined, the only way to set a fixed elevation is to remove the objects that have been used to define the topography. To do this, right-click on the hyperlinked object and click Remove. You will then be able to set a fixed elevation for the topography.

Adding Height Data to the Topography

When creating the topography, it is not necessary to decide on a single source of information, as information can be combined. Once the topography has been defined, additional height data can be added by right-clicking on the topography and selecting from the options available:

For points, surfaces and GIS vector data, you will be prompted to select from the data sources available in the project. For an elevation grid, see Importing an Elevation Grid.

All data objects used to define the topography will appear under the topography, hyperlinked to their parent objects:

When you have added data to the topography, you may need to enlarge the topography extents. See Changing Topography Settings.

To remove data objects from the topography, either:

- Delete the object from the topography. To do this, right-click on the hyperlinked object and click Remove.
- Delete the object from the project. If you choose this option, consider carefully the effects on other objects in the project, as once an object is deleted, it cannot be recovered.

When the topography is defined from multiple objects, you can set the resolution of the topography by double-clicking on it. See Changing Topography Settings.
Changing Topography Settings

When the topography is created from points or GIS data or when the topography is created by combining data, you can change its boundary and resolution and apply a trend. To do this, double-click on the topography in the project tree. The Edit Topography window will appear:

![Edit Topography window]

Changing the Size of the Topography

In the General tab, you can change the topography extents. Use the controls in the scene or enter the required values in the Bounding Box fields.

Changing the Resolution of the Topography

The resolution of the topography depends on how it was created.

- When the topography is created from a single mesh, the resolution of the topography is set from the resolution of the mesh and can only be changed when the mesh is imported. If you wish to change the resolution of the topography, you must first add more height data to the topography. See Adding Height Data to the Topography.

- When the topography is created by setting a fixed elevation, the resolution cannot be set.

When the topography is created from points or GIS data or when the topography is created from combining data, you can set its resolution in the Edit Topography window.

When you set a specific Surface resolution without enabling the Adaptive option, the triangles used will be the same size for the whole topography. When you enable the Adaptive option, the resolution of the topography will be affected by the availability and density of real data. See Surface Resolution in Leapfrog Geo for more information on these settings.

© 2014 ARANZ Geo Limited
Applying a Trend to the Topography

In the Trend tab, you can apply a trend to the topography:

![Edit Topography window](image)

See [Adjusting Surfaces](#) for more information.

### Displaying Topography in the Scene Window

To display the topography in the scene window, either:

- Right-click on the topography in the project tree and select **View Object**.
- Click on the topography object and drag it into the scene.

The topography will be displayed in the scene window and in the shape list:
The topography object in the shape list provides additional controls that can be used to change the way the topography is displayed and highlight features of interest. For example, selecting an imported map from the dropdown list results in it being displayed draped onto the topography:

All GIS data objects in the project can be displayed in this manner. You can also create custom views by combining multiple GIS data objects with an image. See Creating Custom Topography Views for more information.

**Projecting Collars Onto the Topography**

If the drillhole collars are not lying on the topography, Leapfrog Geo can make adjustments to the collar depth values so that the collars lie on the topography. This adjustment is reversible.

To make this adjustment, right-click on the collars table and tick the box for the Project Collars Onto Topography option. If you then open the collar table, the depth values will reflect the topography. Right-click on the collar table and untick the box for Project Collars Onto Topography to return to the uncorrected collar depth values.
Setting Object Extents

Part of creating many objects in Leapfrog Geo is defining the basic rectangular boundary that defines the object’s extents. There are generally two options for defining an object’s extents:

- The first option is to define extents that are independent of other objects in the project. You can do this by entering coordinates or adjusting controls in the scene to set the size and shape of the extents. The new object’s extents are fixed to the specified size. This is a good choice if, for example, you are building a geological model from a map and wish to define the model extents based on information on the map.

- The second option is to define extents based on other objects in the project. This is done by selecting the other object from the **Enclose Object** dropdown list that appears in many Leapfrog Geo screens.

For both methods, the new object’s extents are fixed to the selected size. Using the **Enclose Object** list does not link the two objects, it is simply using the X-Y-Z coordinates of the original object as the basis for the new extents.

For example, here, a geological model’s extents could be defined using the lithology segments used as the base lithology:

![Image of setting object extents](image)

When creating some objects, you have the option of sharing extents with another object. This is the case with editable meshes (©), where you can choose whether the mesh has its own extents or shares extents with other objects in the project. Shared extents are updated when the original object’s extents are updated.

If you are unsure about relationships between objects, expand them in the project tree to view more information. Here, two meshes have been defined from the same set of points:
The first mesh shares its extents with another object in the project, which is indicated by the hyperlink. The second mesh has no hyperlink; it has its own extents that are not updated by other objects in the project.

Geological models and interpolants are created with a basic set of rectangular extents that can then be refined by adding lateral extents created from other data in the project. See Modifying the Model Boundary for more information. Geological models can also have a base created from data in the project. For example, lithology contacts can be used to define the base of a model.
Importing and Working with Drillhole Data

Drillhole data forms the basis for creating models in Leapfrog Geo. Because drillhole data often contains errors that reduce the reliability of a model, Leapfrog Geo has tools that help you to identify and correct errors in the data and work with the data.

In Leapfrog Geo, drillhole data defines the physical 3D shape of drillholes. It is made up of:

- A collar table, containing information on the location of the drillhole.
- A survey table, containing information that describes the deviation of each drillhole.
- At least one interval table, containing information on measurements such as lithology, date or any numeric or textual values. An interval table must also include collar IDs that correspond to those in the collar table and sample start and end depth.

A screens table can also be imported, if available.

When a project is first created, the only options available via the Drillhole Data folder are for importing data. See Importing Drillhole Data for more information on these options.

Once data has been added to the project, a Drillholes object will be created that serves as a container for the tables imported:

When there are errors in the data, the relevant table will be marked with a red X (❼). See Correcting Drillhole Data Errors for more information on fixing data errors.

Leapfrog Geo also has tools for creating new lithology data columns from existing columns in order to solve problems with the drillhole data. See Processing Drillhole Data for more information.

You can open each table by double-clicking on the table (⩬). The table will be displayed and you can make changes. See Using the Table Dialog.

See Displaying Drillholes in Visualising Data for information about displaying drillhole data in the scene. With Leapfrog Geo, you can also plan drillholes and evaluate them against any model in the project. See Planning Drillholes for more information.

Importing Drillhole Data

Drillhole data can be imported from:

- Files stored on your computer or a network location. This process is described below.
- From any database that runs an ODBC interface. See Selecting the ODBC Data Source.
- From an acQuire database. See Connecting to an acQuire Database.

For each of these options, once the data source is selected, the process of importing drillhole data is the same.

© 2014 ARANZ Geo Limited
Leapfrog Geo expects drillhole data that is stored in a collar table, a survey table and at least one interval table. Each project can have only one collar file and survey table, but multiple interval tables can be imported. A screens table can also be imported, if available.

Leapfrog Geo imports tables from text files in CSV, ASCII and text formats. See Expected Drillhole Data Format for more detailed information on the information required in each file type.

To import drillhole data, right-click on the Drillhole Data folder and select Import Drillholes. The Import Drillhole Data window will appear:

For the Collar, click on the Browse button to locate the collar file.

When a collar file is added to the Import Drillhole Data window, Leapfrog Geo will look for interval tables with names such as "lithology" or "geology" in the same location and will add them to the Interval Tables list. If an interval table file is not automatically added to the list, click Add and browse for the required file.

You can also add any screens to import by clicking on the Screens - Browse button.

In the screen below, a collar file, a survey file and two interval tables have been selected for import:

Clicking on Import starts the process of importing data. Leapfrog Geo will display a series of windows, one for each file, and will attempt to match the data found in the files with the columns expected, based on the header row in each file. Progress in working through the files is shown at the top of the window:

The file currently displayed is shown in bold.
For *.csv files that use characters other than the comma as the separator, you can specify the delimiter, comment leader, quote and decimal characters in the Import Drillhole Data window. Click on CSV characters to enter the characters used in the data files:

The row at the top of the table indicates the data type to which Leapfrog Geo will assign each column:

Click at the top of a column to view the column assignments available. The columns highlighted below are the column types required for the collar table:

Each type of table being imported will have different column assignments available, but all table types will display:

- The categories columns can be assigned to (top of the list)
- The option to not import the column
- The required columns, e.g. Hole Id, East (X), North (Y) and Elev (Z) for the collar table
- Any optional columns, e.g. Max Depth and Trench
- The option to select a custom name

If the header row for a column cannot be matched, Leapfrog Geo will mark the column as “Not Imported” and you can select from the column assignments available. If you choose not to import a column then wish to do so later, you can add it later using the Import Column option. See Importing Columns.
Sometimes it is easier to work with the **Column Summary**. For example, if there are multiple columns you wish to assign as the same data type, you can easily do so using the **Column Summary**:

If you wish to import all columns, click on the **Import All Columns** button, then check that all columns have been correctly mapped. If the data contains date and time information and the date and time format is not detected, click on **Date and Time Formats** to reveal more information:

If the date and time format you wish to use is not among the options, you can create a custom format. For each file, check the column mapping and click **Next** to proceed to the next step. If any of the information Leapfrog Geo expects is missing, an error message will appear. Return to the table and correct the problem described.

Once you have checked the last file, click on **Finish**. Once Leapfrog Geo has imported the data, it will appear in the project tree under a new **Drillholes** object.

See **Correcting Drillhole Data Errors**.

**Expected Drillhole Data Format**

Drillhole data can be imported from files stored on your computer or a network location, from any database that runs an ODBC interface or from an acQuire database. Once the data source is selected, the process of importing drillhole data is similar for each data source.

See **Selecting the ODBC Data Source** for information on using the ODBC interface. See **Connecting to an acQuire Database** for information on importing from an acQuire database. A screens table can also be imported, if available.

Leapfrog Geo imports tables from text files in CSV, ASCII and text formats.
The Collar Table

The collar table should contain five columns:

- A drillhole identifier
- The location of the drillhole in X, Y and Z coordinates
- The maximum depth of the drillhole

A collar table can also contain a trench column, and collars marked as trenches will be desurveyed in a manner different from other drillholes.

The Hole ID is used to associate data in different tables with a single drillhole. The Hole ID for a drillhole must be identical in all tables in order for data to be associated with that drillhole. Inconsistencies in the way drillholes are identified are common sources of errors.

The maximum depth column is optional. If it is present, it is used to validate the data imported for the interval tables. The maximum depth specified in the collar table is often a planned quantity, whereas the interval table records actual measurements. For this reason, Leapfrog Geo has an option for fixing the maximum depth value in the collar table to match the data in an interval table.

If maximum depth information is not included in a collar file, Leapfrog Geo will determine it from the maximum depth sampled as indicated by data in the interval tables.

Interval Tables

For interval tables, Leapfrog Geo expects, at minimum, four columns:

- A drillhole identifier
- Start/from and end/to depths
- A column of measurements

If a drillhole ID in an interval table does not correspond to one in the collar file, the file can still be imported but the interval table will contain errors.

Supported column types are:

- Lithology columns containing lithologic data, which can be used for geological modelling.
- Numeric columns containing numeric values, which can be used for interpolating data.
- Category columns, which is text representing categories such as company, geologist, or mineralisation.
- Text columns containing text data that is not categorical, such as comments. Text columns are not validated when imported.
- Date columns containing date data. Custom date and timestamps formats are supported.

The Screens Table

For the screens table, Leapfrog Geo expects a minimum of four columns:

- A drillhole identifier
- Start/from and end/to depths
- A value column
The Survey Table

For the survey table, Leapfrog Geo expects a minimum of four columns:

- A drillhole identifier
- Depth, dip and azimuth values

See [Changing Survey Table Options](#) for more information on the drillhole desurveying algorithms used in Leapfrog Geo.

Selecting the ODBC Data Source

To import drillhole data directly from any database that uses an ODBC interface, right-click on the Drillhole Data folder and select Import Drillhole Data via ODBC. The Select ODBC Data Source window will appear:

![Select ODBC Data Source](Image)

Enter the information supplied by your database administrator and click OK. Once the data source is selected, the importation process is similar to that described in [Importing Drillhole Data](#).

Connecting to an acQuire Database

There are two options for connecting to an acQuire database:

- Create a new connection. To do this, right-click on the Drillhole Data folder and select Import Drillhole Data via acQuire > New Selection. In the window that appears, choose whether to connect using ODBC or DAP. Select the server and click Connect. Next, enter the login details supplied by your database administrator.

- Create a connection from an existing selection file. Right-click on the Drillhole Data folder and select Import Drillhole Data via acQuire > Existing Selection. Navigate to the location where the selection file is stored and open the file.

Once connected to the database, you will be able to select the required data. When you have finished specifying the selection, click OK to import the data. The importation process is similar to that described in [Importing Drillhole Data](#).

Once the drillhole data has been loaded, you can:

- Import additional interval tables. See [Importing Interval Tables](#).
- Appending drillhole data. See [Appending Drillholes](#).
Saving a Selection

Saving a selection saves the acQuire database in its current state. You can use a selection to import the same set of drillhole data in new Leapfrog Geo projects.

To save an acQuire selection, right-click on the Drillholes object in the project tree and select Save Selection. You will be prompted for a filename and location.

Appending Drillholes

If drillhole data is stored in multiple files or new drillhole data is available, you can import other files into the project and add them to the existing drillhole data. To do this, right-click on the Drillholes object and select Append Drillholes.

Append drillhole data when you have new drillholes or wish to add extra length to existing drillholes. If you wish to refresh drillhole data, overwriting all existing drillhole data, use the Reload Drillholes option.

The Append Drillholes window will be displayed. Appending drillhole data is similar to importing the original data (see Importing Drillhole Data):

- If the drillhole data was loaded from a file on your computer or a network location, you will be asked to specify the file locations. Step through the files, checking the Column Summary for each file to ensure that the correct information will be imported, then click Finish to add the new files.
- If the interval table is stored in an ODBC database, you will be prompted to connect to the database. See Selecting the ODBC Data Source.
- If your drillhole data is stored in an acQuire database, you will be prompted to connect to the database. See Connecting to an acQuire Database.

Importing Interval Tables

Interval tables that have not been imported during the drillhole data import process can be added to the project at any time. To add an interval table, right-click on the Drillholes object in the project tree and select from the options available:

- If the interval table is stored in a file on your computer or a network location, select Import From File > Interval Values. Leapfrog Geo will ask you to specify the file location, and then will display the data in the file in the Import Interval window.
- If the interval table is stored in an ODBC database, select Import From ODBC > Interval Values. You will be prompted to select the data source. See Selecting the ODBC Data Source.
- If your drillhole data is stored in an acQuire database, select Import From acQuire > Interval Values. See Connecting to an acQuire Database.

Columns required are:

- A drillhole identifier
- Start/from and end/to depths
- A column of measurements

See Expected Drillhole Data Format for more information on the supported column types.
Select the required columns and assign the data type for each column. Click Finish to import the file, which will appear under the Drillholes object.

**Importing Columns**

Columns of an interval table that have not been imported during the drillhole data import or that are stored in a separate file can be added to the table at any time. To do this, right-click on the interval table in the project tree and select New Column > Import Column.

Importing a column is similar to importing interval tables themselves. Leapfrog Geo will ask you to specify the file location, and then will display the data in the file in the Add Column To Table window. Select as many columns to import as required and assign the appropriate data type. Before finishing, check the Column Summary to ensure that the correct information will be imported.

It is not necessary to re-import any columns that are already part of the project. The drillhole ID and To and From data columns, however, will be used to check the validity of the new column against existing data.

Click Finish to import the new column.

**Importing Screens**

Screens that have not been imported during the drillhole data import process can be added to the project at any time. To do this, right-click on the Drillholes object in the project tree and select Import From File > Screens or Import From ODBC > Screens.

When importing from a file, Leapfrog Geo will ask you to specify the file location, and then will display the data in the file in the Import Screen window.

When importing from ODBC, you will first be prompted to select the data source. See Selecting the ODBC Data Source.

Columns required are:

- A drillhole identifier
- Start/from and end/to depths
- A value column

Select the required columns and assign the data type for each column. Click Finish to import the file, which will appear under the Drillholes object.

A Leapfrog Geo project can have only one screens table.

**Importing Point Values Down Drillholes**

To import a set of points on drillholes, right-click on the Drillholes object in the project tree and select Import From File > Point Values or Import From ODBC > Point Values.

When importing from a file, Leapfrog Geo will ask you to specify the file location and then will display the data in the file in the Import Depth Points window.

When importing from ODBC, you will first be prompted to select the data source. See Selecting the ODBC Data Source.

Columns required are:

- A drillhole identifier
- Depth
Select the required columns and assign the data type for each column. Click Finish to import the file, which will appear under the Drillholes object.

**Importing Downhole Structural Data**

Leapfrog Geo supports structural measurements in .csv or text formats. This topic describes importing downhole structural data tables. Structural data tables that include location information can also be imported to the Structural Data folder. See Importing Structural Data.

To import a set of structural data on drillholes, right-click on the Drillholes object in the project tree and select Import From File > Structural Data or Import From ODBC > Structural Data.

When importing from a file, Leapfrog Geo will ask you to specify the file location and then will display the data in the file in the Import Structural Data window.

When importing from ODBC, you will first be prompted to select the data source. See Selecting the ODBC Data Source.

Leapfrog Geo expects columns describing the drillhole identifier, the depth and the structural orientation. Structural orientation can be specified using either dip and azimuth or alpha and beta.

Match the values in the file to the required column headers, then click Finish to import the file. The table will appear under the Drillholes object.

If the structural orientation is specified using alpha and beta, the reference line from which the beta is measured can be the bottom or top of the drillhole. When the table is imported, the default setting is Bottom of core. To change this, double-click on the structural data table in the project tree. Next, click on the Compatibility tab to change the Beta reference mark setting to Top of core:
Using the Table Dialog

To view the contents of a data table, double-click on it in the project tree. The Table window will appear:

You can enter information in the Query field to filter the data. See Building Query Filters for more information on how to build and use queries.

If the Ignored column is ticked, then Leapfrog Geo completely ignores that row, as though it had been deleted. This is useful for suppressing erroneous data from being processed. If a hole in the collar table is ignored, then all other data associated with that hole (e.g. surveys and interval measurements) are also ignored.

Collar tables have a trench column that indicates whether or not the drillhole is from a trench. When the trench column is ticked for a drillhole, the trench will be desurveyed in a different manner from other drillholes. See Changing Survey Table Options for more information.

Survey tables have a Compatibility tab that provides options for changing the desurveying method for the survey table as a whole. See Changing Survey Table Options for more information.

Drillhole Desurveying in Leapfrog Geo

Drillhole desurveying computes the geometry of a drillhole in three-dimensional space based on the data contained in the survey table.

Under ideal conditions, the drillhole path follows the original dip and azimuth established at the top of the drillhole. Usually, though, the path deflects away from the original direction as a result of layering in the rock, variation in the hardness of the layers and the angle of the drill bit relative to those layers. The drill bit will be able to penetrate softer layers more easily than harder layers, resulting in a preferential direction of drill bit deviation.

There are a number of paths a drillhole could take through available survey measurements, but the physical constraints imposed by drilling are more likely to produce smoother paths. Selecting the desurveying method that gives the best likely approximation of the actual path of the drillhole will ensure that subsequent modelling is as accurate as possible.
Leapfrog Geo implements three algorithms for desurveying drillholes.

**Spherical Arc Approximation**

The default algorithm used in Leapfrog Geo is spherical arc approximation, which is sometimes referred to as the minimum curvature algorithm. Downhole distances are desurveyed exactly as distances along a circular arc:

The algorithm matches the survey at the starting and end positions exactly and the curvature is constant between these two measurements. At the survey points, the direction remains continuous and, therefore, there are no unrealistic sharp changes in direction.

If you wish to use spherical arc approximation, there is no need to change any settings.

**Raw Tangent**

The raw tangent algorithm assumes the drillhole maintains the direction given by the last survey measurement until the next new measurement is reached:

This implies that the drillhole makes sharp jumps in direction whenever a measurement is taken, which is unlikely, except when the drillhole is being used to define a trench.

To use the raw tangent algorithm for a drillhole, double-click on the collar table in the project tree. Tick the **trench** box for the drillholes you wish to desurvey using the raw tangent algorithm. See [Using the Table Dialog](#).
**Balanced Tangent**

The balanced tangent algorithm uses straight lines but attempts to improve the accuracy of the raw tangent algorithm by assigning equal weights to the starting and end survey measurements:

![Balanced Tangent Diagram]

It is an improvement on the raw tangent algorithm but still suffers from an unrealistic discontinuity in the drillhole path. It is, however, a better approximation of the overall drillhole path and is reasonably accurate when the spacing between measurements is small.

To use the balanced tangent algorithm, double-click on the survey table in the project tree. Click on the **Compatibility** tab and change the **Desurveying method**.

**Changing Survey Table Options**

The **Compatibility** tab has two options for changing the way survey table data is handled in Leapfrog Geo:
By default, Leapfrog Geo assumes that negative dip values point down. If this is not the case, untick the **Negative survey dip points down** option.

When drillhole data is imported, the **Desurveying method** applied is **Leapfrog spherical arc approximation**. The **Balanced tangent algorithm** option is compatible with Vulcan and Minesight. See [Drillhole Desurveying in Leapfrog Geo](#) for more information about these options.
Correcting Drillhole Data Errors

Leapfrog Geo automatically identifies and flags common drillhole data errors when drillhole data tables are imported. There are three ways Leapfrog Geo marks tables that contain conflicts or errors:

- Tables containing errors that mean data cannot be used for processing are marked with a red X (❌). These errors can be corrected by opening the Database Errors window, which is described in Correcting Drillhole Data Errors in Leapfrog Geo.

- Numeric data columns with non-numeric values are marked with a red X (❌), which means that the rules that are used to handle non-numeric and negative values need to be reviewed. If a drillhole has intervals that contain non-numeric and negative values, the drillhole cannot be used for further processing until the rules are verified, which is described in Handling Special Values in Drillhole Data.

- Tables containing warnings are marked with a yellow exclamation mark (⚠️). Affected drillholes can be used for further processing, but the information in the warning can indicate that the data requires further attention. For example, if a warning indicates there is data missing for a drillhole defined in the collar table, it may be that a drillhole has been duplicated or that not all required data files have been loaded. Warnings are listed along with table errors in the Database Errors window.

Until errors are corrected, the rows that contain those errors are excluded for all processing that uses the table, including viewing in the scene. For example, if the ID for a collar position contains an invalid coordinate, that collar will not be displayed in the scene as its location is not known. Likewise, any processing will ignore data associated with this drillhole.

It is worth correcting errors as soon as possible, as correcting them later can result in significant recomputation time.

When a table contains errors and warnings, only the errors will be apparent in the project tree view. However, all errors and warnings relevant to a particular table will be displayed in the Database Errors window.

There are two approaches to correcting errors in drillhole data:

- Correct the data in the primary source. Export the errors as described in Exporting Drillhole Data Errors. Then, when the errors have been corrected, reload the drillhole data as described in Reloading Drillhole Data.

- Correct the data in Leapfrog Geo. If you need a record of corrected errors, first export the errors as described in Exporting Drillhole Data Errors. This must be done first, as once errors have been corrected in Leapfrog Geo, they cannot be exported, as they no longer exist. Then correct errors as described in Correcting Drillhole Data Errors in Leapfrog Geo.

Exporting Drillhole Data Errors

There are two options for exporting drillhole data errors:

- Export all errors in the drillhole data set.

- Export only the errors from a single table.
Correcting Drillhole Data Errors in Leapfrog Geo

To export all errors in the drillhole data, right-click on the Drillholes object and select Export Errors. The Export Drillhole Errors window will appear:

![Export Drillhole Errors window]

The list shows the files that will be created, one for each table that contains errors. Choose a folder where the files will be saved, then enter a Base file name, which will be added to the front of each file name. Click Export to export the error files.

To export errors from a single table, right-click on that table and select Export Errors. Choose a location where the file will be saved and click Save.

**Correcting Drillhole Data Errors in Leapfrog Geo**

If you require a list of errors, select the Export Errors option before fixing them.

If you require a record of the errors in the drillhole data, export the errors as described in **Exporting Drillhole Data Errors** before starting to correct the errors in Leapfrog Geo.

To correct errors in drillhole data, right-click on the affected table and select Fix Errors. The Database Errors window will appear. Expand the list to view the details of the selected error:

![Database Errors window]

When a row that contains an error is selected, a red box indicates the source of the error.
Errors are automatically grouped by **Type** when the **Database Errors** window is opened. If there are many errors, you may find it useful to view them grouped by **Table** or **HoleID**. You can change the size of the **Database Errors** window and the columns in the table to view more information easily. When you have finished fixing errors, click the **OK** button. Leapfrog Geo will then update the database.

There are many possible sources of errors. Some useful techniques for fixing errors are described below.

**Checking for Missing Files**

Sometimes data is spread across several files and not all files have been imported. When you have many errors in freshly imported data, make sure that all necessary files have been imported.

**Ignoring Errors**

Ticking the **Ignored** box for a row results in that row being omitted from all processing, as though it has been deleted.

**Modifying Data**

You can double click on any cell to edit its content, except for the id column. If the cell you wish to edit is already selected, press the space bar to start editing.

Changes made to data in this way are immediately saved to the database.

**Fixing Collar Maxdepths**

If there is a drillhole segment that falls beyond the maxdepth defined in the collar table, a Collar maxdepth exceeded error will be reported. To fix this error, click on the **Fix Collar Maxdepths** button. This results in the collar table being updated with a maxdepth value that reflects the data in the interval tables.
Replacing All

With Replace All, you can replace an incorrect value that occurs multiple times in a column. To do this, click the Replace All button. In the window that appears, select the column to search and the Find and Replace with values.

Click OK to make the changes.
Replacing a Selection

With Replace Selection, you can select a number of row and replace values in a selected column with a single value. To do this, use the Shift and Ctrl keys to select the rows you wish to edit, then click the Replace All button. In the window that appears, select the Column and enter the Replace with value.

Click OK to make the changes.

Handling Special Values in Drillhole Data

Assay data often contains special values to represent different situations, such as grade values that are below a detection limit, cores that have been lost or segments that were not sampled. In addition, it is not uncommon for a drillhole to contain some intervals that have no values.

When drillhole data tables and points data are imported, Leapfrog Geo will mark columns containing non-numeric special values and missing intervals so that you can review these missing and non-numeric values and determine how Leapfrog Geo will handle them. For example, here numeric data columns that contain errors are marked with a red X:
To review these errors, double-click on the column. The **Invalid Value Handling** window will appear:

Leapfrog Geo will automatically set missing and non-numeric intervals to be omitted from further processing. Negative values are automatically set to **keep**. To change the **Action**, select another action from the dropdown list:

- Select **replace** to enter a numeric value to be used for further processing.
- Select **keep** to use a negative value in further processing.

For non-numeric and negative values, all values are initially treated as a single rule. However, if values have different meanings, you can define specific rules to determine how each value is handled. To do this, click on the **Add Rule** button. The window that appears will show the values present in the data:

To define a new rule for a specific value, select that value in the list, then tick the box for **The value I want is not in the list**. Enter the **Value** and click **OK**. In the **Invalid Value Handling** window, the value will be listed separately and you can choose the **Action** to apply.

Once you have reviewed the rules that will be applied to the column, tick the **These rules have been reviewed** box and click **OK**. The rules will be applied and used in further processing.
When you open a data table, the original values will be displayed. In all further processing of that data, the assigned special values will be used.

**Processing Drillhole Data**

Once imported and corrected, drillhole data usually requires further processing before any models are built. Use the techniques described in [Displaying Drillholes](#) to aid in making decisions on what further processing is required.

Often, selecting a small portion of intervals can be achieved using a query filter (see [Building Query Filters](#)). In some cases, however, you may wish to composite data to focus on a single unit. There may also be issues with how drillhole data has been recorded; for example, two units have been catalogued as one, or a single unit may be divided into multiple units.

Leapfrog Geo has a number of tools for processing drillhole data, including:

- **Compositing Category Data.** Sometimes unit boundaries are poorly defined, with fragments of other lithologies within the lithology of interest. This can result in very small segments near the edges of the lithology of interest. Modelling the fine detail is not always necessary, and so compositing can be used to smooth these boundaries.

- **Compositing Numeric Data.** Compositing numeric data takes unevenly-spaced drillhole data and turns it into regularly-spaced data, which is then interpolated.

- **Grouping Lithologies.** The group lithologies tool lets you define a new unit to which existing units are added. For example, a sandstone deposit might appear in an interval table as poorly-sorted and well-sorted units. The group lithologies tool lets you group both units into a single sandstone unit.

- **Splitting Lithologies.** Lithology units may be incorrectly grouped, which can become apparent when you display drillholes in the scene. The split lithologies tool lets you create new units by selecting from intervals displayed in the scene.

- **Selecting Intervals.** If the lithologies in a column are poorly sorted, you can display the column in the scene and use the interval selection tool to work with all the segments and sort them into new units.

- **Creating an Overlaid Lithology Column.** You may have two versions of an interval column, one that contains draft data and one that contains the final version. The final version may contain gaps, which can be filled in using the draft version. The overlaid lithology tool lets you combine the two columns to create a new column.

- **Creating a New Category Column from Numeric Data.** When you have numeric data you wish to use with the lithology and category modelling tools, you can convert the numeric data to a category column.

- **Back-flagging Drillhole Data.** Evaluating geological models on drillholes creates a new lithology table containing the lithologies from the selected model.

Each of these tools creates a new interval table or creates a new column in an existing interval table, preserving the original data. New tables and columns can be used as the basis for new models in the project and can be incorporated into existing models using [From Other Contacts](#) options. When a new table is created, you can view it in the scene along with the original table to see the differences between the processed and the unprocessed data.

If you are working with columns in different interval tables, you can create a new merged table that includes columns from these different tables. Columns created in Leapfrog Geo can be included in a merged table. See [Creating a New Merged Drillhole Data Table](#).
Compositing Category Data

Sometimes unit boundaries are poorly defined, with fragments of other lithologies within the lithology of interest. This can result in very small segments near the edges of the lithology of interest. Modelling the fine detail is not always necessary, and so compositing can be used to smooth these boundaries.

In Leapfrog Geo, you can composite category data in two ways:

- Composite the drillhole data directly. This creates a new interval table that can be used to build models, and changes made to the table will be reflected in all models based on that table. This process is described below.

- Composite the points used to create depositional, erosional or intrusional contact surfaces in a geological model. See Defining Contact Surfaces.

Drillhole data is composited from the Composites folder, which is in the project tree as part of the Drillholes object. To create a category composite, right-click on the Composites folder and select New Category Composite. You will be prompted to select from the category columns available in the drillhole data. Next, the New Composited Table window will appear, showing the options for sorting intervals in the selected column:

Compositing category data sorts segments into three categories:

- **Primary.** This is the unit of interest. In the case of compositing on intrusional contact surfaces, this will be the interior/intrusive lithology.

- **Ignored.** These are units that are, generally, younger than the unit of interest and should, therefore, be ignored in generating contact surfaces.

- **Exterior.** These are units that occur outside of the unit of interest. For an intrusive lithology, other lithologies the intrusion contacts should be classified as Exterior.
Unspecified intervals can be handled as **Ignored**, **Primary** or **Exterior**. The additional compositing parameters determine how ignored segments flanked by interior or exterior segments are handled and the length of segments that will be filtered. Each of these settings is discussed below.

Click **OK** to create the table. Once you have created a composites table, you can edit it by right-clicking on it and selecting **Edit Composited Table**.

### Converting Ignored Segments

The **Convert enclosed ignored segments** setting determines how ignored segments are handled when they are flanked by either two interior segments or two exterior segments. If **Convert enclosed ignored segments** is enabled, Leapfrog Geo will convert enclosed ignored segments to match the surrounding segments. In cases where an ignored segment does not lie between two interior or exterior segments, it will remain ignored.

If you wish to set a maximum size for ignored enclosed segments, tick the **Shorter than** box and set the maximum length.

If **Convert enclosed ignored segments** is disabled, this processing does not occur and ignored segments are never converted. When an intrusive contact surface is created, this setting is disabled by default.

For example, this scene shows two ignored segments that are flanked by the unit of interest. Because **Convert enclosed ignored segments** is disabled, the segments remain ignored:
Enabling Convert enclosed ignored segments results in the segments being converted to the Primary unit:

Enabling Shorter than and setting it to 4 results in the shorter segment being converted to the Primary unit and the longer segment remaining ignored:
Zooming out, we can see that the ignored segments at the top of the drillholes have not been converted:

**Filtering Interior and Exterior Short Segments**

The **Filter primary segments** and **Filter exterior segments** parameters determine how short a segment must be before it is composited:

- Short **Exterior** segments flanked by **Primary** segments will be converted to **Primary** segments.
- Short **Primary** segments flanked by **Exterior** segments will be converted to **Exterior** segments.

When the value is set the zero, no segments will be converted.

To see how these parameters can smooth the shape of a unit of interest, let’s look at a series of drillholes where we wish to create an intrusion boundary based on the red segments. Short segments are highlighted in the uncomposited intervals:

An intrusion generated from these uncomposited intervals will have more detail than is necessary for modelling. However, when compositing settings are applied and the short intervals are converted, we can see that the intrusion boundary is more geologically reasonable:
Compositing Numeric Data

Compositing numeric data takes unevenly-spaced drillhole data and turns it into regularly-spaced data, which is then interpolated.

Compositing regularises numeric data by applying two parameters, **Compositing Length** and **Minimum Coverage**, and applying these parameters in the following stages:

- Drillholes are divided into composite intervals. The **Compositing Length** determines the length of each composite interval, and the **Minimum Coverage** value determines whether or not lengths shorter than the **Compositing Length** are retained for further processing.
- Composite values are calculated for each composite interval. This is simply the average of all numeric drillhole data that falls within the composite interval.
- Composite points are generated at the centre of each composite interval from the composite values. If the **Minimum Coverage** threshold is not reached, no composite point will be generated.

For example, the following illustration shows how the **Compositing Length** and **Minimum Coverage** values can be applied in dividing two drillholes into composite intervals. In both cases, the **Compositing Length** is set to 10.

In the first example, any intervals at least 1m long (10%) will be retained, so both the 2m and 7m lengths are retained. In the second example, intervals must be at least 5m long (50%) to be retained, and so the 2m interval in the first drillhole is removed.

Omitted segments are drillhole segments for which no replacement action have been assigned in the **Invalid Value Handling** window. Omitted segments are excluded from numeric compositing so that composite values will not be diluted. See **Handling Special Values in Drillhole Data** for more information.

These parameters can be applied to entire drillholes or only within a selected region of the drillhole. For example, you may wish to composite Au values only within a specific lithology.

In Leapfrog Geo, you can composite numeric data in two ways:

- **Composite the drillhole data directly.** This creates a new interval table that can be used to build models, and changes made to the table will be reflected in all models based on that table. This process is described below.

- **Composite the points used to create an interpolant.** This is carried out by generating a contact surface and then setting compositing parameters for the interpolant's values object. The compositing settings are only applied to the interpolant. See **Setting Compositing Parameters for an Interpolant**.
Drillhole data is composited from the Composites folder, which is in the project tree as part of the Drillholes object. To create a numeric composite, right-click on the Composites folder and select New Numeric Composite. The New Composited Table window will appear:

First, set the Compositing Length and the Minimum Coverage. By default, compositing will be applied to all values down the length of drillhole. If you wish to composite only within selected regions, click on the Region tab. Select the lithology or category column to use, then move the categories you wish to composite into the Selected list:
Finally, click on the **Output Columns** tab to select from the available columns of numeric data:

![New Composited Table]

Click **OK** to create the table. Once you have created a composited table, you can edit it by right-clicking on it and selecting **Edit Composited Table**.

**Grouping Lithologies**

The group lithologies tool lets you define a new unit to which existing units are added. For example, a sandstone deposit might appear in an interval table as poorly-sorted and well-sorted units. With the group lithologies tool, you can group both units into a single sandstone unit.

When you group lithologies, the original lithology column is preserved and a new lithology column is added to the interval table. You can then select the original lithology column or the new one when displaying data and creating models.

To start grouping two or more lithologies, right-click on the interval table in the project tree and select **New Column > Group Lithologies**. The **New Lithology Column** window will appear:

![New Lithology Column]

Select the lithology column you wish to use from the **Base Column** list, then enter a **Name** for the new lithology column. Click **OK**.

© 2014 ARANZ Geo Limited
A window will appear displaying all lithologies in the base lithology column:

![Lithology Column - GroupedLithologies](image)

In this example, two spellings of Alluvium have been used and these lithologies should be combined into a single lithology.

The most straightforward way to group lithologies is to select the first of the lithologies, then click **New Group**. A group will be created for the selected lithology with only that lithology as a member.
Next, click on a lithology in the **Ungrouped Lithologies** pane and drag it into the group:

![Image](image_url)

Grouping lithologies creates a new lithology column and any lithologies left in the **Ungrouped Lithologies** pane will be excluded from the new column. For this reason, once you have grouped the required lithologies, move all remaining lithologies to the **Groups** pane by clicking on each lithology, then on the **New Group** button. This will make each remaining lithology a new group with a single member:

![Image](image_url)

When you are finished, click **OK** to create the new lithology column. It will appear in the project tree as an additional lithology column in the interval table.

Select the new column from the shape list to display it:

![Image](image_url)

Click on the **Edit** button (`Edit`) to start editing the selected column.

The other way to group lithologies is to let Leapfrog Geo create the lithology groups. See [Automatically Creating Lithology Groups](#).
Automatically Creating Lithology Groups

Leapfrog Geo can automatically create lithology groups. To do this, create a new lithology column as described in Grouping Lithologies. Click the Auto Group button to reveal more options:

The First letter(s) and Last letter(s) options let you create groups according the names of the existing lithologies. Click Group to create the new groups.

Here, the first two letters have been used to created a new set of lithologies:

The two alluvium lithologies have been added to a single group.

The One group per value option creates a group for each original lithology. You can then drag and drop lithologies into different groups, move lithologies you do not wish to group back into the Ungrouped Lithologies pane and use the Delete Groups options to remove any empty groups.
Splitting Lithologies

With the split lithologies tool, you can create new units from a single unit by selecting from intervals displayed in the scene. When you split lithologies, the original lithology column is preserved and a new lithology column is added to the interval table. You can then select the original lithology column or the new one when displaying data and creating models.

The difference between the interval selection tool and the split lithologies tool is that with splitting lithologies, you are limited to selecting intervals from a single lithology. If you wish to select intervals from multiple lithologies, see Selecting Intervals.

To start splitting a lithology, first add the drillhole data to the scene. Then right-click on the interval table in the project tree and select New Column > Split Lithologies. The New Lithology Column window will appear:

Select the lithology column you wish to use from the Base Column list, then enter a Name for the new lithology column. Click OK.

The Lithologies and Splits window will appear, together with a set of tools that will help you to select intervals in the scene:

Alluvium (gold) appears both above and below Coarse Sand (blue) and so should be split into two separate lithologies.

The first step is to select the lithology that will be split in the Lithologies and Splits window. In the example above, Alluvium is already selected.
Next, click on the Select Intervals button ( ) and click the Add Intervals button ( ). In the scene, draw a line across each interval you wish to select.

To change the width of the line used to select intervals, click on the Change Line Width button ( ) and enter a new value. You can keep the Set Line Width window open while you select intervals so you can change the line width as required.

Selected intervals are highlighted in the scene. If you accidentally select the wrong interval, click the Remove Intervals button ( ) and draw across the interval once again. You can also:

- Select all visible intervals by clicking on the Select All button ( ).
- Clear all selected intervals by clicking on the Clear Selection button ( ).
- Swap the selected intervals for the unselected intervals by clicking on the Invert Selection button ( ).
Once you have selected some segments, click on the Assign to button in the Lithologies and Splits window and select Create New Split:

The New Split window will appear:
Enter a **Name** for the new lithology, then click **OK**. The new lithology will be created and the scene updated to reflect the changes:

Once you have created a new lithology, you can add to it by selecting intervals, then selecting the lithology from the **Assign to** list.

When you are finished, click the **Save** button (soon) and close the **Lithologies and Splits** window. The new lithology column will appear in the project tree as an additional lithology column in the interval table.

Select the new column from the shape list to display it:

Click on the **Edit** button (soon) to start editing the selected column.

**Selecting Intervals**

When you wish to select a small portion of intervals or you don’t have suitable parameters to use a query filter, you can select intervals from drillholes displayed in the scene to create a new lithology column. The original lithology column is preserved and a new lithology column is added to the interval table. You can then select the original lithology column or the new one when displaying data and creating models.

The difference between the interval selection tool and the split lithologies tool is that with splitting lithologies, you are limited to selecting intervals from a single lithology. With interval selection, you can choose intervals from any lithology displayed in the scene.
To start selecting intervals, first add the drillhole data to the scene. Then right-click on the interval table in the project tree and select **New Column > Interval Selection**. For a merged table, right-click on it and select **Interval Selection**.

The **New Lithology Column** window will appear:

Select the lithology column you wish to use from the **Base Column** list, then enter a **Name** for the new lithology column. Click **OK**.

The **Interval Selection** window will appear, together with a set of tools that will help you to select intervals in the scene. To select intervals, click on the **Select Intervals** button ( ) and click the **Add Intervals** button ( ). In the scene, draw a line across each interval you wish to select:

Selected intervals are highlighted in the scene. If you accidentally select the wrong interval, click the **Remove Intervals** button ( ) and draw across the interval once again. You can also:

- Select all visible intervals by clicking on the **Select All** button ( ).
- Clear all selected intervals by clicking on the **Clear Selection** button ( ).
- Swap the selected intervals for the unselected intervals by clicking on the **Invert Selection** button ( ).

To change the width of the line used to select intervals, click on the **Change Line Width** button ( ) and enter a new value. You can keep the **Set Line Width** window open while you select intervals so you can change the line width as required.
When you have selected at least one interval, click on the **Assign to** button, then select **Create New Lithology**:

Enter a **Name** for the new lithology, then click **OK**:
The new lithology will be created and the scene updated to reflect the changes:

Once you have created a new lithology, you can add to it by selecting intervals, then selecting the lithology from the Assign to list.

When you are finished, click the Save button ( ) and close the Interval Selection window. The new lithology column will appear in the project tree as an additional lithology column in the interval table:

Select the new column from the shape list to display it:

**Creating an Overlaid Lithology Column**

You may have two versions of an interval column, one that contains draft data and one that contains the final version. The final version may contain gaps, which can be filled in using the draft version. The overlaid lithology tool lets you combine the two columns to create a new column.

Both columns must be part of the same interval table. If they are not, use the merged table tool to create a new table that contains both columns. See [Creating a New Merged Drillhole Data Table](#).

To create an overlaid lithology column, right-click on the interval table in the project tree and select New Column > Overlaid Lithology Column. For a merged table, right-click on it and select Overlaid Lithology Column.
The **New Overlaid Lithology Column** window will appear:

For the **Primary column**, select the column that you wish to have precedence. Data in the **Fallback column** will be used when no data is available from the **Primary column**.

Click **Create** to create the new column. The new column will appear in the project tree.

You can display drillhole data with the new column by selecting it from the shape list:

**Creating a New Category Column from Numeric Data**

When you have numeric data you wish to use with the lithology and category modelling tools, you can convert the numeric data to a category column. To do this, right-click on the numeric data column and select **New Column > Category From Numeric**. In the window that appears, select the **Base Column**, then enter a name for the new column. Click **OK**.

The next step is to sort the numeric data into categories:

Leapfrog Geo automatically assigns three categories calculated from the distribution of data. To add a new category, click the **Add** button and enter the required value. Click the **Show Histogram** button to view the distribution of data in deciding what categories to define.

Click **OK** to create the new column, which will appear in the project tree as part of the original interval table.
Back-flagging Drillhole Data

Evaluating geological models on drillholes creates a new lithology table containing the lithologies from the selected model. The new table contains From, To and Lithology columns defined using the intersection between the model’s output volumes and the drillholes.

To evaluate drillhole data in this way, right-click on the **Drillholes** object in the project tree and select **New Evaluation**. The **New Evaluation** window will appear:

![New Evaluation Window]

Select the model to use and enter names for the column and table. Click **OK** to create the new table, which will appear in the project tree as part of the **Drillholes** object.

Viewing Correlation Statistics

When the geological model was created from the base lithology column, you can view the correlation between modelled geology and actual logged drillhole segments. To do this, right-click on the table and select **Statistics**. In the **Correlation Statistics** window, you can compare model values to drilled lithologies or vice versa:

![Correlation Statistics Window]

To export the information displayed in the summary as a CSV file, click **Export**.

Creating a New Merged Drillhole Data Table

When you have more than one drillhole interval table in a project, you can create a new table using selected columns from existing interval tables. You can include columns created by, for example, grouping or splitting lithologies or compositing.
To create a merged table, right-click on the Drillholes object in the project tree and select New Merged Table. The New Merged Table window will appear showing all interval columns available in the project:

You can change the columns included once you have created the table. Select the columns you wish to include in the new table and click OK. The new table will appear in the project tree as part of the Drillholes object.

You can create query filters for a merged data table, as described in Building Query Filters. You can also select intervals (see Selecting Intervals) and create an overlaid lithology column (see Creating an Overlaid Lithology Column). You cannot, however, use the group lithologies and split lithology tools on a merged table.

To edit the table, right-click on it and select Edit Merged Table.

Adding Core Photo Links

Leapfrog Geo can link drillhole data to ALS Webtrieve and Coreshed core photo databases. When drillhole data has been linked, a photo link object will appear in the project tree:

You can only have one type of core photo link associated with the drillhole data. To add a link, right-click on the Drillholes object and select Add Core Photo Link. In the window that appears, select the core photo provider and click OK:
For information on setting up the links, see:

- Setting Up the ALS Interface
- Setting Up the Coreshed Interface

To use the core photo links, see:

- Using the ALS Interface
- Using the Coreshed Interface

**Setting Up the ALS Interface**

Before you can view core photos, you must first log in to the ALS database. Two levels of security are provided, one set up in Leapfrog Geo and the next via your browser.

To set up the interface between Leapfrog Geo and the ALS database, right-click on the Drillhole Data object and select **Add Core Photo Link**. In the window that appears, select **ALS Webtrieve** and click **OK**. The **ALS Core Photo Settings** window will appear:

Information required to access core data is the **Project Name** and the **Encryption Key**. This information provides the first level of security for information in the ALS database. Click on each field and enter the required information. The information is case-sensitive, so ensure that the characters entered are correctly capitalised.

For **Leapfrog depths measured in**, ensure that the units used for depth match in Leapfrog Geo and ALS.

For **Open selection in new browser**, choose whether each core photo will be opened in a separate browser **Window** or **Tab**.
Click **OK** to save the information. If login is successful, the **ALS Core Photos** button (▲) will appear in the toolbar:

A link will also appear in the project tree as part of the **Drillholes** object:

Before you can view core photos, you must login via the browser. To do this, add drillhole data to the scene, if it is not already visible. Click on a drillhole in the scene, then click on the **ALS Core Photo Link** button in the window that appears:

Your browser will be launched and you will be prompted to log in to the ALS database. Enter the **User Name** and **Password**, which are case-sensitive. Remember to allow the browser to save the details so that you will not be prompted to log in each time you wish to view a photo.

Your browser settings may require that you install a plugin or make changes to settings in order to view core photos. If you are not able to access the ALS database from Leapfrog Geo and have ensured your **Project Name**, **Encryption Key**, **User Name** and **Password** have been entered correctly, contact Customer Support.

© 2014 ARANZ Geo Limited
Support as described in Getting Support.

Once you have logged in via your browser, you will be able to view core photos from the scene, as described in Using the ALS Interface.

Using the ALS Interface

Before you can view core photos, you must first log in to the ALS database. See Setting Up the ALS Interface.

Once the interface between Leapfrog Geo and the ALS database is set up, you can view core photos by clicking on a drillhole in the scene, then clicking on the ALS Core Photo Link button in the window that appears.

If you want to view core photos in rapid succession, click on the ALS Core Photos button ( ) in the toolbar, then click on a drillhole in the scene. This will simultaneously display information on the segment selected in Leapfrog Geo and the core photo in your browser.

Setting Up the Coreshed Interface

Before you can view core photos, you must first set up the Coreshed interface. To do this, right-click on the Drillhole Data object and select Add Core Photo Link. In the window that appears, select Coreshed and click OK. The Coreshed Photo Settings window will appear:

Select the View and Layout. For Open in new browser, choose whether each core photo will be opened in a separate browser Window or Tab.

Click OK to save the information. The Coreshed Core Photos button ( ) will appear in the toolbar:
Before you can view core photos, you must login via the browser. To do this, add drillhole data to the scene, if it is not already visible. Click on a drillhole in the scene, then click on the Coreshed Photo Link button in the window that appears:

Your browser will be launched and you will be prompted to log in to the Coreshed database. Enter the Username and Password, which are case-sensitive. Remember to allow the browser to save the details so that you will not be prompted to log in each time you wish to view a photo.

Your browser settings may require that you install a plugin or make changes to settings in order to view core photos. If you are not able to access the Coreshed database from Leapfrog Geo and have ensured your Username and Password have been entered correctly, contact Customer Support as described in Getting Support.

Once you have logged in via your browser, you will be able to view core photos from the scene, as described in Using the Coreshed Interface.

**Using the Coreshed Interface**

Before you can view core photos, you must first log in to the Coreshed database. See Setting Up the Coreshed Interface.

Once the interface between Leapfrog Geo and the Coreshed database is set up, you can view core photos by clicking on a drillhole in the scene, then clicking on the Coreshed Photo Link button in the window that appears.
If you want to view core photos in rapid succession, click on the Coreshed Photo Link button (套) in the toolbar, then click on a drillhole in the scene. This will simultaneously display information on the segment selected in Leapfrog Geo and the core photo in your browser.

**Deleting Drillhole Data**

To delete a lithology or numeric data table, right-click on the table in the project tree and select **Delete**. You will be asked to confirm your choice.

When you right-click on the drillhole or collar table object in the project tree and select **Delete**, the resulting action will also remove all lithology and numeric data tables from the project. You will be asked to confirm your choice.

**Reloading Drillhole Data**

Reloading data is necessary when the imported data is modified externally. All drillhole data can be reloaded by right-clicking on the **Drillholes** object and selecting **Reload Drillholes**. If you only need to reload a single table, right-click on that table and select **Reload Data**.

> Reloading drillhole data overwrites all existing drillhole data. If you have data you wish to add to the project without overwriting existing data, use the **Append Drillholes** option.

The process is similar to that for importing drillhole data:

- If the drillhole data was loaded from a file on your computer or a network location, you will be prompted to specify the file locations.
- If the interval table is stored in an ODBC database, you will be prompted to connect to the database. See [Selecting the ODBC Data Source](#).
- If your drillhole data is stored in an acQuire database, you will be prompted to connect to the database. See [Connecting to an acQuire Database](#).

When you reload data, Leapfrog Geo retains the table structure and refreshes the data contained in the tables. This ensures that you do not need to reassign the data type for each column and select the columns to be imported.

**Exporting Drillhole Data**

Changes made to the drillhole data in Leapfrog Geo only affect the Leapfrog Geo database, not the original data files. You can export Leapfrog Geo drillhole data, which is useful if you wish to keep a copy of drillhole data outside the project.

You can:

- Export all data. See [Exporting All Drillhole Data](#).
- Export only a single data table. See [Exporting a Single Drillhole Data Table](#).
Exporting All Drillhole Data

To export all drillhole data, right-click on the Drillholes object and select Export. The Export Drillhole Data window will appear:

Once you have selected how you wish to export the data, click OK. The Export Drillhole Data Files window will appear:

The list shows the files that will be created, one for each data table. Choose the Folder where the files will be saved, then enter a Base file name, which will be added to the front of each file name.

Click Export to save the files.

Exporting a Single Drillhole Data Table

To export a single drillhole data table, right-click on that table and select Export. The Export Drillhole Data window will appear:

Once you have selected how you wish to export the data, click OK. You will be prompted for a filename and location.
Importing and Working with Other Data Types

You can import many different types of data into Leapfrog Geo. This topic describes importing and creating points data, structural data, meshes and polylines.
Importing and Working with GIS Data, Maps and Images

Often the first data imported into a new project is information that sets the coordinates for the project as a whole. This includes GIS data, maps, aerial photos and 2D grids. Leapfrog Geo also has tools for creating GIS lines.

All GIS data in the project can be viewed draped on the topography. See Viewing GIS Data for more information.

You can view the attribute table for most GIS data objects by right-clicking and selecting Attribute Table. You can also create query filters that can be used when displaying the GIS object. See Using the Table Dialog and Building Query Filters for more information.

Importing Vector Data

Vector data formats Leapfrog Geo supports include:

- ESRI Shape files (*.shp)
- MapInfo files (*.tab, *.mif)
- ESRI Personal GeoDatabase files (*.mdb)

You can also import data from MapInfo and ESRI databases. See Importing a MapInfo Batch File and Importing Data From an ESRI Geodatabase for more information.

To import vector data, right-click on the GIS Data, Maps and Photos folder and select Import Vector Data. Navigate to the folder that contains GIS data file and select the file. You can select multiple files using the Shift and Ctrl keys.

Click Open to begin importing the data.

If you are importing a single file, the Import GIS Vector Data window will show a summary of the data in the selected file.

You can choose what field in the data to use for the Elevation Field from the dropdown list.
If you are importing multiple files, all files being imported are listed in the **Import GIS Vector Data** window and no summary of each file is displayed:

Data is automatically clipped to the clipping boundary, but you can change how the data is filtered to suit any bounding box that exists in the project. If you do not wish to clip the data, untick the **Filter Data** box.

Click **OK** to add the data to the project. The object or objects will appear in the project tree under the **GIS Data, Maps and Photos** folder. You can then view an object’s attributes by right-clicking on it and selecting **Attribute Table**.

When importing files, you may be prompted to select whether or not to filter elevation data. If you wish to use another data source for your elevation data, select **Filter Data**. For example, if you import a GIS line that has suspect elevation data, you can discard the elevation data and set the elevation from the topography, as described in [Setting Elevation for a GIS Object](#).

---

**Importing Maps and Images**

Image formats Leapfrog Geo supports include:

- PNG files (*.png)
- JPEG files (*.jpg, *.jpeg)
- TIFF and GeoTIFF files (*.tiff, *.tif)
- Windows Bitmap files (*.bmp)

Images larger than 16384 by 16384 pixels will be scaled down. Reducing your images in size below this limit will avoid scaling; you can do this by cropping the image during the import process or by scaling down the image in an external image editor.

If the file contains georeference information, it too will be imported.
To import a map or image, right-click on the GIS Data, Maps and Photos folder and select Import Map. Navigate to the folder that contains the GIS data file and select the file. The Import Image window will be displayed:

The three reference markers ( , , ) are used to set coordinates for the image in the scene. If the image is the first object added to the project, this will, in effect, set the coordinate system for the project.

The scene markers ( , , ) let you copy georeference information from the scene.

Cropping the image to only the area of interest will reduce video RAM usage and may improve graphics performance. To crop the image, click on the Crop Image button ( ), then drag around the part of the image you wish to use. Click on the Remove Crop button ( ) to clear the cropping.

Georeferencing in Leapfrog Geo

Leapfrog Geo imports georeference information as X, Y, Z coordinates. It is not necessary to specify what georeferencing standard is being used.

If the data you are importing uses, for example, latitude and longitude for X and Y, but feet for elevation, you can scale the Z axis to a value that provides a better picture of the information being displayed. See Scaling the Z Axis for more information.

If you are importing data that uses different coordinate systems, you will need to pre-process the data so that it is using the same coordinate system.

Adding georeference data to a map will set the location of the map in the three-dimensional viewer. It is often used as a first step in setting the coordinates for the project as a whole.

Manual Georeferencing

If the image does not contain georeference information, you will need to add it manually by adding the three reference markers ( , , ) to the image. To select a marker, click on it, then move it to the required location.
on the image using the mouse or the arrow keys.
Once each marker is correctly positioned, enter the real-world X and Y coordinates for each marker:

There are two ways to do this:

- Enter the coordinates for each marker in the **East (X)** and **North (Y)** fields. As you enter the coordinates, the positions of the markers will be displayed in the scene.
- Copy coordinates from the scene using the three scene markers (, , ).
The second method is useful when you already have other objects correctly georeferenced in the project. For example, if you have a larger map in the project and wish to import a more detailed map, you can copy the coordinates from the georeferenced map to the detailed one. To do this, move the **import image** window so you can see enough of the scene to work in both windows:

1. In the **import image** window, position the marker (▲, ▼, ◀) on the image being imported.
2. Click the corresponding copy coordinates marker (▲, ▼, ◀).
3. Zoom in to the point in the scene where you wish to place the marker and click.
The coordinates in the scene will be copied to the **Import Image** window:

Once you have set the coordinates for each marker, click **OK** to return to the main window. Once Leapfrog Geo saves the image, it will appear in the project tree under the **GIS Data, Maps and Photos** folder.
Automatic Georeferencing

If the image contains georeference data, it will automatically be displayed:

If the georeference data in the imported image uses a different coordinate system than that used for the project, you can change the georeference data by ticking the **Override image’s georeference data** box, then editing the information.

Click **OK** to import the image. It will appear in the project tree under the **GIS Data, Maps and Photos** folder.

Exporting a Georeferenced Image

Leapfrog Geo exports georeferenced images as GeoTIFFs. To do this, right-click on it in the project tree and select **Export**. You will be prompted for a filename and location. Click **Save**.
**Importing 2D Grids**

ERMapper files (*.ers) can be imported into Leapfrog Geo as 2D grids. To import a 2D grid, right-click on the GIS Data, Maps and Photos folder and select Import 2D Grid. Navigate to the folder that contains grid and select the file. Click Open to begin importing the data.

The Import 2D Grid window will appear, displaying the grid and each of the bands available:

![Import 2D Grid window](image)

Select the data type for each band and set the georeference information, if necessary. See Importing Maps and Images for information on georeferencing imported files.
When you display the grid in the scene, select the imported bands from the shape list:

Grids can be displayed as points (●) or as cells and the values filtered, as described in Displaying Points Data.

**Importing a MapInfo Batch File**

You can import a collection of GIS data exported from MapInfo. The MapInfo file can include points, lines, polygons, images and elevation grids.

To import GIS data in this way, right-click on the GIS Data, Maps and Photos folder and select **Batch Import from MapInfo**. In the window that appears, navigate to the folder that contains the MapInfo batch file, which is an XML file. Click **Open**.

The data that can be imported will be displayed and you can select which files to import:
Importing Data From an ESRI Geodatabase

You can import points, lines and polygons from an ESRI geodatabase. However, the importation of raster data is not supported.

To import GIS points, lines and polylines in this way, right-click on the GIS Data, Maps and Photos folder and select Batch Import > from ESRI Geodatabase. In the window that appears, navigate to the folder that contains the database and click Open.

Leapfrog Geo imports uncompressed ESRI geodatabases.

The data that can be imported will be displayed and you can select which files to import:

Data is automatically clipped to the clipping boundary, but you can change how the data is filtered to suit any bounding box that exists in the project. If you do not wish to clip the data, untick the Filter Data box.

Click OK to import the selected files. Points, lines, polygons and images will be added to the GIS Data, Maps and Photos folder. Elevation grids will be added to the Meshes folder.

Setting Elevation for a GIS Object

You can set the elevation for GIS objects by:

- Using a fixed elevation
- Using the elevation data from one of the object’s attributes
You can also set the elevation for GIS lines or points objects by projecting the object onto any surface in the project.

To set the elevation for a GIS object, right-click on it in the project tree and select Set Elevation. The Set Elevation window will appear:

The From surface option is only available for lines and points objects.
Select the option required and click OK.

Creating a New GIS Lines Object

There are two ways to create a new GIS lines object in Leapfrog Geo:

- If you do not have GIS data for a topographical feature you wish to use in model building, you can draw a new GIS lines object.
- If you have a polyline you wish to use as a GIS lines object, right-click on it in the project tree and select Extract GIS Line. The new GIS lines object will appear in the GIS Data, Maps and Photos folder. It is not linked to the original polyline.

To view the new lines object draped on the topography, select the object from the GIS data dropdown list, as described in Displaying Topography in the Scene Window.

You can edit the GIS line at any time by right-clicking on it in the project tree and selecting Edit. If it is in the shape list, you can edit it by clicking on the Edit button.

Drawing a New GIS Lines Object

To draw a new GIS lines object, add the topography to the scene to serve as a reference while drawing.

If the topography has not been defined, you will not be able to create a new GIS lines object.

Next, right-click on the GIS Data, Maps and Photos folder and select New GIS Lines Object. In the window that appears, enter a name for the new object and click OK.

The object will be created in the project tree and added to the shape list. The scene view will change to view the objects in the scene from above and tools for drawing straight polylines will appear. Click on the Draw lines button and start drawing in the scene, as described in Drawing With the Straight Line Tool. When you have finished drawing, click the Save button. The new line will be saved in the project tree.
Exporting GIS Data

To export GIS data, right-click on the GIS data object in the **GIS Data, Maps and Photos** folder and select **Export**. The **Export GIS** window will be displayed:

Select whether elevation information will come from the topography or from the GIS object itself, or untick the **Use 2.5D format with elevations from** box to export the object without elevation information.

Click **Export**. You be prompted for a filename and location.
Importing and Working with Points Data

Points are sets of 3D coordinates, with or without associated values. In Leapfrog Geo, points are used to define surfaces and for interpolation.

The Points folder can be used to import points data, extract contact points and intrusion values from drillhole data and import distribution data and geophysical data. You can also create a grid of points that can be evaluated against geological models and interpolants and exported for use in other modelling packages.

Importing Points Data

To import points data, right-click on the Points folder and select Import Points. You will be prompted to select a file. Leapfrog Geo supports the following file types for points data:

- CSV files (*.csv)
- ASCII text files (*.asc)
- Leapfrog Geo 3D Point Data files (*.pl3, *.ara)

The file will be imported and added to the Points folder. If there are errors in the data, the errors can be corrected as described in Correcting Drillhole Data Errors.

To view the imported data, double-click on the object that has been added to the Points folder. Once points data has been imported to the project, it can be modified and evaluated against an interpolant.

Appending Points Data

If points data is stored in multiple files, you can import these files into the project and add them to existing points data. To do this, right-click on the object you wish to append and select Append Data. You will be prompted to select a file.

Next, the Import Tables For Appending window will be displayed.

Check the data to ensure that the correct information will be imported, then click Finish to add the new file.

Extracting Points from Drillhole Data

In Leapfrog Geo, you can extract different types of points from imported drillhole data. See:

- Extracting Contact Points from Drillhole Data
- Extracting Intrusion Values from Drillhole Data
- Changing Intrusion Point Generation Parameters
- Extracting Interval Midpoints from Drillhole Data
Extracting Contact Points from Drillhole Data

Contact points define the boundary between two lithology layers. You can extract contact points from interval tables to create a new points object in the Points folder. The values extracted are the x-y-z values of the contact points.

To extract contact points from an interval table, right-click on the Points folder and select New Contact Points. A window will appear listing the lithology and category columns available in the project:

Select the required column and click OK.

Next, the New Contact Points window will appear:

Select the lithology required from the Select primary lithology list, then select the adjacent lithologies you wish to extract in the Contacting lithologies list.
For complex geologies, the up and down directions for the surface may not be clear. If this is the case, untick the Horizontal Plane box. A reference plane will appear in the scene, with the up-facing surface labelled A and the downward-facing surface labelled B:

Controlling the position of the reference plane is similar to controlling the position of the moving plane:

- Use the handles in the scene window to move the plane.
- Set the Dip and Dip Azimuth values in the New Contact Points window. The reference plane will be updated in the scene.

Once the reference plane is correctly oriented, click the Set From Plane button.

A reference plane set for contact points in the Points folder will be applied wherever the contact points are used.

Click OK to create the points, which will appear in the project tree under the Points folder. To edit the points, double-click on them.

**Extracting Intrusion Values from Drillhole Data**

You can extract intrusion points from interval tables to create a new points object in the Points folder.

To extract intrusion values from an interval table, right-click on the Points folder and select New Intrusion Values. A window will appear listing the lithology and category columns available in the project:

Select the required column and click OK.
Next, the New Intrusion window will appear:

Select the intrusion lithology, then select the options required. See Creating Intrusional Contact Surfaces for more information on the options in this window.

Click OK to create the new points object, which will appear in the project tree under the Points folder. To edit the points, double-click on the points object ( ) in the project tree. See Changing Intrusion Point Generation Parameters.

When you view the intrusion points in the scene, you can display only the contact points or all the points used determining the extrusion values. To display all points, click on the points object in the shape list and tick the box for Show volume points:

Changing Intrusion Point Generation Parameters

To change the way intrusion values are generated, double-click on the points object ( ) in the project tree:

The Edit Intrusion window will appear, displaying the Point Generation tab.
Here, the surface and volume points are displayed to show the effects of the **Surface offset distance** and **Background fill spacing** parameters:

![Surface and volume points display](image)

The **Surface offset distance** parameter sets the top and bottom ends of the interval and affects how a surface behaves when it approaches a contact point. A smaller distance restricts the angles that an approaching surface can take. Another factor that affects the angles a surface will take is whether or not a trend has been applied to the surface.

The **Background Fill Spacing** parameter determines the approximate length of segments in the remaining intervals. If the remaining interval is not a multiple of the **Background Fill Spacing** value, Leapfrog Geo will automatically adjust the spacing to an appropriate value. A smaller value for **Background Fill Spacing** means higher resolution and, therefore, slightly smoother surfaces. However, computation can take longer.

### Extracting Interval Midpoints from Drillhole Data

You can extract interval midpoints from raw or composited numeric and category tables to create a new points object in the **Points** folder. The extracted points will be dynamically linked to the original drillhole segments and can be evaluated against other data in the project. The values extracted are the midpoints of each segment, the x-y-z values and the hole ID.

To extract midpoints from an interval table, right-click on the **Points** folder and select **New Interval Mid Points**. In the window that appears, select the required **Source table**, then select which data columns to use:

![New Interval Mid Points window](image)

Apply a query filter, if required, then click **OK**. The new points object will appear in the project tree under the **Points** folder. To edit the points, double-click on the points object (كرة) in the project tree.
Changes made to the source data table, such as changes to compositing parameters or special values rules, will be reflected in the extracted points object. Extracted interval midpoints can be exported in CSV (*.csv) or Isatis 3D point file (*.asc) formats.

**Importing Geophysical Data**

To import geophysical data, right-click on the **Points** folder and select **Import Geophysical Data**. You will be prompted to select a *.dfn file. Click **Open** to continue. You will then be prompted to name the table:

![Import Grid As Dialog](image)

Enter a name and click **OK**. The file will be imported and added to the **Points** folder. To view the imported data, double-click on the object that has been added to the **Points** folder.

**Creating a Grid of Points**

You can create a grid of points that can be evaluated against geological models and interpolants and exported for use in other modelling packages.

To create a grid of points, right-click on the **Points** folder and select **New Grid of Points**. The **New Grid of Points** window will appear, together with controls in the scene that will help in setting the grid’s boundary:

![New Grid of Points Dialog](image)

If there are objects displayed in the scene, the initial grid dimensions will be based on those objects.
The controls in the scene adjust the size and position of the grid as follows:

- Red and pink handles adjust the **Boundary Size**.
- The orange handle adjusts the **Base Point**.
- The blue handles adjust the **Azimuth**.

Set the **Spacing** and **Reference Point**, which will control the number of points in the grid. You can set the **Reference Point** by clicking in the scene. To do this, first click on the **Select** button (⌘) for the **Reference Point**, then click in the scene. The coordinates in the scene will be copied to the **New Grid of Points** window. If the number of points will be very large, rendering of the grid in the scene will be disabled.

You will be able to change the settings in this window once the grid has been created.

Click **OK** to create the grid, which will appear in the **Points** folder. Double-click on the grid to change its settings.

Once you have created the grid, you will be able to evaluate it against geological models, interpolants and distance functions in the project. See **Evaluating Points Data**.

Evaluations will be exported with the grid. See **Exporting a Grid of Points** for more information.

**Exporting a Grid of Points**

You can export a grid of points in the following formats:

- CSV file (*.csv)
- GSLIB Data file (*.dat)
- Surpac Block Model file (*.mdl)
- Isatis Block Model file (*.asc)
- Geo 3D Point Data file (*.pl3, *.ara)

For CSV, Surpac Block Model and Isatis format files, all evaluations on the grid of points will be exported as part of the file. For all other file types, only numeric evaluations will be exported.

To export a grid of points, right-click on it in the project tree and select **Export**. Select the format required, enter a filename and location, then click **Save**.

**Evaluating Points Data**

Once points data has been imported to a project, it can be evaluated against geological models, interpolants and distance functions created in the project, as described in **Evaluating Objects**.

In the case of geological models, you can also combine two or more models to evaluate the points data and set the priority used for evaluation. To do this, click on the **Combined Evaluation** button in the **Select Models To Evaluate** window. In the window that appears, select the evaluations to combined, then set their priority. Click **OK** to create the combined evaluation, then click **OK** in the **Select Models To Evaluate** window. The combined evaluation will be available from the colour dropdown list.

To delete a combined evaluation, click on the **Delete Combined** button in the **Select Models To Evaluate** window.
Exporting Points Data

To export points data, right-click on the points data object (\%2) in the project tree and select Export. The Export Points window will appear:

Once you have selected how you wish to export the data, click OK. You will be prompted for a filename and location.
Creating and Importing Structural Data

In Leapfrog Geo, you can create structural data tables directly or from other objects in the project. You can also:

- Edit structural data. See Editing Structural Data.
- Display structural data in the scene. See Displaying Structural Data.
- Use structural data in the project to modify other objects in the project. See Editing a Surface with Structural Data in the topic Working with Surfaces in Leapfrog Geo.
- Estimate structural data from other data in the project. See Estimating Structural Data.
- Create lateral extents, faults and contact surfaces for geological models from structural data. See Creating a Lateral Extent from Structural Data.
- Import tables from other sources. See Importing Structural Data.

Downhole structural data can also be imported, although structural data tables imported in this way cannot be edited. See Importing Downhole Structural Data.

Creating a New Structural Data Table

There are two ways to create a new structural data table in Leapfrog Geo:

- Create a new table as part of creating or editing another object. See Creating a Lateral Extent from Structural Data and Editing a Surface with Structural Data.
- Create a new table using the Structural Data folder. Use this technique when, for example, you are creating structural data points from a map or image. Right-click on the Structural Data folder and select New Structural Data. In the window that appears, enter a name for the new table and click OK.

Before creating the new data table, add the map, image or data object you wish to work from to the scene and orient the scene for drawing the new data points.
Creating a New Structural Data Table

When a new structural data table is created, it will be added to the scene. The **Structural Data** window will open, together with a set of tools for adding structural data points:

![Structural Data Window](image1)

Click on the **New Structural Data Point** button and click and drag along the strike line in the scene to add a new data point:

![New Structural Data Point](image2)
You can adjust the data point using the controls in the **Structural Data** window:

If you wish to assign points to categories, select **New Category** from the **Base Category** dropdown box. In the window that appears, enter a name for the category, then click **Create Category**.
When adding additional data points, you can then select the new category from the Base Category list.

When you have finished adding data points, click the Save button.

If the data contains categories that you wish to use in building models, define query filters for the categories. You will then be able to select the filter when you are creating a surface.

See Building Query Filters for more information.

**Importing Structural Data**

Leapfrog Geo supports structural measurements in .csv or text formats. This topic describes importing structural data tables that include location information. Downhole structural data can also be imported, as described in Importing Downhole Structural Data.

To import a structural data table, right-click on the Structural Data folder and select Import Structural Data. You will be prompted to select a file. Click Open to begin importing the data.
The process is similar to that for importing drillhole data. Leapfrog Geo will display the data and you can select which columns to import:

Leapfrog Geo expects **East (X)**, **North (Y)**, **Elev (Z)**, **Dip** and **Dip Azimuth** columns. The **Base Category** and **Polarity** columns are optional. The **Base Category** column can be used for filtering data once it has been imported.

Click **Finish** to import the data. The structural measurements will appear in the **Structural Data** folder.

If the data contains categories that you wish to use in building models, define query filters for the categories. You will then be able to select the filter when you are creating a surface:

See [Building Query Filters](#) for more information.

Once the data has been imported, you can reload and append the data in a similar manner to drillhole data. See [Appending Drillholes](#) and [Reloading Drillhole Data](#) for more information.
**Editing Structural Data**

Editing structural data tables is similar to editing drillhole data tables. To edit the data in the table directly, double-click on the structural data table in the project tree. See Using the Table Dialog.

To edit the structural data in the scene, right-click on the table in the project tree and select **Edit in Scene**. If the table is displayed in the scene, in the shape list, click on the **Edit** button ( ) in the shape list. The **Structural Data** window will appear in the scene, together with controls for editing the data points. To edit a data point, click on it. Information about the selected point will be displayed in the **Structural Data** window, together with controls in the scene you can use to adjust the point:

![Structural Data Window](image)

You can also add new data points in the same manner described in Creating a New Structural Data Table.

**Estimating Structural Data**

You can generate a set of structural measurements using any points object in the project. To do this, right-click on the points object and select **Estimate Structural Data**. In the window that appears, enter a name for the structural data table, then click **OK**. The new structural data table will appear in the project tree and you can view and edit it as described in Displaying Structural Data and Editing Structural Data.
Importing, Creating and Editing Meshes

The Meshes folder contains all meshes imported into Leapfrog Geo and created in Leapfrog Geo outside of the model building process.

Two types of meshes are stored in the Meshes folder:

- Non-editable meshes are meshes imported into Leapfrog Geo and meshes created in Leapfrog Geo from the moving plane, Meshes > Mesh Operations tools and by extracting mesh parts from other surfaces in the project.
- Editable meshes are created in Leapfrog Geo from data objects such as points data, GIS data and polylines. Editable meshes can be refined by adding more data. Editable meshes can be interpolated meshes (using FastRBF) or triangulated meshes (using Delaunay triangulation). Interpolated meshes can also be created from structural data and values objects.

This topic describes importing meshes, creating meshes and modifying editable meshes. See Adding Data to Surfaces, Adjusting Surfaces and Editing a Surface with Polylines for information about different techniques for refining other surfaces in the project.

Importing a Mesh

Mesh formats Leapfrog Geo supports include:

- Leapfrog Geo files (*.msh, *.ara)
- Datamine mesh files (*.tr.asc, *.tr.dm)
- DXF files (*.dxf)
- Gemcom files (*.tri)
- Surpac files (*.dtm)
- VULCAN files (*.00t)
- GOCAD files (*.ts)

To import a mesh, right-click on the Meshes folder and select Import Mesh. Navigate to the folder that contains the mesh file, select the file and click Open. The Cleanup Mesh window will be displayed (see Cleaning Up a Mesh). The mesh will be added to the project tree under the Meshes folder.

When importing a Vulcan 8 mesh that contains a path to an associated texture, Leapfrog Geo will also import the texture. If the path to the texture does not exist, you can import it once the mesh has been imported. Do this by right-clicking on the mesh in the project tree and selecting Import Texture. Navigate to the folder containing the texture file and click Open. The texture will be imported and stored in the project tree as part of the mesh.

Once a mesh has been imported to the project, you can evaluate it against any interpolant or distance function in the project. See Evaluating Objects for more information.
Cleaning Up a Mesh

There are several options for cleaning up a mesh that can be applied to meshes imported into Leapfrog Geo and to non-editable meshes created in Leapfrog Geo.

To clean up a mesh, double-click on the mesh in the Meshes folder or right-click on the mesh and select Open. The Cleanup Mesh window will be displayed:

![Cleanup Mesh Window](image)

The Cleanup Mesh window will also be displayed when you import meshes.

The first four options are automatically applied to meshes created in or imported into Leapfrog Geo:

- **Consistently orient faces** ensures that a mesh can be used for inside/outside testing.
- **Remove non-vertex points** removes points that are not used by any triangles.
- **Remove degenerate faces** removes triangles with duplicate vertices.
- **Orient concentric parts** ensures that internal parts have the correct orientation.

Other options are:

- **Invert mesh orientation** reverses the polarity of the mesh.
- **Remove vertical edges** removes any vertical faces from the mesh boundary.
- **Move Mesh** lets you offset the mesh by a vector. Tick the Move Mesh box and enter the required values. The offset values can be changed by opening the Clean Mesh window once again.

Select the options required, then click OK.

Importing an Elevation Grid

Elevation grid formats Leapfrog Geo supports include:

- Arc/Info ASCII Grid files (*.asc, *.txt)
- Arc/Info Binary Grid files (*.adf)
- Digital Elevation Model files (*.dem)
- Surfer ASCII or Binary Grid files (*.grd)
- SRTM files (*.hgt)
- ESRI .hdr Labelled Image files (*.img, *.bil)
- GeoTIFF Image files (*.tiff, *.tif)
There are two ways to import an elevation grid:

- Import the grid to the **Meshes** folder. Right-click on the **Meshes** folder and select **Import Elevation Grid**.
- Import the grid as part of creating a topography. Right-click on the **Topographies** folder and select **New Topography > Import Elevation Grid**.

Navigate to the folder that contains the elevation grid file and open the file. The **Import Elevation Grid** window will be displayed:

Leapfrog Geo automatically sets a **Surface resolution** based on the information in the file, but you can change the value if you wish. A lower value will produce more detail, but calculations will take longer. See **Surface Resolution in Leapfrog Geo** for more information.

When importing an elevation grid, note that the resolution cannot be changed once the file has been imported.

Data is automatically clipped to the clipping boundary, but you can change how the data is filtered to suit any bounding box that exists in the project. If you do not wish to clip the data, untick **Clip data to bounding box**. The **Margin** value determines how far outside the selected **Bounding box** the elevation grid will extend.

The **No Data Handling** option determines whether NoData values are displayed as gaps or at a fixed elevation setting.

Click **Import**. If you are creating a new topography, you will then be prompted to enter a name for it and click **OK**.

The elevation grid will be added to the **Meshes** folder. If you imported the grid as part of creating a topography, a hyperlink to the grid in the **Meshes** folder will appear as part of the defined topography.

### Creating Meshes

Leapfrog Geo provides you with several tools for creating meshes:

- **Creating a Mesh from the Moving Plane**
- **Combining Meshes to Create a New Volume**
- **Clipping a Volume**
- **Clipping a Mesh**
- **Extracting Mesh Parts from a Surface**
These tools produce non-editable meshes (file).

You can also create editable meshes (file) that are interpolated or triangulated:

- An interpolated mesh uses FastRBF to fit and interpolate surface data. The FastRBF is useful for creating meshes from sparse datasets or when data has large areas where there are no points. Interpolated meshes can be created from points data, GIS data, polylines, structural data and values objects.
- A triangulated mesh uses Delaunay triangulation to create the mesh. Triangulated meshes can be created from points data, GIS data and polylines. A triangulated mesh is suitable only for horizontal surfaces.

Editable meshes can be modified using other data in the project. See:

- [Creating an Interpolated Mesh](#)
- [Refining Interpolated Meshes](#)
- [Creating and Editing a Triangulated Mesh](#)
- [Creating and Editing an Offset Mesh](#)

### Creating a Mesh from the Moving Plane

When a vertical wall, flat fault plane or other flat geological surface is required, the moving plane can be used to create a simple mesh.

To create a new mesh from the moving plane, first display the plane in the scene by clicking on the Show Plane button (file). Use the controls in the scene to position the plane, then right-click on the Meshes folder and select Mesh From Moving Plane. The Mesh From Plane window will appear:

![Mesh From Plane](image)

Set the Resolution for the mesh, enter a name and click OK. The new mesh will appear in the Meshes folder. See [Surface Resolution in Leapfrog Geo](#) for more information on the resolution setting.
Combining Meshes to Create a New Volume

To create a new mesh from two existing closed meshes, right-click on the Meshes folder and select Mesh Operations > Boolean Volume. The Boolean Volume window will appear:

![Boolean Volume window](image)

The Available list shows all closed meshes available in the project. Select a mesh by double-clicking on it or by clicking on it, then on the arrow.

The Operation type can be Intersect or Union.

Click OK to save the new mesh, which will appear in the Meshes folder. To edit the mesh, double-click on it. The Boolean Volume window will appear.

When any of the meshes used to create the volume is modified, the volume will be updated.

Clipping a Volume

To clip a closed mesh using another mesh, right-click on the Meshes folder and select Mesh Operations > Clip Volume. The Clip Volume window will appear. Select the meshes you wish to use and whether to retain the inside or outside of the clipped mesh.

Click OK to save the new mesh, which will appear in the Meshes folder. To edit the mesh, double-click on it. When either of the meshes used to create the clipped volume is modified, the clipped volume will also be updated.

Clipping a Mesh

This option creates a new mesh that consists of the parts of a Clip mesh that are inside, outside or overlap with the Using mesh. To clip one mesh using another mesh or boundary in this manner, right-click on the Meshes folder and select Mesh Operations > Clip Mesh. The Clip Mesh window will appear:

![Clip Mesh window](image)
Select the meshes to use, then choose whether to retain the inside or the outside of the clipped mesh. Tick the **Include overlap** box to include the overlap between the two meshes as part of the new mesh.

Click **OK** to save the new mesh, which will appear in the **Meshes** folder. To edit the mesh, double-click on it. The **Clip Mesh** window will appear.

When either of the meshes used to create the clipped mesh is modified, the clipped mesh will be updated.

**Extracting Mesh Parts from a Surface**

To extract the triangles from a mesh and create a new mesh, right-click on the surface and select **Extract Mesh Parts**. The **Extract Mesh Parts** window will appear:

The **Extract clipped mesh** option is only available for meshes that are clipped to a boundary.

The largest part is initially selected. You can sort the mesh parts by **Volume** or by **Area** by clicking the heading of the respective column.

To select all parts, click the **Select All** button. To de-select all parts click the **Remove All** button.

Inside-out parts have negative volume. To remove them, click the **Remove Inside-Out** button.

To remove parts smaller than a given size, first click the **Select All** button. Select the last item you want to keep and click the **Remove Below Current** button.

Click **OK** to save the new mesh, which will appear in the **Meshes** folder. The mesh generated is a non-editable mesh (☐).

Meshes created in this way are not connected to the mesh they were created from. Changes to the original mesh will not be reflected in the selected parts.

If the quality of the mesh produced is not acceptable, clip the mesh as described in **Clipping a Mesh**.

**Creating an Interpolated Mesh**

An interpolated mesh is a type of editable mesh (☐). An interpolated mesh uses FastRBF to fit and interpolate surface data. The FastRBF is useful for creating meshes from sparse datasets or when data has large areas where there are no points. Interpolated meshes can be created from points data, GIS data, polylines, structural data and values objects.

Interpolated meshes can be edited by adding more data to the mesh and changing settings as described in **Refining Interpolated Meshes**.

© 2014 ARANZ Geo Limited
The steps for creating a mesh from data in the project are similar, regardless of the data used to create the mesh. The exception is creating an offset mesh, which requires additional parameters. See Creating and Editing an Offset Mesh for more information.

To create an interpolated mesh from data in the project, right-click on the Meshes folder and select from the New Mesh options.

Here, a new mesh is being created from points:

Select the required object from the list.
When defining the mesh’s extents, you can set the extents to be independent of other objects in the project (Own extents) or you can use the extents of another object (Shared with). When you select the Shared with option, the mesh will be updated when the extents object it shares is updated.

Leapfrog Geo automatically sets the surface resolution based on the data available in the project. You can experiment with the surface resolution and adaptive settings once you have created the mesh. See Surface Resolution in Leapfrog Geo for more information on the effects of these settings.

Enter a name for the new mesh and click OK.
If you are creating the mesh from a polyline, you will be prompted to select an existing polyline or draw a new one. If you draw a new polyline, it will not be able to be used elsewhere in the project unless it has been shared. To share the polyline, expand the mesh in the project tree, right-click on the polyline and select Share.

The new mesh will appear in the Meshes folder. Expand the mesh in the project tree to see how it was made. As further refinements are made to the mesh, that information will also be added to the mesh in the project tree.

See Refining Interpolated Meshes for more information on adding data to the mesh and changing its settings.

**Refining Interpolated Meshes**

Editable interpolated meshes ( Españoles ) can be refined by adding data, as described in Adding Data to Surfaces. The options available depend on how the mesh was created.

To add data to an editable mesh, right-click on it and select one of the options from the Add menu. A list of objects available in the project will be displayed. Select the required object and click OK. The mesh will be updated and the object used to modify it will appear under it in the project tree.
You can also refine editable interpolated meshes by changing the trend, transforming values, adjusting the interpolant and changing the boundary. To do this, double-click on the mesh. The **Edit Mesh** window will be opened:

![Edit Mesh Window](image)

See [Creating and Editing an Offset Mesh](#) for the options available for meshes from offset points.

In the **General** tab, you can change the **Surface resolution**. See [Surface Resolution in Leapfrog Geo](#).

Tick the box for **Snap mesh to surface points** and set a **Maximum snap distance**, if you wish the mesh to snap to points. If you will be exporting the mesh for use in another application, you may wish to adjust the snap settings.

Data used to create the mesh will appear in the **Input values** list. When you add more data to the mesh, those objects will also be listed. You can remove those additional objects by expanding the mesh in the project tree, then right-clicking on the data object and selecting **Remove**.

In the **Boundary** tab, you can change whether the mesh boundary is independent of other objects in the project (**Own extents**) or you can use the extents of another object (**Shared with**). When you select the **Shared with** option, the mesh will be updated when the extents object it shares is updated.

Options available in other tabs are similar to those available for interpolants. See:

- [Creating and Applying Structural Trends](#)
- [Clipping and Transforming Values for a Numeric Interpolant](#)

For information on the parameters in the **Interpolants** tab, see:

- [The Spheroidal Interpolant Function](#)
- [The Spheroidal Interpolant Function](#)
- [The Linear Interpolant Function](#)

### Creating and Editing a Triangulated Mesh

A triangulated mesh is a type of editable mesh ( mái). A triangulated mesh uses Delaunay triangulation to create the mesh and can handle more points than an interpolated mesh. Triangulated meshes can be created from points data, GIS data and polylines. Large datasets representing horizontal surfaces can be used to created a triangulated mesh.
The steps for creating a mesh from data in the project are similar, regardless of the data used to create the mesh. To create a triangulated mesh from data in the project, right-click on the **Meshes** folder and select from the **New Triangulated Mesh** options.

Here, a new triangulated mesh is being created from points:

![New Triangulated Mesh window](image)

Select the required object from the list.

When defining the mesh’s extents, you can set the extents to be independent of other objects in the project (**Own extents**) or you can use the extents of another object (**Shared with**). When you select the **Shared with** option, the mesh will be updated when the extents object it shares is updated.

The **Use error threshold** setting lets you exclude data points that fall within the threshold. This can be useful if you are using a large dataset and you require a more coarse surface that omits some data. When **Use error threshold** is disabled, the mesh will follow all the data.

Here, a mesh created from points has the **Use error threshold** disabled. The mesh follows all the points:
Here, a mesh has been created with the **Distance** set to 20. The mesh ignores points that fall outside the threshold:

You will be able to change the **Use error threshold** setting once the mesh has been created.

Enter a name for the new mesh and click **OK**.

If you are creating the mesh from a polyline, you will be prompted to select an existing polyline or draw a new one. If you draw a new polyline, it will not be able to be used elsewhere in the project unless it has been shared. To share the polyline, expand the mesh in the project tree, right-click on the polyline and select **Share**.

The new mesh will appear in the **Meshes** folder and you can edit its settings by double-clicking on it.

To add data to a triangulated mesh, right-click on it and select one of the options from the **Add** menu. A list of objects available in the project will be displayed. Select the required object and click **OK**. The mesh will be updated and the object used to modify it will appear under it in the project tree.
Creating and Editing an Offset Mesh

You can create a new interpolated mesh by offsetting an existing mesh with any points object in the project. To do this, first ensure the points and mesh you wish to use are already in the project. Next, right-click on the Meshes folder and select New Mesh > From Offset Points. In the window that appears, select the Mesh and Points to use:

When the mesh is created, it will automatically snap to the points, and points outside the Distance Limits will be ignored. These settings can be changed once the mesh has been created.

An offset mesh may be distorted if points used to offset the mesh lie too far outside the mesh extents. If this occurs, set a Maximum distance to exclude points far away from the mesh extents.

Enter a name for the new mesh and click OK. The new mesh will appear in the Meshes folder.
To edit the mesh, double-click on it. The Edit Offset Mesh window will appear:

The mesh is created with Snap mesh to surface points enabled. If you will be exporting the mesh for use in another application, you may wish to adjust the snap settings.

You can also modify an offset mesh by adding data, as described in Refining Interpolated Meshes. You can also edit the mesh’s boundary, but you cannot apply a trend, clip and transform values or adjust the interpolant as you can for other interpolated editable meshes.
Draping an Image on a Mesh

You can drape images on any mesh in the Meshes folder. To do this, right-click on the mesh in the Meshes folder and select one of the Drape Image options.

- For the Import Image option, you will be prompted for a file location. Navigate to the folder containing the image you wish to drape, select the file and click Open. Set georeferencing information for the image, if required, then click OK. See Importing Maps and Images for more information on georeferencing images. The imported image will appear in the project tree under the mesh.

- For the Select Existing Image option, select from the images available in the project and click OK. A hyperlink to the image will appear in the project tree under the mesh.

You can drape as many images as required. When the mesh is displayed in the scene, you will be able to select any draped images from the list of display options.

When you import and georeference an image, you can then export it as a GeoTIFF. To do this, right-click on it in the project tree and select Export. You will be prompted for a filename and location. Click Save.

Exporting a Mesh

You can export a mesh created in Leapfrog Geo for use in other software. Formats Leapfrog Geo can export are:

- Leapfrog Geo Attribute Binary Mesh format (*.msh, *.ara)
- GOCAD ASCII (*.ts)
- Drawing Exchange (*.dxf)
- Surpac ASCII (*.dtr, *.str)
- Gemcom TRI ASCII (*.tri)
- Datamine ASCII (*.tr.asc, *pt.asc)
- Micromine ASCII (*.MMpt.dat, *MMtr.dat)
- VULCAN (*.00t)
- DXF Polyface Mesh (MineCAD) (*.dxf)
- Alias Wavefront Object (*.obj)

You can export meshes in several ways:

- Export a single mesh. See Exporting a Single Mesh.
- Export multiple meshes from the Meshes folder. See Exporting Multiple Meshes from the Meshes Folder.
- Export multiple meshes from a geological model, interpolant, combined model or static model. This options lets you export meshes from a single model or interpolant. See Exporting Multiple Meshes from Models and Interpolants.
Exporting a Single Mesh

To export a mesh, right-click on the mesh and select **Export**. The **Export Mesh Parts** window will appear:

![Export Mesh Parts window](image)

The **Export clipped mesh** option is only available for meshes that are clipped to a boundary. If the quality of the mesh produced is not acceptable, clip the mesh as described in **Clipping a Mesh**, then export the mesh. Select the **Parts to Export**, then click **OK**. You will be prompted for a filename and location.

Exporting Multiple Meshes from the Meshes Folder

To export multiple meshes from those in the **Meshes** folder, right-click on the **Meshes** folder and select **Export Meshes**. In the window that appears, select the meshes you wish to export:

![Export Meshes window](image)

The filename that will be used for each mesh is shown in the **Filenames** column. To change the filename for any of the meshes, click on its name in the **Filenames** column.

Next, select the format required and where to save the exported meshes. Click **Export** to save the meshes.
Exporting Multiple Meshes from Models and Interpolants

You can export multiple meshes from individual geological models, interpolants, combined models and static models. To export meshes in this way, right-click on a model or interpolant and select Export. In the window that appears, select the volumes and surfaces you wish to export:

For geological models, if you wish to export surfaces other than the output volumes, untick the Only Output Volumes option. For faulted geological models, you also can select from the faulted volumes by ticking the Faulted Volumes box.

The filename that will be used for each mesh is shown in the Filenames column. To change the filename for any of the meshes, click on its name in the Filenames column.

Next, select the format required and where to save the exported meshes. For any of the export options other than Leapfrog Model Files format, you can save the meshes as a zip file.

The Leapfrog Model File format exports a single *.lfm file. If the file is imported into the Meshes folder, each output volume will appear as a single mesh.

Click Export to save the meshes.

Exporting an Elevation Grid

For any mesh in a project, you can export an elevation grid for use in other software. Formats Leapfrog Geo can export are:

- ARC/Info ASCII Grid (*.asc)
- ESRI.hdr Labelled (*.bil)
- ENVI Raster Image (*.img)
- Surfer ASCII Grid (*.grd)
To export an elevation grid, right-click on the mesh and select **Export Elevation Grid**. The **Export Grid** window will appear:

The **Snap to Grid** option changes the extents of the exported grid so that they coincide with the elevation grid spacing.

Enter the information required, then click **Export** to enter a filename and choose a location and format for the file.

### Exporting a Thickness Grid

For any mesh in a project, you can export a grid made up of the area between two surfaces. Formats Leapfrog Geo can export are:

- ARC/Info ASCII Grid (*.asc)
- ESRI.hdr Labelled (*.bil)
- ENVI Raster Image (*.img)
- Surfer ASCII Grid (*.grd)

To export a thickness grid, right-click on the mesh and select **Export Thickness Grid**. The **Export Thickness Grid** window will appear:

Select the surfaces required from the dropdown lists.

Enter the information required, then click **Export**. You will be prompted for a filename and location.
Importing, Creating and Exporting Polylines

Leapfrog Geo imports many common polyline formats and also has tools for drawing and exporting polylines. See Importing Polylines. Polylines imported into Leapfrog Geo are stored in the Polylines folder.

There are three ways to create polylines in Leapfrog Geo:

- Create a new polyline using the Polylines folder. These polylines are stored in the Polylines folder.
- Create a new polyline as part of working with another tool. For example, a polyline can be drawn to create a lateral extent in a geological model. These polylines are stored in the tool used to create them and cannot be used elsewhere in the project unless they have been shared. To share a polyline, right-click on it and select Share. The polyline will be moved to the Polylines folder and can be used elsewhere in the project.
- Create a new polyline from a GIS line. To do this, right-click on the GIS lines object (or ) in the GIS Data, Maps and Photos folder and select Extract Polyline. The new polyline object will appear in the Polylines folder. It is not linked to the original GIS lines object.

Polylines can be drawn using the curved line drawing tool or the straight line drawing tool. See Drawing in 3D for more information on both tools.

Export a polyline by right-clicking on it and selecting Export. Leapfrog Geo exports polylines in the following formats:

- Drawing Interchange Polylines (*.dxf). This format is available for both straight and curved polylines.
- CSV Text Files (*.csv). This format is available for curved polylines.

Importing Polylines

Polyline formats Leapfrog Geo supports include:

- Datamine Polylines (*.asc)
- Surpac String Polylines (*.str)
- Gemcom Polylines (*.asc)
- Micromine Polylines (*.asc, *.str)
- MineSight Polylines (*.srg)
- Gocad Polylines (*.pl, *.ts)
- Drawing Interchange Polylines (*.dxf)
- Leapfrog Geo 3D Polylines (*.csv, *.txt)

To import a polyline, right-click on the Polylines folder and select Import Polyline. In the Import Polyline window, navigate to the location where the polyline file is saved and select it. Click Open.
If the polyline file is in Gocad or DXF format, the importing will start immediately. For all other formats, the Polyline Import window will appear:

If the polyline file is in one of the standard formats listed above, the default settings can be used. Click Import to finish the process.

If, however, you wish to specify polyline import parameters, two pieces of information are required:

- The columns the polyline vertex coordinates are in
- How the polyline sections are separated in the file

Select the vertex coordinate columns by clicking on the heading at the top of a column and selecting one of East (X), North (Y) or Elev (Z) from the list.

The polyline will be imported and added to the project tree under the Polylines folder.
Building Query Filters

Query filters can be used to select or view a subset of rows in a table. When used on a collar table, this amounts to selecting collars. When used on an interval table, measurement intervals are selected. Query filters can be used to model using a subset of data and to filter information displayed in the scene window.

A query can be created for any type of table in a project, including GIS data, points data and structural data. When a query filter has been defined for an object and the object is displayed in the scene, the query filter can be applied by clicking on the object in the shape list and selecting the query filter in the shape properties panel:

Query filters defined for collar tables are available to all other drillhole data tables. To create a query filter, right-click on the required table in the project tree and select New Query Filter. The Query Filter window will appear:

Type the required criteria into the Query box, using the query syntax described below. Press Ctrl-Enter for a new line in longer queries. Click the ... button for more advanced query building options, which are described in Building a Query and Advanced Query Building.

Assign the filter a name and click OK to save it. It will appear in the project tree under the table to which it applies. To apply a query filter to the scene, select the object in the shape list, then select the filter from the Query filter dropdown list in the shape properties panel:

In this case, because the query filter was created for the collar table, it is also available for the lithology table.

Leapfrog Geo Query Syntax

The Leapfrog Geo query syntax is based on the WHERE clause of the Structured Query Language (SQL) with some restrictions:
 Unary operators are not allowed
 SQL functions cannot be used
 The SELECT statement should not be used (as in 'holeid in (SELECT holeid FROM ...)')
 Following statements are also prohibited: CASE, WHEN or MATCH

There is also one main SQL extension:
 IN and NOT IN will accept a partition group for the value list. E.g. 'zone IN layers.weathered' where "layers" is a partition of the "zone" column that has a group called 'weathered'.

These are some examples of valid Leapfrog Geo query statements:
 holeid in ('m-001', 'm-002')
 holeid not in ('m-001', 'm-002')
 holeid not like 'MAR%'

To enter a query that contains an apostrophe, enter two apostrophes. For example, the following query will result in an error:

```
holeid = 'dave\'s hole01'
```

Adding the second apostrophe results in a valid query:

```
holeid = 'dave\'s hole01'
```

The Query box allows the following shortcut queries:

- Typing a word will match all hole-ids starting with that string. For example, typing "MAR" is a shortcut for "holeid like 'MAR%'
- Typing a comma-separated list of words will match all hole-ids that exactly match the given words. For example typing "M001, M002" is a shortcut for "holeid in ('M001', 'M002')".
Building a Query

Many common queries can be built using the Build Query window:

This window aims to be easy to use rather than comprehensive in its support for the full Leapfrog Geo query syntax. For more advanced queries, click on the Advanced button. See Advanced Query Building for more information.

To add a criteria, click Column to view a dropdown list of columns available in the table. Select a Test and enter a Value. What can be entered for the Value depends on the type of column and test selected.

Quotes are not required around text values entered in the value column as they are in SQL. Leapfrog Geo will add quotes and brackets to the value "MX, PM" to make a valid SQL list of strings "("MX", 'PM')" when the query is saved.

Click on the Apply button to apply to query to the context in which the dialog was opened.

Use the Delete button to delete the criteria in the selected row and the Add button to add a blank row.

Advanced Query Building

The Advanced Query window provides a powerful and flexible query building using the Leapfrog Geo query language.
Enter the query in the **Criteria to Match** area on the left. The query is displayed as a tree structure with AND and OR terms as the branch nodes and conditions as the leaves. Use the **Delete** button to delete a row from the query and the **Add** button to add a blank row. The **Check** button can be used at any time to check if the current query statement is valid. Below the buttons is a box showing the raw SQL form of the query.

Except for the arrow buttons, the buttons down the middle of the dialog are used for entering values into the query. The arrow buttons are used for moving the currently selected criteria to a different position in the query. The **Date**, **List** and **Value** buttons will open a builder dialog for the column selected in the current row. If there is no column found or the column is of the wrong type, an error message is displayed.

The tree on the right contains all the columns available to the query. Double-click on a column name to insert it into the query.
Working with Surfaces in Leapfrog Geo

In Leapfrog Geo, meshes are used to represent surfaces in the form of vertices and triangles that define the 3D shape of the surface. Meshes can be open or closed.

Meshes are generated as part of the model-building process, but can also be imported into a project or created directly in the project. Leapfrog Geo has several tools for adjusting meshes.

This section describes different aspects of working with surfaces in Leapfrog Geo.

Surface Resolution in Leapfrog Geo

In Leapfrog Geo, meshes are used to represent surfaces in the form of vertices and triangles that define the 3D shape of the surface. The resolution of a surface is controlled by the size of the triangles used to create a surface. A lower surface resolution value means smaller triangles and, therefore, a finer resolution. A higher surface resolution value will take less time to process but the surface may not show the level of detail required.

When a surface is imported, Leapfrog Geo automatically sets a surface resolution based on the information in the file. It is not possible to change the resolution of surfaces imported into Leapfrog Geo. The exception is elevation grids (see Importing an Elevation Grid).

When surfaces are created, Leapfrog Geo sets a default resolution based on the data available. You can set a lower value, but calculations will take longer. In addition, the resolution for many surfaces can be adaptive; that is, areas closer to data will have a finer resolution than areas further away from data.

To see the effect of different resolution settings, consider a simple geological model of three rock types. Here, the surface resolution is set to 50 and the adaptive isosurfercer is disabled:
Here, the resolution has been reduced, which results in smaller triangles:

For both resolution settings above, the triangles are the same size everywhere in each surface, even where real data is available. Once the adaptive isosurfer has been enabled, the triangles closer to the drillholes are smaller than those further away:

Areas of the surface that have large triangles indicate that there is less data in those areas to guide the interpolation of the surface.

In Leapfrog Geo, the resolution for different types of surfaces can be controlled as follows:

- For geological models, a resolution can be set for the model as a whole, but individual surfaces can have different settings. See [Surface Resolution for a Geological Model](#).
- For interpolants, the resolution of the output isosurfaces is controlled by a single setting that can be overridden for individual surfaces. The adaptive option is not available for interpolant surfaces. See [Changing the Isosurface Parameters for a Numeric Interpolant](#) and [Changing Surfacing and Volume Options for an Indicator Interpolant](#).
- The resolution can be changed for editable interpolated meshes (🔗) and can be adaptive. See [Creating an Interpolated Mesh](#).
- When the topography has been defined using multiple data sources, the resolution can be set and the adaptive option is available. See [Changing Topography Settings](#).

### Adding Data to Surfaces

Many surfaces can be refined by adding points, structural data, GIS data, polylines and values objects. If a surface can be modified in this way, an **Add** menu will appear for the object when you right-click on it in the
Adjusting Surfaces

In Leapfrog Geo, many surfaces can be adjusted by applying a trend to the surface. To do this, add the surface you wish to adjust to the scene so that it can be used in setting the trend. Double-click on the surface in the project tree and select the Trend tab. Here, the Trend tab is displayed for a contact surface:

In this window, you can use the moving plane tool as a reference plane to set a trend. Often the easiest way to do this is to click on the Draw plane line button ( ) and draw a plane line in the scene in the direction in which you wish to adjust the surface. You may need to rotate the scene to see the plane properly.

Click on the plane to view the controls, which adjust the plane as follows:

- The main axis of the moving plane is defined by the green line. In the Trend tab, the Along Pitch value determines the strength of the variation along the main axis.
- The second axis is defined to be in the plane at right angles (orthogonal) to the main axis.
- Third axis is the axis pointing directly out of the plane. The Out of Plane variation setting applies to this axis.
Once you have adjusted the plane to represent the trend you wish to use, click the **Set From Plane** button to copy the moving plane settings.

The **Set to** list contains a number of different options Leapfrog Geo has generated based on the data used in the project. **Isotropic** is the default option used when the surface was created. Settings made to other surfaces in the project will also be listed, which makes it easy to apply the same settings to many surfaces.

Click **OK** to apply the changes.

How the moving plane can be used to adjust a surface in this manner is illustrated by the following intrusive contact surface:

The intrusion surface has two bodies that are not connected, and we can apply a trend to connect the two parts. Here, the intrusion surface has been hidden in the scene and the scene rotated to line up the QzP segments. A plane line can then be drawn through the QzP segments:

Using the plane settings to adjust the surface results in the two parts of the intrusion joining up:
Creating and Applying Structural Trends

Structural trends create a flat ellipsoid anisotropy that varies in direction with the mesh.
To create a new structural trend, right-click on the Structural Trends folder and select New Structural Trend. The Structural Trend window will appear:

Click Add to select from the meshes available in the project. The list of meshes will be displayed:
Tick the box for each mesh required, then click **OK**. The selected meshes will be added to the **Structural Trend** window:

![Structural Trend window](image)

The **Strength** parameter determines the shape of the ellipsoid, and the **Range** parameter indicates how far the influence of this mesh reaches. If the **Trend Type** is **Non-decaying**, the distance from the mesh no longer affects the anisotropy and the **Range** value cannot be set.

Trends that are **Strongest along meshes** or **Blending** can include a global trend. To set this, click on the **Global Mean Trend** tab.

![Global Mean Trend](image)

You can enter the trend manually or add the moving plane to the scene and set the trend using the moving plane, as described in **Adjusting Surfaces**.

Enter a **Name** for the trend and click **OK**. The new trend will appear under the **Structural Trends** folder.
Displaying a Structural Trend

When displayed in the scene, the trend is shown using disks placed on a regular grid:

The orientation of the disk gives the direction of the anisotropy. The size of a disk is proportional to the anisotropy strength. Where there are no disks (or the size is very small) the trend is isotropic.

If the Trend Type is set to Non-decaying, the distance from the mesh no longer affects the anisotropy and all disks have the same size:

The Blending option requires multiple meshes and blends them according to their individual strength settings. A trend with higher strength makes a stronger impact on the blending. The blended trend is of decaying-type, and its strength weakens further away from the mesh.
Applying a Structural Trend

To apply a structural trend to an interpolated editable mesh or an interpolant, double-click on the object in the project tree and click on the **Trend** tab:

To apply a structural trend to an intrusion contact surface, enable **Show additional surfacing options** in the **Surfacing** tab, then click on the **Trend** tab.

Click on **Structural Trend**, then select the required trend from the dropdown list. Click **OK** to apply the trend to the surface.

When a structural trend is applied, surfaces may appear distorted further away from the data:
If this is the case, experiment with the **Outside value** setting. The **Outside value** is the long-range mean value of the data. Setting a value of -1 for intrusions (where the positive values are on the inside) and +1 for other surfaces will result in a smoother surface in most cases. For example, here, the **Outside value** has been set to -1 for this intrusion, resulting in a much smoother surface:

![Image]

**Editing a Surface with Polylines**

In Leapfrog Geo, many surfaces can be edited using polylines, including contact surfaces, geological model extents and editable meshes.

To edit a surface with a polyline, it is a good idea to first add the object you wish to edit to the scene and draw a slice across the scene where you plan to edit the surface. Next, right-click on the surface in the project tree and select **Edit > With Polyline** or **Edit > With Curved Polyline**.

The drawing toolbar will appear for the type of polyline selected and a new polyline will be added to the scene. Draw the polyline and adjust it as described in **Drawing in 3D**, then click the **Save** button (_HANDLE) to view the effect of the polyline on the surface. To remove the polyline from the surface, expand the surface in the project tree. Right-click on the polyline object and select **Remove**.

In cases where you have existing polyline edits (control points), you can import them and add them to the surface. To do this, import the polylines to the **Polylines** folder, then add them to the surface by right-clicking on the surface and selecting **Add > Points**.

How a polyline can be used to edit a surface can be illustrated by the following surface, where a small volume is disconnected from the main surface:

![Image]
First, a slice is drawn through the surface where it will be edited:

Next, two lines are drawn to represent contacts that link up the surfaces:

The scene is then rotated and a new slice drawn in order to create another set of polylines perpendicular to the first set:
When the polyline edits are saved, the surface is updated to reflect the edits:

It is best to keep polyline edits to a minimum, as small edits can have significant effects on the shapes of surfaces.

When you save the polyline, the object will be updated to reflect the additional points. The polyline will be added to the project tree as part of the object that was edited. You can edit the polyline by double-clicking on it or by right-clicking and selecting **Edit Polyline** or **Edit Curved Polyline**.

### Editing a Surface with Structural Data

In Leapfrog Geo, many surfaces can be edited using structural data points drawn in the scene. Surfaces that can be edited in this way include contact surfaces, geological model extents and interpolated editable meshes. There are two ways to do this:

- If you have a structural data table created in or imported into Leapfrog Geo that you want to use to adjust the surface, right-click on the surface in the project tree and select **Add > Structural Data**. You will be prompted to select from the structural data tables available in the project.

- If you want to create structural data points to use to adjust the surface, right-click on the surface in the project tree and select **Edit > With Structural Data**.

To edit a surface with structural data using the second option, it is a good idea to first add the object you wish to edit to the scene. Next, right-click on the surface in the project tree and select the **Edit > With Structural Data** option.

The structural data toolbar will appear and a new structural data object will be added to the scene. Draw the structural data points and adjust them as described in Creating a New Structural Data Table, then click the **Save** button to view the effect on the surface. Structural data tables created in this way cannot be used by other objects in the project until the table has been shared. To do this, right-click on the table in the project tree and select **Share**. The structural data table will be saved to the **Structural Data** folder.

To remove the structural data from the surface, expand the surface in the project tree. Right-click on the structural data object and select **Remove**.

### Extending a Surface

Geological models created in a Leapfrog Geo project automatically use the defined topography as an upper boundary. If a model is defined that extends outside the topography, an error will occur. A similar error occurs when surfaces used in geological models do not extend outside the model’s extents. In all cases, Leapfrog Geo cannot process the surface and an error will be displayed.
In this example, an error has occurred during the process of creating a geological model because the topography (yellow) does not enclose the model extents (pink):

In order for Leapfrog Geo to be able to divide the model into separate volumes, the topography needs to be extended to enclose the model’s boundary or the model’s boundary needs to be restricted so it falls inside the topography. When the model is processed, the following error results:

In this example, a fault surface (red) does not extend to the model boundary (pink):
The surface needs to be extended or the model boundary needs to be restricted. Leapfrog Geo provides the following options:

![Extend Surface](image)

Selecting the **Use Vertices** option results in Leapfrog Geo generating the vertices (orange) to generate a new surface (blue) that extends to the model boundary:

![Extended Surface](image)

The solutions proposed will depend upon the data used to create the surfaces that conflict, but fall into three broad categories:

- Reduce the size of the model’s or interpolant’s extents. Click the **Edit Extents** button. This will open the object’s **Boundary** window and you can change the boundary.

- Enlarge the topography by manually adjusting it. Click on the **Edit Topography Extents** button. This option is only available when the topography has been created from more than one data source. See [Adding Height Data to the Topography](#) and [Changing Topography Settings](#).

- Use the surface’s vertices to create the boundary or contact with extents large enough to be used in the model or interpolant. Click the **Use Vertices** button to create a new vertices object and use it as the source data for the boundary or contact.

If you have a solution to the problem that is not covered by the options presented, click **Do Nothing**. For example:

- If the topography is not large enough, there may be additional data available. If it is not already in the project, import the data and add it to the topography as described in [Adding Height Data to the Topography](#).
• If a surface being used to define a contact surface or boundary in a geological model or interpolant is not large enough, you can add additional data to the surface, as described in Refining Extents and Editing Contact Surfaces.

Using vertices to create the boundary or contact results in the creation of a new points object that will be saved in the Points folder.

Earlier versions of Leapfrog Geo (up to 1.3) would automatically create the new vertices object and use it to interpolate the surface.

In the case of using topography vertices as an upper boundary, the vertices will be applied as a lateral extent and the defined topography will not be used. For example, here the geological model does not use the defined topography but instead uses the “GM: Topography” surface created from the vertices:

Using topography vertices can take some time to process.

An additional disadvantage to using vertices is that the vertices object created is not linked to the original object. When the object used to create the vertices changes, the vertices will not be updated.
Building and Refining Geological Models

The model building process involves several key steps:

- Creating the project and setting up the modelling environment
- Importing drillhole data and correcting errors
- Importing other required data
- Visualising the data in the scene and inspecting it to make sense of the model that will be built. It is at this stage that you might create new drillhole data columns to select data that will be the basis of geological models.
- Creating a basic GM, then refining its boundary and defining a fault system
- Modelling the contact surfaces
- Setting the cutting relationships between the different contact surfaces and generating volumes

This part describes how to create and refine a geological model once the data required has been imported to the project and a topography has been defined.
Building a Geological Model

Once a project has been set up and data imported, building a geological model is a process of successive refinement made up of two main steps:

- Defining the model extents.
- Defining the internal structure. This involves generating contact surfaces that define the internal divisions within the model boundaries. These internal divisions correspond to the contacts between lithological units.

A fault system can also be defined that divides the geological model into subunits in which the internal structure can be defined independent of the other subunits in the model.

This topic describes the first step in defining a geological model that is a simple volume enclosing the model extents. See Refining a Geological Model for information about refining the boundaries and modelling the lithological units.

A geological model can be created using only a basic set of parameters. The only parameter that cannot be changed once the model has been created is the base lithology.

To create a new geological model, right-click on the Geological Models folder and select New Geological Model. The New Geological Model window will open, together with a set of controls in the scene that help in defining the model extents.

Selecting the Base Lithology

Select the drillhole data column that will be used as the basis of a model from the Base Lithology Column dropdown list. If you do not wish to use lithology data as the basis for the model, select <None>. This may be the case if, for example, you want to build a model from points data or from an imported map. If you select <None>, you will need to manually define the lithologies that will be modelled.

If more than one column of lithology data is available for creating models, be sure to choose the correct one as it cannot be changed once the initial model has been created. If after creating and modifying the model, you find you need to modify the drillhole data, resulting in a new lithology column, you can use that new column to create contact surfaces using Other Contacts options.

You can also filter the drillhole data used to build the geological model using query filters. To do so, tick the Filter Data box and select the required query filter from the dropdown list. Once the model has been created, you can remove the filter or select a different filter.

Setting the Surface Resolution

The surface resolution setting Leapfrog Geo automatically uses as the default is based on the data available in the project. Set the surface resolution for the model as a whole and choose whether or not the resolution will be adaptive. See Surface Resolution for a Geological Model for more information on the effects of these settings and how they apply to individual contact surfaces.

Later, while refining the model, you can change the resolution of each surface and enable or disable adaptive resolution.
Setting the Model Extents

A geological model is initially created with a basic rectangular set of extents aligned with the south/north and east/west axes. You can define the model’s extents in three ways:

- Enter the coordinates.
- Select **Enclose Object** and choose from the list of objects in the project. If the model is based on drillhole data, select the lithology segments from the **Enclose Object** list.
- Use the controls that appear in the scene. The orange handle adjusts the centre of the plane and the red handles adjust the size.

See [Setting Object Extents](#) for more information.

Creating the Model

Enter a **Name** for the model that describes the purpose of the model. This **Name** will be used in naming the objects that will be added to the model.

Click **OK** to create the new model. The new geological model will be created and added to the **Geological Models** folder. The objects under the geological model in the project tree represent different parts of the model:

- The **Boundary** object defines the limits of the geological model. When the model is first created, this is the rectangular model extents. If a topography has been defined, it is automatically used for as the upper boundary. See [Modifying the Model Boundary](#) for more information about modifying the boundary.
- The **Fault System** object defines faults and their interactions in the model. See [Creating a Faulted Model](#).
- The **Lithologies** object describes all the lithological units to be modelled and the colours that are used to display them on the screen. It is generated automatically from all the lithologies identified in drillhole data selected when the model is created. If no column was selected, you will need to define the lithologies manually before you start modelling the lithology layers.
- The **Surface Chronology** object describes the contact surfaces in the model, organised in chronological order, from youngest to oldest. These surfaces and their chronology determine how the volume inside the model extents is divided into lithological units. When the model is first created, the **Surface Chronology** is empty, but it will eventually hold all contact surfaces and inputs to them.
- The **Output Volumes** folder contains all the volumes generated in building the geological model in chronological order, from youngest to oldest. When the model is first created, the **Surface Chronology** is empty and so there is only a single output volume that fills the model’s extents, called “Unknown”.

Display the geological model by dragging it into the scene or by right-clicking on it and selecting **View Output Volumes**.
Viewing the Model in the Scene

The Output Volumes folder contains all the volumes generated in building a geological model. When a geological model is first created, the only volume that appears under the Output Volumes folder will be a volume called “Unknown”. Once contact surfaces have been generated and added to the Surface Chronology object, new volumes will be generated and added to the Output Volumes folder.

To view the generated volumes in the scene, you can:

- Drag the volumes into the scene, one by one
- Drag the geological model object into the scene
- Right-click on the Output Volumes folder and select View All

See Importing, Creating and Editing Meshes for more information on some of the options available for the individual Output Volumes.

You can export all of the output volumes for a geological model in a single file. See Exporting Geological Model Volumes and Surfaces for more information.

Copying a Geological Model

Creating a copy of a geological model is a useful way of experimenting with changes to a model.

To copy a geological model, right-click on it in the project tree and select Copy. Enter a name for the copy of the model and click OK. The copy will be added to the project tree.

Creating a Static Copy of a Geological Model

Creating a static copy preserves a snapshot of a geological model that does not change, even when changes are made to the data on which the original model was dependent. This is a useful way of storing historical models and comparing models. Static copies can be exported from Leapfrog Geo, as described in Exporting Geological Model Volumes and Surfaces.

To create a static copy of a geological model, right-click on it in the project tree and select Static Copy. Enter a name for the copy of the model and click OK. The copy will be added to the Geological Models folder.

In the project tree, the static copy is made up of the model volumes and a Legend object:
When displayed in the scene, the copy will appear as a single line in the shape list. To control the colours used to display the different volumes, double-click on the Legend object in the project tree or click on the Edit Colours button in the shape list:

To view the date the static copy was created, right-click on it in the project tree and select Properties. The date the copy was created is shown in the General tab.

**Exporting Geological Model Volumes and Surfaces**

There are three options for exporting a geological model’s output volumes and surfaces. These are:

- Export an output volume or a surface as a mesh. Right-click on it in the project tree and click Export. You will be prompted for a file name and location. See Exporting a Single Mesh.
- Export an output volume as a thickness grid. Right-click on it in the project tree and click Export Thickness Grid. See Exporting a Thickness Grid.
- Export multiple output volumes and surfaces. Right-click on the geological model in the project tree and select Export. See Exporting Multiple Meshes from Models and Interpolants.

When exporting output volumes, the Merge output lithology volumes setting in the geological model’s General tab (see Refining a Geological Model) determines how the output volumes are handled when they are exported. If this setting is enabled, internal walls and surface seams will be removed from volumes of the same lithology.
Refining a Geological Model

Once a geological model has been created, you can change the model’s resolution and other basic settings by double-clicking on the model in the project tree. The **Geological Model** window will open with the **General** tab selected. The other tabs in the **Geological Model** window represent the different parts of the geological model. It is generally more useful, however, to work with these parts of the model on an individual basis by either double-clicking on the object in the project tree or right-clicking and seeing what options are available.

**Base Lithology**

Although the **Base lithology column** cannot be changed once a geological model has been created, you can change the filters applied to the data. Any filters defined for the lithology table used to define the model can be applied to the **Base lithology column**.

**Surface Generation**

The **Surface resolution** and **Adaptive** settings in the **General** tab apply to the model as a whole. These settings can be overridden for individual surfaces. See [Surface Resolution for a Geological Model](#).

If you will be exporting the contact surfaces for use in another application, you can set contact surfaces in the model to snap to contact points. To do this, tick the **Snap surfaces to contact points** box and set the **Maximum snap distance**. As with the resolution settings, the snap settings in the **General** tab apply to the model as a whole, but can be overridden for individual surfaces.

**Volume Generation**

The **Merge output lithology volumes** setting determines whether or not output volumes of the same lithology are merged when the volumes are exported. If this setting is enabled, internal walls and surface seams will be removed from volumes of the same lithology. This processing can take some time, and so this setting is disabled when a geological model is first created. Enable this setting if:

- You will be using final output volumes as extents for other models. See [Adjusting the Interpolant Boundary](#).
- You will be exporting output volumes for use in other modelling packages. See [Exporting Geological Model Volumes and Surfaces](#) for more information.

**Surface Resolution for a Geological Model**

When you create a geological model (see [Building a Geological Model](#)), the surface resolution is set for the model as a whole. When surfaces and boundaries are created as part of the model-building process, their resolution is inherited from the geological model:

- For deposit and erosion contact surfaces, stratigraphic sequences and model boundaries, the resolution is the same as the geological model.
- For intrusion contact surfaces, the resolution is half that set for the geological model.

You can change the resolution and enable or disable the adaptive isosurfercer on a surface-by-surface basis. This is useful if you want to build a detailed model of some lithologies without increasing processing time for other volumes.
To change the resolution settings for a contact surface, double-click on the surface in the project tree, then click on the **Surfacing** tab:

For a lateral extent or fault, simply double-click on the surface in the project tree to change its resolution settings.

Untick the **Inherit resolution from GM** box to change the resolution settings for a surface. This setting may be disabled, depending on the data used to create the boundary or surface.

The resolution of intrusion contact surfaces is also affected by the point generation parameters. See [Changing Intrusion Point Generation Parameters](#) for more information.

**Editing the Lithologies**

To view the lithologies used for a geological model, you can:

- Double-click on the geological model in the project tree and then click on the **Lithologies** tab.
- Double-click on the **Lithologies** object for the geological model in the project tree.

All the lithologies defined for the geological model are displayed, together with the colours used to display them:

Click a colour chip to change the colours used to display the lithologies.
If the geological model was created from drillhole data, the lithologies are automatically generated from that data. There is also an additional lithology, “Unknown”, which is used to label lithologies that cannot be labelled using known lithologies. This is the case when a geological model is first created and no contact surfaces have been defined. The entire model volume has no identified lithologies and so is assigned as “Unknown”.

If there is no drillhole data in the project or if the model is not based on drillhole data, you will need to define the lithologies one-by-one. To do this, click on the Add button, enter a name for the lithology and choose a colour.

**Modifying the Model Boundary**

Geological models are created with a basic set of rectangular extents that can then be refined using other data in the project. These extents usually correspond to the ground surface and known boundaries. Creating lateral extents can also be used to restrict modelling to a particular area of interest; for example, modelling can be restricted to a known distance from drillholes by applying a distance function as a lateral extent. Extents do not need to be strictly vertical surfaces.

When a topography is defined for the project, it will be automatically applied as a geological model’s upper boundary when the model is created.

To create a lateral extent, expand the model in the project tree. Right-click on the **Boundary** object and select from the **New Lateral Extent** options. Follow the prompts to create the lateral extent, which will then appear in the project tree under the model’s **Boundary** object. For example, this geological model has two lateral extents, one from a polyline and the other from GIS data:

New lateral extents are automatically applied to the boundary being modified. Leapfrog Geo often orients a new lateral extent correctly, with red presenting the inside face of the lateral extent and blue representing the outside face. If this is not the case, you can change the orientation by right-clicking on the lateral extent in the project tree and selecting **Swap Inside**.

If you have defined a lateral extent and want to remove it from the model, there are two options. The first is to right-click on the extent in the project tree and click **Delete**. This deletes the extent from the model, but does not delete parent objects from the project unless they were created as part of the model, e.g. a polyline used as a lateral extent but not shared within the project. Use this option only if you are sure you do not want to use the extent. See **Importing, Creating and Exporting Polylines** for more information.
The second method is useful if you are making changes to the extent and do not want to recompute the model with each change. Double-click on the model’s **Boundary** object or double-click on the model and click on the **Boundary** tab. The **Boundaries** part of the window lists all objects used as extents:

Untick the box for extents to temporarily disable them in the model. The model will be reprocessed, but you can then work on the extent without reprocessing the model. Disabled extents will be marked as inactive in the project tree:

For more information on creating the different types of lateral extents, see:

- [Creating a Lateral Extent from a Polyline](#)
- [Creating a Lateral Extent from GIS Vector Data](#)
- [Creating a Lateral Extent from Points](#)
- [Creating a Lateral Extent from Structural Data](#)
- [Creating a Lateral Extent from a Surface](#)
- [Creating a Lateral Extent from a Distance to Points](#)
- [Creating a Lateral Extent from a Distance Function](#)

See [Refining Extents](#) for information about the different techniques for refining extents, including using lithology contacts.

See [Creating and Refining a Base](#) for information about the techniques available for modifying the model’s base.

**Creating a Lateral Extent from a Polyline**

See [Modifying the Model Boundary](#) for more general information about working with lateral extents.
When creating a lateral extent from a polyline, you can use a polyline that already exists in the project or you can draw a new one. If you want to use an imported polyline, import it into the Polylines folder before creating the new lateral extent.

To create a new lateral extent from a polyline, right-click on the Boundary object for the model you are working on and select New Lateral Extent > From Polyline or New Lateral Extent > From Curved Polyline. The New Lateral Extent window will appear:

You can draw the polyline in the scene directly by selecting the New Drawing option. You can also use any polyline in the project by selecting the Existing option, then selecting the required object from the dropdown list.

Select whether you wish to create a new Vertical Wall or Surface.

If you create the lateral extent as a Surface, you will be able to modify it using additional data, as described in Refining Extents. You will also be able to apply a trend to the surface and edit the surface using a polyline. A lateral extent created as a Vertical Wall, however, cannot be modified.

Click OK to generate the new extent. If you have chosen to create a New Drawing, the drawing controls will appear in the scene and you can begin drawing, as described in Drawing in 3D.

The new lateral extent will appear in the project tree as part of the Boundary object.

In Leapfrog Geo, polylines can be created using the Polylines folder or as part of working with another tool. For example, a polyline can be drawn to create a new lateral extent in a geological model. This polyline cannot be used elsewhere in the project unless it has been shared.

To share a polyline, right-click on it and select Share. The object will then be available elsewhere in the project.

Creating a Lateral Extent from GIS Vector Data

See Modifying the Model Boundary for more general information about working with lateral extents.

To create a new lateral extent from GIS vector data, that data must first be imported into the project.
Once the data you wish to use has been imported, right-click on the **Boundary** object for the geological model you are working on and select **New Lateral Extent > From GIS Vector Data**. The **Select Vector GIS Data To Add** window will be displayed, showing vector data available in the project:

Select the vector data you wish to use, then select whether the lateral extent will be a **Vertical Wall** or a **Surface**.

If you create the lateral extent as a **Surface**, you will be able to modify it using additional data, as described in [Refining Extents](#). You will also be able to apply a trend to the surface and edit the surface using a polyline. A lateral extent created as a **Vertical Wall**, however, cannot be modified.

If you select the **Surface** option, you can use the GIS data object with its own elevation data or projected onto the topography:

Using the **On Topography** option makes sense for GIS data as it is, by nature, on the topography. The **On Topography** option also mitigates any issues that may occur if elevation information in the GIS data object conflicts with that in the project.

Click **OK** to create the new lateral extent. The new lateral extent will appear in the project tree as part of the **Boundary** object.

**Creating a Lateral Extent from Points**

See [Modifying the Model Boundary](#) for more general information about working with lateral extents.

To create a new lateral extent from points, that data must first be imported into the project.
Once the points data you wish to use has been imported, right-click on the **Boundary** object for the geological model you are working on and select **New Lateral Extent > From Points**. The **Select Points To Add** window will be displayed, showing points data available in the project:

Select the information you wish to use and click **OK**. The new lateral extent will appear in the project tree as part of the **Boundary** object. Lateral extents created in this way can be modified using additional data. See **Refining Extents** for more information.

**Creating a Lateral Extent from Structural Data**

See **Modifying the Model Boundary** for more general information about working with lateral extents. When creating a lateral extent from structural data, you can create a new structural data table or use a table that already exists in the project.

- If you want to create a new structural data table, add the object you wish to modify to the scene and orient the scene for drawing the points, as described in **Creating a New Structural Data Table**.

- If you want to use categories of structural data in creating the lateral extent, use an existing table and create filters for those categories before creating the lateral extent.

Next, right-click on the **Boundary** object for the model you are working on and select **New Lateral Extent > From Structural Data**. The **New Lateral Extent** window will appear:

Select the **New Drawing** option to draw the structural data points directly in the scene.
Select the **Existing Structural Data** option to use a table in the **Structural Data** folder. With this option, you will be able to select from the categories available in the data table, if query filters have been created for those categories:

![New Structural Data](image)

Click **OK** to generate the new extent. If you have chosen to create a **New Drawing**, the drawing controls will appear in the scene and you can begin drawing, as described in [Creating a New Structural Data Table](#). To share the new structural data table, right-click on it and select **Share**. The table will be saved to the **Structural Data** folder.

The new lateral extent will appear in the project tree as part of the **Boundary** object.

Lateral extents created in this way can be modified using additional data. See [Refining Extents](#) for more information.

### Creating a Lateral Extent from a Surface

See [Modifying the Model Boundary](#) for more general information about working with lateral extents.

To create a new lateral extent from a surface, the surface must already exist in the project.

Once the surface you wish to use is in the project, right-click on the **Boundary** object and select **New Lateral Extent > From Surface**. The **Select Mesh to Add** window will be displayed, showing the meshes available in the project:

![Select Mesh To Add](image)

Select the surface you wish to use and click **OK**.

The new lateral extent will appear in the project tree under the **Boundary** object.

Lateral extents created in this way can be modified using additional data. See [Refining Extents](#) for more information.

### Creating a Lateral Extent from a Distance to Points

See [Modifying the Model Boundary](#) for more general information about working with lateral extents.
Leapfrog Geo can calculate the distance to set of points and use the resulting distance buffer as a lateral extent.

To create a new lateral extent from a distance buffer, right-click on the **Boundary** object for the geological model you are working on and select **New Lateral Extent > From Distance To Points**. The **Smoothed Distance Buffer** window will appear:

Select the **Distance** and set an **Anisotropy**, if required. Click **OK** to create the new lateral extent, which will appear in the project tree as part of the **Boundary** object.

Lateral extents created in this way can be modified using additional data. See **Refining Extents** for more information.

### Creating a Lateral Extent from a Distance Function

See **Modifying the Model Boundary** for more general information about working with lateral extents.

A distance function calculates the distance to a set of points and can be used to bound a geological model. You can use an existing distance function as a lateral extent or create a new one.

To use a distance function as a lateral extent, right-click on the **Boundary** object for the geological model you are working on and select **New Lateral Extent > From Distance Function**. If there are no distance functions in the project, you will be prompted to create a new one. See **Creating and Editing a Distance Function** for information on defining and editing the distance function.

When there are already distance functions in the project, you will be prompted to choose between creating a new function or using an existing one:

To use an existing function, select it from the dropdown list and set a **Buffer distance**. Click **OK** to create the lateral extent.

When you create a new distance function, it will be part of the geological model's **Boundary** object and will not be available elsewhere in the project. To share it within the project, expand the lateral extent in the project tree and right-click on the distance function. Select **Share**. The distance function will be saved to the **Interpolants** folder.

### Refining Extents

To change the resolution of a lateral extent or base, double-click on it in the project tree. See **Surface Resolution for a Geological Model** for more information.
Extents created from points data, a distance to points function or structural data can be refined using other data in the project. A lateral extent created from a polyline or GIS vector data can also be refined in this way if it was created as a **Surface** rather than as a **Vertical Wall**.

The types of data that can be used to modify a lateral extent are:

- Points
- GIS vector data
- Structural data

The data that can be used to modify the lateral extent depends on how the extent was created. To modify a lateral extent, right-click on the lateral extent and select one of the options from the **Add** menu.

You can also:

- Adjust the surface of lateral extents derived from points data, distance buffers and structural data. See [Adjusting Surfaces](#) for more information.
- Edit the lateral extent using a polyline. See [Editing a Surface with Polylines](#) for more information.
- Edit the lateral extent using structural data. See [Editing a Surface with Structural Data](#) for more information.

## Creating and Refining a Base

Adding a base to a geological model is similar to adding lateral extents and many of the same techniques can be used. See:

- [Creating a Lateral Extent from a Polyline](#)
- [Creating a Lateral Extent from GIS Vector Data](#)
- [Creating a Lateral Extent from Points](#)
- [Creating a Lateral Extent from Structural Data](#)
- [Creating a Lateral Extent from a Surface](#)

A base can also be created from the base lithology used to define the geological model or from other contacts available in the project. Right-click on the **Boundary** object and select either **New Base > From Base Lithology** or **New Base > From Other Contacts**.

The only difference in the two methods is that when creating a base from other contacts, you must first select the lithology column from those available in the project.

When defining the base, select the **First lithology** and the contacts to use:
Click **OK** to create the base, which will appear under the **Boundary** object. The new base will automatically be added to the model.

Each geological model can have only one base defined, so if you wish to define a new base, you must first delete the existing base from the model. Do this by right-clicking on the **Base** object and selecting **Delete**. You can also choose not to use the base you have defined. See **Modifying the Model Boundary** for more information.

When the model's base has been created from data other than a surface, it can be refined using other data in the project. The types of data that can be used to modify base are:

- Points
- Lithology contacts
- GIS vector data
- Structural data

The techniques are the same as those used for refining lateral extents. See **Refining Extents** for more information.
Creating a Faulted Model

Each geological model is created with a Fault System object that is used to construct faults. Once the faults are active in the geological model, the geological model will be divided into separate fault blocks, which will appear in the project tree as part of the model:

![Project tree showing Fault System and Fault blocks]

Each fault block has its own Surface Chronology, which can be modified without affecting other fault blocks in the geological model. There is no top-level Surface Chronology for the geological model once the Fault System has been activated. This means that lithology layers can be constructed for a faulted model in two ways:

- Define the Surface Chronology before enabling the Fault System. All surfaces defined for the unfaulted model will automatically be copied to each fault block. Some surfaces defined for the model as a whole will not occur in every fault block, which can be corrected by working with the surfaces in each fault block.
- Enable the Fault System before any surfaces are defined in the unfaulted model, then define the Surface Chronology for each fault block. An aid to working with a faulted model in this way is the ability to copy contact surfaces from one faulted block to another. See [Copying the Surface Chronology to an Empty Fault Block](#).

Which approach is best depends on the model being built. You may already know where the faults are and choose to define them and subdivide the geological model before defining any lithology layers. On the other hand, sometimes it is not apparent where the faults are until the layers have been built, in which case you can add the new fault, activate it in the model, then work with the surfaces in each fault block.

When a geological model is first created, the Fault System object is empty. To create faults, right-click on the Fault System object and select from the options available. Many of these options are similar to those for creating lateral extents. For more information, see:

- [Creating a Lateral Extent from a Polyline](#)
- [Creating a Lateral Extent from GIS Vector Data](#)
- [Creating a Lateral Extent from Points](#)
- [Creating a Lateral Extent from Structural Data](#)
- [Creating a Lateral Extent from a Surface](#)

Faults created from polylines and GIS vector data can be created as vertical walls or surfaces. Faults created as surfaces can be modified by adding further data in the same manner as lateral extents. See...
Creating a fault from the base lithology or other contacts is similar to creating contact surfaces. See [New Deposit/Erosion From the Base Lithology](#) and [New Deposit/Erosion From Other Lithology Contacts](#) for more information.

Faults will appear in the project tree as part of the **Fault System** object and can be expanded to show how they were created:

Once all the faults required have been created, you can start defining the interactions between the faults by double-clicking on the **Fault System** object. The **Fault System** window will be displayed:
To add an interaction, click on a fault, then click the Add button. Select the Interaction Type and set how the faults interact:

Once you have defined each fault interaction, click OK to generate the fault system. Add the Fault System object to the scene to check that the faults interact correctly.

You can also edit fault interactions by double-clicking on individual faults. The Edit Fault window will open, which shows only the interactions for the selected fault:

Faults are not active in the geological model until the box is ticked for each fault in the Fault System window. This means you can check the fault system without regenerating the geological model.

To activate the fault system in the geological model, double-click on the Fault System object once again and tick the box for each fault. The model will be divided into separate fault blocks that can be worked with in a similar manner to the geological model as a whole.

To view the faulted model in the scene, right-click on the model and select View Output Volumes. To view the fault blocks without displaying the lithology layers, right-click on the model and select View Fault Block Boundaries.
To work with a specific fault block, click on it in the scene. The window that appears displays the name of the selected fault block:

![Fault Block Information Window]

You can also view the output volumes for each individual fault block by right-clicking on the fault block in the project tree and selecting **View Output Volumes**.

### Defining Contact Surfaces

Once a model’s boundaries and fault system have been defined, the next step is to define the internal structure. This involves generating contact surfaces that correspond to the boundaries between lithological units, refining the contact surfaces, arranging them in chronological order and then using the surfaces and the chronological order to divide the geological model into units.

The **Surface Chronology** object represents the collection of contact surfaces and defines how they interact to produce the volumes of the geological model. There are different types of contact surfaces that interact with other surfaces and volumes in different ways:

- **Deposit** contact surfaces do not cut older volumes. A volume defined by a deposit contact surface will, therefore, appear conformably on top of older volumes.

- **Erosion** contact surfaces cut other contact surfaces on the older side of the erosion contact surface.

- **Intrusion** contact surfaces remove existing lithologies and replace them with the intrusive lithology on the younger side of the contact surface. Often, the older side of an intrusion contact surface is labelled “Unknown” as typically intrusions displace multiple older lithologies.

- **Vein** contact surfaces remove existing lithologies and replace them with the vein lithology within the boundaries defined by hangingwall and footwall surfaces and points and a reference surface.
It is not necessary to model geological formations according to their corresponding contact surface type. For example, it might make sense to model basement granite as a deposit rather than as an intrusion when it forms the lowest layer in a geological model: if there are no older layers for an intrusion-type contact surface to remove and it is apparent from the drillhole data that the lithology simply fills the lowermost parts of the model, then it makes sense to model it as a deposit.

The rest of this topic describes the different types of contact surfaces and how they interact. For information on creating the different types of contact surfaces, see:

- Creating Depositional and Erosional Contact Surfaces
- Creating Intrusional Contact Surfaces
- Creating Veins

You can also create a stratigraphy object that defines a series of continuous layers and a vein system that defines the interactions between a series of individual veins. See Creating Stratigraphic Sequences and Creating a Vein System.

Dividing the Geological Model Volume Using the Surface Chronology

When a geological model is first created, it is simply a volume of lithology “Unknown”. The contact surfaces and their order in the Surface Chronology determines how they divide this larger “Unknown” volume into known lithological units. The scene below shows the Surface Chronology for four depositional contact surfaces and two intrusional contact surfaces, bounded by the geological model extents (pink). The two intrusive contacts are labelled as Unknown on the outside and the intrusive lithology on the inside:
The **Surface Chronology** is open, showing the contact surfaces in chronological order, with the youngest at the top of the list. This is the order in which contact surfaces will be used to cut the “Unknown” volume of a newly created model. The different types of contact surfaces cut older volumes in different ways, which are described below.

For the model shown above, the first contact surface to cut the geological model volume is the oldest surface, D5 - D4 contacts. The volume is divided into D5 (red) below and D4 (green) above:

When the next contact surface (D4 - D3 contacts) is enabled in the model, the volume above the contact surface is labelled with the lithology assigned to the surface’s younger side (blue):

Therefore, any volume in a geological model is labelled with the lithology assigned to the youngest side of the surface that last cut the volume.
With a simple depositional geological model, as long as each side of each contact surface is assigned a lithology, all volumes will be labelled with known lithologies. Intrusive contact surfaces, however, are often of unknown lithology on the outside, as they contact multiple lithologies. When the two intrusive surfaces in the model above are enabled but all depositional surfaces are disabled, the unknown lithology is replaced with each intrusive lithology on the inner sides of each contact surface, but outside each intrusive contact surface the lithology is not known:

If the outside of the older contact surface (green) is assigned a lithology (red), the volume outside each intrusion is known and, therefore, the surrounding volume can be labelled:

If, however, the outside of the younger intrusion is known but the outside of the older intrusion is unknown, it is not possible to determine the lithology of the surrounding volume as the lithology on the outer side of the surface making the first cut is not known:
**Younging Direction**

An important factor in determining how surfaces interact is the younging direction of each surface. Each contact surface has a younger side and an older side. Leapfrog Geo will, by default, put the younger side of a contact surface up, since this is geologically reasonable in most situations. If, for example, you know that the geology is overturned, you can change the younging direction once the surface has been created.

When contact surfaces are displayed in the scene, you can choose whether to display the surfaces using the lithology or the younging direction. When the younging direction is displayed, the younger side is typically green and the older side is brown:

When a contact surface is displayed using the younging direction, Leapfrog Geo by default colours the younger side green and the older side brown.

Understanding how the different types of contact surface interact will help you in deciding how to model different units and determine the younging direction.

**Depositional and Erosional Contact Surfaces**

Deposits appear conformably on top of underlying older volumes and do not occur in regions defined by older deposits. Erosions, however, remove existing lithologies on the older side of the erosion. The difference between the two types of contact surface is illustrated here, using a model made up of three deposits, A, B and C:
The contact surfaces that define the three output volumes are as follows, with the B-C contacts surface toward the top of the model extents and the A-B contacts surface lower down:

Note that the output volumes are named according to the lithologies assigned to each side of the contact surfaces that bound each volume.

An erosional contact surface (C-D contacts) added to the model cuts across the A-B and B-C contacts. The younger (purple/D) side of the C-D contact surface faces up:

Once the model is recalculated, the erosion (D) has cut away the deposits on the older side of the erosion:
However, if the C-D contact surface is made a depositional surface, D only occurs on the younger side of the C-D contact surface and does not cut away the A, B and C volumes:

Output volumes are named according to the lithologies assigned to each side of the contact surfaces that bound each volume. For example, in the depositional model above, all volumes are labelled with a known lithology, because each side of each contact surface has a lithology assigned and this can be used to identify the lithology for each volume. If, however, no lithology is set for the youngest contact surface on the younger side, the upper volume will be labelled Unknown:

Usually this is not an issue for depositional and erosional contact surfaces, with a known lithology assigned to each side of the surface.

See Creating Depositional and Erosional Contact Surfaces for information on techniques for creating depositional and erosional contact surfaces.
Intrusional Contact Surfaces

An **intrusion** is a type of contact surface that removes existing lithologies and replaces them with the intrusive lithology. An intrusional surface (E) added to the model as the youngest surface cuts away the other lithologies wherever it occurs:

Note that the intrusive contact surface is labelled “Unknown - E contacts”, as the intrusion contacts multiple units. This is typical of intrusive contact surfaces as an intrusion will usually displace multiple older lithologies. Although the outside of the intrusive volume is not labelled with a lithology, the lithology of each volume the intrusion comes into contact with can be known from the lithologies assigned to the depositional contact surfaces.

However, when all contact surfaces are intrusive, the lithology of the surrounding volume cannot be known, which results in intrusive volumes surrounded by an Unknown volume:

In this instance, the contact surfaces each have a known side and an unknown side:
Adding the drillholes to the scene helps in understanding what lithology the outside of each intrusion should be:

In this case, assigning the outside of both intrusions to AvT results in a model for which all volumes are labelled with a known lithology:

See [Creating Intrusional Contact Surfaces](#) for information on techniques for creating intrusive contact surfaces.

**Vein Contact Surfaces**

**Veins** remove existing lithologies and replace them with the vein lithology within the boundaries defined by hangingwall and footwall surfaces and points and a reference surface. Here, a slice has been made horizontally through a model made up of three deposits:
Adding five dykes modelled as veins and enabling them in the model results in the veins cutting away each deposit at the point of contact:

Here the sliced deposits are displayed but the veins are hidden in order to show how they cut away the deposits:

The veins cut one another according to the chronological order set in the Surface Chronology. Vein In 1 (aqua) is the oldest vein and so is cut by the younger veins In 4 (yellow) and In 5 (green):
See [Creating Veins](#) for information on techniques for creating vein contact surfaces.

All contact surfaces except those created as part of a stratigraphic sequence can be modified using the techniques described in [Surface Resolution in Leapfrog Geo](#).

### Creating Depositional and Erosional Contact Surfaces

See [Defining Contact Surfaces](#) for more general information on the different types of contact surface and how they interact.

To create a new depositional or erosional contact surface, right-click on the **Surface Chronology** object and select one of the **New Deposit** or **New Erosion** options. See:

- [New Deposit/Erosion From the Base Lithology](#)
- [New Deposit/Erosion From Other Lithology Contacts](#)
- [New Deposit/Erosion From Other Data](#)

#### New Deposit/Erosion From the Base Lithology

Lithology data is often the most reliable data source to use when building geological surfaces. It is best to derive contact surfaces from lithology data, when it is available. There are two ways to create contact surfaces from lithology data:

- Using the base lithology column assigned when the model was created. This is the process described below.
- Using other lithology information available in the project. This is useful when you have created an additional lithology column as part of correcting and working with the drillhole data. For example, if when building a geological model it becomes apparent that changes need to be made to the drillhole data, you can import additional data or create a new column using the split lithology, group lithology or interval selection tools. See [New Deposit/Erosion From Other Lithology Contacts](#) for more information.
Selecting the **From Base Lithology** option opens the **New Contact Points** window:

Select the lithology you wish to use to create the surface from the **Select primary lithology** list; this will be the older lithology (lower down) in the geological model. The **Contacting/Avoided lithologies** list shows the lithologies that contact the primary lithology and the number of contacts. This helps in selecting which contacts to use to create the contact surface.

Data can be composited at the drillhole level or on a surface-by-surface basis. To composite the data used to generate the contact surface, click on the **Compositing** tab. See [Compositing Category Data](#) for more information.

The options in the **Lithology** tab are useful for creating a surface when one lithology is interbedded with another. For example, here we can see that the coarse sand is interbedded with alluvium:
The solution to this is to create two surfaces from the Alluvium contacts, one using the contacts above (younger contacts) and the other using the contacts below (older contacts):

Note that the gravel contacts should be excluded for the surface created from the **Use contacts below** option, as we can see from the drillhole data that gravel appears lower down in the model than the surface we are creating. Do this by dragging the contacts that should be excluded to the **Ignored lithologies** list:
For complex geologies, the up and down directions for the surface may not be clear. If this is the case, untick the **Horizontal Plane** box. A reference plane will appear in the scene, with the up-facing surface labelled A and the downward-facing surface labelled B:

Controlling the position of the reference plane is similar to controlling the position of the moving plane:

- Use the handles in the scene window to move the plane.
- Set the **Dip** and **Dip Azimuth** values in the **New Contact Points** window. The reference plane will be updated in the scene.

Once the reference plane is correctly oriented, click the **Set From Plane** button.

Setting a reference plane for contact points is different from applying a global trend to a surface. To apply a global trend to a surface, double-click on the surface in the project tree and click on the **Trend** tab. See [Adjusting Surfaces](#).

The name Leapfrog Geo automatically assigns to a contact surface will be of the format “Older Lithology - Younger Lithology” or “Older Lithology contacts” when the lithology contacts multiple lithologies.

Click **OK** to create the contact surface, which will appear in the project tree under the **Surface Chronology**. Expand the surface in the project tree to see how it was made:

Double-click on the contact surface to edit the surface. Double-click on the contacts object (ジョン) to edit the contacts and adjust the reference plane. Double-click on the segments object (ジョン) to edit compositing settings.

As further refinements are made to the surface, that information will also be added to the project tree. See [Editing Contact Surfaces](#) for more information on refining the contact surface.
Add the contact surface to the scene to view it and check that it is oriented correctly. Here, the Basement Granite contacts surface has been added to the scene, together with the drillholes:

Because the upper side of the surface represents contacts with multiple lithologies, it is labelled “Unknown” and appears in the scene according to the colour assigned to “Unknown” (white). The surface is oriented correctly, with the Basement Granite side at the bottom and the Unknown side facing up, but if the younging direction was incorrect, correcting it is a simple process. Double-click on the surface in the project tree to open the Edit window:

Click Swap Younging Direction to correct the orientation of the surface, which will be reflected in the scene, if the contact surface is displayed. Note that changing the younging direction does not change which lithology is older or younger.

See Editing Contact Surfaces for more information on the settings in this screen and the different techniques that can be used for adjusting a contact surface.

New Deposit/Erosion From Other Lithology Contacts

Creating contact surfaces using the From Other Contacts option is useful when you have created an additional lithology column as part of correcting and working with the drillhole data. For example, if when
building a geological model it becomes apparent that changes need to be made to the drillhole data, you can import additional data or create a new column using the split lithology, group lithology or interval selection tools. See Splitting Lithologies, Grouping Lithologies and Selecting Intervals for more information.

The process is similar to creating a surface from the base lithology column, but you must first select the lithology column you will use:

Select the First Lithology and Second Lithology, if known. Click OK. The New Contact Points window will appear. Assign the Primary lithology, Contacting/Avoided lithologies and the Ignored lithologies. These can only be selected from the model’s base lithology.

The rest of the process is similar to defining a contact surface from the base lithology. See New Deposit/Erosion From the Base Lithology for more information.

Be sure to add the contact surface to the scene to view it and check that it is oriented correctly.

See Editing Contact Surfaces for more information on the different techniques that can be used for adjusting a contact surface.

New Deposit/Erosion From Other Data

If suitable lithology data is not available, contact surfaces can be created from other data in the project, such as GIS data, structural data, points, polylines and surfaces. The steps for creating depositional and erosional contact surfaces from non-drillhole data are similar, regardless of the data used to create the surface:

- Select the data object that will be used to define the surface. This must already be in the project, unless you are using a polyline, in which case you are given the option to create a new polyline.

- Select the First lithology and Second lithology. These are the lithologies that will be assigned to each side of the contact surface. The lithologies you can choose from are those defined for the geological model in the Lithologies object (see Editing the Lithologies).

- Set whether the First lithology is older or younger than the Second lithology. Leapfrog Geo will, by default, put the younger side of a contact surface up, but this can be changed later.

Here, a points data object is being used to create a contact surface:
For polylines, you first set the lithologies and the younging order:

![New Depositional Contact dialog box]

Click **OK** to move on to the next step:

![New Polyline dialog box]

You can draw the polyline in the scene directly by selecting the **New Drawing** option. You can also use any polyline in the project by selecting the **Existing Polyline** option. You can then select the required polyline from the dropdown list.

The new contact surface will appear in the project tree under the **Surface Chronology**. Add the contact surface to the scene to view it and check that it is oriented correctly.

Expand the surface in the project tree to see how it was made. Here, a number of surfaces have been created using different types of data:

![Surface chronology tree]

If creating a surface from a new polyline, the polyline will not be able to be used elsewhere in the project unless it has been shared. To share the polyline, expand the contact surface in the project tree, right-click on the polyline and select **Share**. The polyline will then be available elsewhere in the project.

As further refinements are made to the surface, that information will also be added to the contact surface in the project tree. See **Editing Contact Surfaces** for more information on techniques that can be used to refine the surface.

**Creating Intrusional Contact Surfaces**

See **Defining Contact Surfaces** for more general information on the different types of contact surface and how they interact.
To create a new intrusional contact surface, right-click on the **Surface Chronology** object and select one of the **New Intrusion** options. The options for creating an intrusional contact surface from data other than drillhole data are similar to those for creating depositional and erosional contact surfaces. One thing to keep in mind for all intrusional contact surfaces is that an intrusion removes all the existing material on the younger side of the contact surface. Therefore:

- An intrusion should always have the younger side of its surface labelled with the intruded material.
- The older side will typically be labelled “Unknown” as an intrusion will usually displace multiple older lithologies.

See [Defining Contact Surfaces](#) for more information on creating contact surfaces from non-drillhole data.

The remainder of this topic describes creating intrusional contact surfaces from lithology data. There are two options:

- Using the base lithology used to define the geological model. Select **New Intrusion > From Base Lithology**.
- Using other contacts available in the project. Select **New Intrusion > From Other Contacts**.

The only difference in the two methods is that when creating an intrusion from other contacts, you must first select the lithology column from those available in the project and specify the **First lithology** and **Second lithology**.

Drag any younger lithologies to the **Ignore** list.

![New Intrusion dialog](image)

Compositing category data sorts segments into three categories, as described in [Compositing Category Data](#). For intrusional contact surfaces, these categories are:

- **Interior**. This is the unit of interest and is equivalent to **Primary**.
- **Ignored**. These are lithologies that are younger than the intrusive lithology and should, therefore, be ignored in generating the contact surface.
- **Exterior**. These are lithologies that occur outside of the unit of interest. For an intrusive lithology, other lithologies the intrusion contacts should be classified as **Exterior**.
Select whether unspecified intervals should be treated as **Ignored**, **Interior** or **Exterior**.

**Compositing Intrusions**

Sometimes intrusive boundaries are poorly defined, with fragments of country rock intermixed with the intrusive body. This can result in very small segments near the edges of the intrusion. Modelling the fine detail is not always necessary, and so compositing can be used to smooth these boundaries. Compositing parameters are set in the **Compositing** tab:

![Compositing tab](image)

The settings in this tab are described in [Compositing Category Data](#).

**Editing Intrusions**

Intrusional contact surfaces will appear in the project tree as part of the **Surface Chronology** object, together with objects used to create the contact surface. See [Editing Contact Surfaces](#) for more information.

**Displaying Intrusion Points**

When you view the intrusion points in the scene, you can display only the contact points or all the points used in creating the intrusion. To display all points, click on the points object (☐) in the shape list and tick the box for **Show volume points**.
When the volume points are displayed, points with negative values are those outside the surface, while points with positive values are those inside.

You can change the way intrusion points are generated by double-clicking on the points object in the project tree. See Changing Intrusion Point Generation Parameters.

### Creating Veins

A vein is a type of contact surface that removes existing lithologies and replaces them with the vein lithology within the boundaries defined by hangingwall and footwall surfaces constructed from selected input data. A reference surface is defined that is the best fit for the hangingwall and footwall surfaces. The reference surface can be curved or planar.

Options for creating veins are:

- From lithology data, using the base lithology used to define the geological model or other contacts available in the project. See Creating Veins From Lithology Contacts.

- From GIS vector data, point data and polylines. See Creating Veins From Other Data.

- Creating a vein system. This results in a single lithology that represents all the veins in a model. Veins and their interactions are defined within the vein system. See Creating a Vein System.

Veins and vein systems are stored in the project tree as part of the Surface Chronology object. Further modifications can be made to the vein by working on the objects that make up the vein. Expand the vein in the project tree to view these objects.
Here, the hangingwall and footwall surfaces and points are displayed in the scene for a vein defined from lithology data. The reference surface (yellow) and the vein segments (red and blue cylinders) used to create the vein are also shown:

This vein is made up of:

- Hangingwall and footwall surfaces ( ), which, when expanded, show the hangingwall and footwall data objects used to create the surfaces.
- Vein segments and pinch out segments ( ) extracted from drillhole data. These are only included when a vein is created from lithology contacts.
- A reference surface ( ) calculated as the best fit surface using the hangingwall and footwall surfaces.
- A boundary object ( ), which is empty when the vein is first created.

The hangingwall and footwall surfaces can be exported, as described in Exporting a Mesh and Exporting an Elevation Grid. You can add points to the meshes by right-clicking on them and selecting Add. These surfaces can also be edited with polylines; right-click on the surface and select one of the Edit options.

You can change the way the different objects that make up the vein are displayed using options in the shape list:

Tools for refining veins differ from those for refining other types of contact surface. See:

- Changing Vein Surfacing Options
- Adjusting the Vein Reference Surface
- Changing the Vein Boundary
- Editing Vein Segments
Creating Veins From Lithology Contacts

To create a new vein from lithology contacts, right-click on the Surface Chronology object and select either New Vein > From Base Lithology or New Vein > From Other Contacts. The only difference in the two methods is that when creating a vein from other contacts, you must first select the lithology column from those available in the project and specify the Vein lithology and Outside lithology.

In the New Vein window, select the Vein lithology:

![New Vein window](image)

When extracting the hangingwall and footwall points, Leapfrog Geo automatically includes points at the ends of the drillholes. To exclude these points, untick the Include points at the ends of holes. Once the vein has been created, this setting can be changed by double-clicking on the vein segments object in the project tree.

Click OK to create the vein, which will be added to the project tree as part of the Surface Chronology object. See Creating Veins and Editing Contact Surfaces for more information on techniques that can be used to refine the vein.

Creating Veins From Other Data

If suitable lithology data is not available, veins can be created from other data in the project, such as GIS data, points and polylines. The steps for creating veins from non-drillhole data are similar, regardless of the data used to create the surface:

- Select the data objects for the Hangingwall and Footwall. These objects must already be in the project.
- Select the Vein lithology and the Outside lithology. The lithologies you can choose from are those defined for the geological model in the Lithologies object (see Editing the Lithologies).

Here, a points data object is being used to create a vein:

![New Vein Contact window](image)

Click OK to create the new vein. The new contact surface will appear in the project tree under the Surface Chronology. Expand the vein in the project tree to see how it was made.
As further refinements are made to the vein, that information will also be added to the vein in the project tree. See Creating Veins and Editing Contact Surfaces for more information on techniques that can be used to refine the vein.

**Changing Vein Surfacing Options**

Double-click on the vein (%) in the project tree to edit basic settings. In the Surfacing tab, you can set the vein thickness and pinch out options:

![Edit B1](image)

See Editing Contact Surfaces for information on the other settings you can change for the vein.

**Setting the Vein Thickness**

Veins have two thickness settings that force the vein to maintain a minimum or maximum thickness. If footwall and hangingwall points are in pairs, it is not usually necessary to set the Minimum thickness or Maximum thickness.

- If the vein intersects itself, set the Minimum thickness to a value that is less than the minimum distance between any two contact points.
- If the vein widens out toward the edges of the geological model set the Maximum thickness to a value that limits the effects of long segments.

If the Pinch out option is enabled, you will not be able to set the Minimum thickness. If you set the Maximum thickness and Pinch out, the Pinch out is applied before the Maximum thickness.

**Controlling Vein Pinch Out**

Vein walls can be set to pinch out where drillhole data indicates they do not occur. This is achieved by creating ‘outside’ intervals on drillholes that do not have an interior vein segment. These intervals are then flipped with respect to interior vein intervals, which, in effect means the footwall and hangingwall orientation has the opposite sense to the nearest interior intervals. This forces the hangingwall and footwall surfaces to cross, thereby pinching out.
The **Pinch out** option is disabled when a vein is first created. To enable it, double-click on the vein in the project tree and click on the **Surfacing** tab. Tick the box for **Pinch out**. Click **OK** to process the changes. The vein will be updated and pinch out points (📐) will be added to the vein in the project tree.

For this vein, the surface occurs even where the vein lithology (green cylinders) does not occur and terminates at the boundary of the geological model:

![Diagram of the vein with pinch out points marked.](image1)

When the vein is set to pinch out, it tapers out where the vein lithology does not occur:

![Diagram of the vein tapering out.](image2)
You can change how much the vein pinches out by excluding some pinch out segments. To do this, right-click on the pinch out segments in the project tree and select Edit in Scene. The Pinch Out Properties window will appear in the scene. Click on a segment to view information about it and set it to be Excluded, if required. Note that the segments displayed in the scene below are the pinch out segments rather than the drillhole segments shown in earlier scenes. The grey segments are excluded and the currently selected segment is highlighted in the scene:

Click the Save button to view the effect of the excluded pinch out segments on the vein. Excluding the two segments results in the vein terminating at the boundary of the geological model:

Adjusting the Vein Reference Surface

A vein includes a reference surface that is the best fit for the objects that make up the hangingwall and footwall surfaces. There are two types of reference surface.

- **Curved.** A curved reference surface can be used to make a vein follow the medial trend of the source data, which leads to a more natural modelled shape. This is the type of reference surface used by default.
for veins created from lithology data. A curved reference surface can be used for veins created from other types of data by adding data to the reference surface, as described below.

- **Planar.** A planar reference surface is simply the best linear fit between the hangingwall and footwall surfaces.

To adjust the reference surface (.), double-click on it in the project tree or right-click on it and select **Open.** The **Reference Surface** window will appear, showing the data used to for the reference surface. This is the reference surface for a vein created from lithology data, and so the midpoints for the vein lithology are used as **Input values:**

---

**Adding Data to the Reference Surface**

In order for a vein created from data other than lithology data to use a curved reference surface, other data must be added to it. To add data, right-click on the reference surface in the project tree and select **Add** or **Edit.** Once you have added data, the **Curved reference surface** option will be enabled in the **Reference Data** window and the objects used to adjust the surface will appear in the list of **Input values:**

![Reference Surface Window](image)

You can enable or disable the different data objects to see their effects on the vein. Click **OK** to process the changes.

**Using a Planar Reference Surface**

Veins created from objects other than lithology data use a planar reference surface, and this option can also be selected for veins created from lithology data. To use a planar reference surface, select the **Planar reference**
surface option in the Reference Surface window. The plane will be displayed in the scene, together with handles that can be used to adjust it:

These handles work in the same manner as the moving plane controls, as described in Using the Moving Plane. Click OK to update the reference surface and view the results.

Changing the Vein Boundary

Once a vein has been created, you can change its boundary by:

- Adding a polyline to the boundary
- Adjusting the boundary plane
Adding a Polyline to the Vein Boundary

To change the boundary using a polyline, right-click on the boundary object (▼) in the project tree and select Edit. The current vein boundary will appear in the scene, together with drawing controls. Begin drawing the new boundary, as described in Drawing With the Straight Line Tool, ensuring that the polyline drawn closes and does not intersect itself.

When you save the boundary, the vein will be updated to reflect the changes to the boundary. If you want to revert to the original boundary, right-click on the boundary object (▼) and select Delete Polyline.

Adjusting the Vein Boundary Plane

To adjust the boundary plane, right-click on the boundary object (▼) in the project tree and select Adjust Plane. The Adjust Boundary Plane window will appear and handles to adjust the plane will appear in the scene:
Click OK to apply the changes to the vein. To revert to the original boundary plane, right-click on the boundary object and select Adjust Plane. In the Adjust Boundary Plane window, click on the Set to Default button and click OK.

**Editing Vein Segments**

When a vein has been created from contact points, you can change the vein segment settings by double-clicking on the vein segments object ( ) in the project tree. This opens the Edit Vein window.

When extracting the hangingwall and footwall points, Leapfrog Geo automatically includes points at the ends of the drillholes. To exclude these points, untick the Include points at the ends of holes.

**Changing the Orientation of Vein Segments**

If you need to change the orientation of individual vein segments, e.g. for curved veins, you can do this by right-clicking on the vein segments object ( ) in the project tree and selecting Edit In Scene. If the vein segments object is already in the scene, you can edit it by clicking the Edit button ( ) in the shape list.

The Vein Segment Orientations window will appear in the scene. Click on a vein segment to view information about that segment:

Points A and B are labelled in the scene and can be changed by unticking the box for each point and choosing whether to exclude the point or make it a hangingwall or footwall point. Once you have finished editing vein segments, click the Save button ( ).

If you wish to return to the default settings, ensure the Auto box is ticked for each point.

**Creating a Vein System**

An alternative to defining veins one-by-one is to create a vein system. The vein system represents a single lithology within the geological model. For example, for a model of a sedimentary system cross-cut by vertical
intersecting dykes, we could model the veins one-by-one, in which case each “vein” in the model is represented by a separate lithology:

Modelled as a vein system, however, the veins are grouped into a vein system object (▃) that defines the lithology for the vein system as a whole:

Note that the individual veins are part of the vein system.

The vein system defines how the veins interact, and veins can be added to it using the same techniques used to create individual veins.

To create a vein system, right-click on the Surface Chronology and select New Vein System. In the window that appears, select the Vein lithology:

If the vein system contacts only one lithology, set the Outside lithology. Otherwise, leave Outside lithology set to Unknown.
Click **OK**. An empty vein system ($\text{\textbullet}$) will be added to the project tree under the **Surface Chronology**. Double-click on it to change the lithologies.

**Adding Veins to the Vein System**

Once the vein system has been created, you can create veins using the same techniques described in [Creating Veins From Lithology Contacts](#) and [Creating Veins From Other Data](#).

To add veins to the vein system, right-click on the vein system and select one of the **New Vein** options. Veins will appear in the project tree as part of the vein system object and can be expanded to show how they were created.

**Setting Vein Interactions**

Once all the veins required have been created, you can start defining the interactions between them by double-clicking on the vein system object ($\text{\textbullet}$), then clicking on the **Vein System** tab:

![Edit Vein System](image)

The veins appear in the list from highest priority to lowest. Organise the veins in chronological order before defining interactions. You cannot define an interaction for the highest priority vein in the list.
To add an interaction, click on a vein, then click the **Add** button. Select the **Interaction Type** and set how the veins interact:

![Image: Edit Vein System]

Once you have defined the required vein interactions, tick the box for each vein, then click **OK**. Add the **Vein System** object to the scene to check that the veins interact correctly. You can also edit vein interactions by double-clicking on the individual veins.

Veins and the vein system are not active in the geological model until the box is ticked for each vein in the **Edit Vein System** window and the vein system is enabled in the **Surface Chronology**. This means you can check the vein system without regenerating the geological model.

**Creating Stratigraphic Sequences**

When you have a series of continuous layers in a geological model, you can model each layer separately or you can model them as a single stratigraphic sequence. Modelling a stratigraphic sequence works best for sequences uniform in thickness with a consistent stacking order. Once you have created a stratigraphic sequence, you can refine it by adding and removing layers and by adjusting the surfaces produced.

When a layer varies in thickness, the contact surface will not match the contact points in some places. This will be a consideration when choosing whether to model layers as part of a stratigraphic sequence or as a separate object.
To create a stratigraphic sequence, right-click on the **Surface Chronology** object and select **New Stratigraphy**. The **New Stratigraphic Sequence** window will appear:

First select the **Lithology Above** and **Lithology Below** by selecting from the lithologies available in the geological model:
Next, click the Add Lithologies button to view available lithologies:

Click OK to add the layers to the Stratigraphic Lithologies list, and then make sure they are arranged in the correct order.

In the New Stratigraphic Sequence window, select whether the Bottom Contact Type is an erosion or a deposit.

In the Surfacing tab, the Surface Stiffness controls the smallest bend a surface will make, where a higher value will result in a smoother surface that bends less. The default value is 0, which is no stiffening.

The options for Snap to contact points are:

- Inherit from GM. The setting for the geological model as a whole will be used. This is the default setting.
- On. Set the Maximum snap distance.
- Off.

All contact surfaces that make up a stratigraphic sequence will inherit the Snap to contact points setting from the stratigraphy. See Refining a Geological Model for more information on this setting.

Click OK to create the stratigraphy, which will be added to the project tree as part of the Surface Chronology object.

The objects that make up the stratigraphy include the generated contact surfaces and any points that result in pinch-out errors:

Add the pinch-out errors object (شاهد) to the scene to view the points that are causing errors. To find out more about the errors, right-click on the stratigraphy object and select List Errors.
In the **Stratigraphic Errors** window, information is provided about the different errors that occur in the stratigraphic sequence, with pinch-out errors and other errors listed separately:

![Stratigraphic Errors Window](image)

Use this information, together with the pinch-out error points, to either remove lithologies from the sequence or adjust surfaces using any of the tools available for individual surfaces. Right-click on each contact surface in the sequence to see what tools are available. You can also ignore an error by ticking the **Ignored** box.

**Editing Contact Surfaces**

Once a contact surface has been generated, you can refine it in several ways:

- Add other data. Right-click on the surface to see the options available, which will depend on how the surface was created.

- Edit the surface with a polyline. Right-click on the surface in the project tree and select either **Edit > With Polyline** or **Edit > With Curved Polyline**. See [Editing a Surface with Polylines](#) for more information.

- Edit the surface extent using structural data. Right-click on the surface and select **Edit > With Structural Data**. See [Editing a Surface with Structural Data](#) for more information.

You can edit the contacts used to generate the surface by expanding the contact surface in the project tree and double-clicking on the points object ( or ).

You can also change settings for a surface by double-clicking on it in the project tree. The window that appears has three tabs:

![Edit Gravel - Alluvium contacts](image)
The Surfacing Tab

See Surface Resolution for a Geological Model for information about the resolution settings in the Surfacing tab.

For Snap to contact points, there is a general setting for the geological model as a whole, which is set in the Geological Model > General tab (see Refining a Geological Model). For individual surfaces, the options are:

- Inherit from GM. The setting for the geological model as a whole will be used. This is the default setting.
- On. Set the Maximum snap distance.
- Off.

You can set Snap to contact points for deposits, erosions and intrusions, but not veins. You can also set Snap to contact points for a stratigraphic sequence, but not for the individual contact surfaces in the sequence. All contact surfaces that make up a stratigraphic sequence will inherit the Snap to contact points setting from the stratigraphy.

For intrusions, clicking Additional options adds Value Clipping and Interpolant tabs to the window and also allows the use of a structural trend in the Trend tab:

See below for more information on these additional features.

For veins, there are additional settings related to vein thickness and vein pinch out. See Changing Vein Surfacing Options.

The Trend Tab

You can also adjust the surface by applying a global trend. See Adjusting Surfaces.

For intrusions, you can also use a structural trend. To do this, click the Additional options button in the Surfacing tab, then click on the Trend tab.
Click on **Structural Trend**. then select the required trend from the dropdown list. See [Creating and Applying Structural Trends](#) for more information.

**The Value Clipping Tab**

The **Value Clipping** tab is only available for intrusive contact surfaces.

In the **Value Clipping** tab, you can manipulate the data distribution by clipping the data:

Clipping cuts off values that are outside the range set by the **Lower bound** and **Upper bound** values. For example, if you change the **Upper bound** from 16.00 to 10.00, distance values above 10.00 will be regarded as 10.00.
The **Automatic clipping** setting has different effects based on whether a global trend or structural trend is set in the **Trend** tab:

- When a global trend is applied, Leapfrog Geo automatically clips the values. That is, the **Automatic clipping** setting is **Do clipping** and Leapfrog Geo sets the **Lower bound** and **Upper bound** from the data. To disable clipping, untick **Automatic clipping**, then untick **Do clipping**. To change the **Lower bound** and **Upper bound**, untick **Automatic clipping**, then change the values.

- When a structural trend is applied, Leapfrog Geo automatically does not clip the values. To clip values, untick **Automatic clipping**, then tick **Do clipping**. Again, Leapfrog Geo sets the **Lower bound** and **Upper bound** values from the data and you can change them, if required.

**The Interpolant Tab**

The **Interpolant** tab is only available for intrusive contact surfaces. For more information on the settings in this tab, see:

- [The Spheroidal Interpolant Function](#)
- [The Spheroidal Interpolant Function](#)
- [The Linear Interpolant Function](#)

**Copying the Surface Chronology to an Empty Fault Block**

If you are working with a faulted model and have defined the **Surface Chronology** for one fault block, you can copy the **Surface Chronology** to the empty fault blocks. To do this, right-click on the **Surface Chronology** for which you have defined surfaces and select **Copy Chronology To**. In the window that appears, select the fault blocks you want to copy contacts to and click **OK**. The surfaces will be copied and you can modify them without affecting the surfaces in the other fault blocks.

**Adding Contact Surfaces to the Surface Chronology**

When you create a contact surface, it appears in the project tree under the **Surface Chronology** object, but it is not enabled and, therefore, does not affect the geological model volumes. This means you can work on the surface without having to reprocess the model whenever you make a change to the surface. In Leapfrog Geo, you can easily define, enable and remove contact surfaces from a model, and you can experiment with modelling lithologies using different techniques in order to arrive at a geologically reasonable model.
To add a contact surface to the surface chronology, double-click on the Surface Chronology object. The Surface Chronology window will be displayed:

In the project tree, the surfaces are also arranged in chronological order:

The Surface Chronology determines the overall chronological order of the contact surfaces in the model. If you build your models from the bottom up, you will find that often the contact surfaces are in the correct chronological order when you first open the Surface Chronology window. However, you can easily rearrange the chronology using the Younger and Older buttons. Tick the boxes for surfaces you wish to include in the model. When you click OK, the included surfaces will be used to subdivide the geological model into lithological layers. The volumes will appear in the Output Volumes folder.

Output volumes are named according to the lithologies assigned to each side of the contact surfaces that bound each volume. See Defining Contact Surfaces for more information.

If you are working with a faulted model and have defined the Surface Chronology for one fault block, you can copy the Surface Chronology to the empty fault blocks. See Copying the Surface Chronology to an Empty Fault Block.
Refining Lithological Volumes

When you have built a geological model and want to model further within one of the volumes, you can do this by creating a refined geological model. This changes the way the original (parent) geological model is organised in the project tree and makes it possible to create a sub-model within one or more of the lithological volumes.

Before starting to refine lithological volumes, it is a good idea to make a copy of the original geological model.

To start refining a lithological volume, first create the refined geological model. To do this, right-click on the Geological Models folder and select New Refined Model:

In the window that appears, select the geological model to refine and then select from its lithologies.

Next, set the **Base lithology column**, **Filter data** and **Surface resolution**. You cannot change the **Base lithology column** once the refined geological model has been established, but you will be able to change the resolution and data filter settings.

Click **OK** to create the refined lithology.
A new refined model will be created in the project tree and the parent geological model will be moved into it. Here, a model called “M Campaign GM” has been used to create a new refined model, with the QzP volume selected as the refined lithology:

The sub-model is created inside the refined geological model and has its own Boundary, Lithologies, Surface Chronology and Output Volumes objects.

You can work with the sub-model in the same manner you would a normal geological model. The exceptions are:

- The sub-model’s boundary cannot be refined directly. However, changes to the parent geological model will be updated in the sub-model’s boundary.
- The sub-model cannot have its own fault system. If the parent geological model is faulted, the sub-model will have its own fault blocks in which you can work.

See Editing the Sub-Model for information on refining the sub-model.

You can still work with the parent geological model in the usual manner. Any changes to the parent geological model that change the extents of the sub-model will be reflected in the sub-model’s boundary.

You can create additional sub-models by right-clicking on the refined model and selecting Refine Lithology.

A sub-model can be viewed and evaluated in the same manner as normal geological models. However, sub-models cannot be used as layer guides for flow models.

Deleting the refined geological model deletes all models it contains. To return to the original project tree organisation for a geological model, delete the sub-models:
Once there are no more sub-models, the refined model object is also deleted, leaving the parent geological model.

The refined model has its own **Lithologies** table, which contains all the lithologies from the parent model and any sub-model lithologies. You cannot add lithologies to this table. To add more lithologies to a refined model, add them to the lithology table in either the sub-model or the parent geological model.

The refined model also has its own **Output Volumes** folder that combines information from the parent geological model and the sub-model. If no surfaces have been created in the sub-model, adding the refined model to the scene will simply display the volumes from the parent geological model. If surfaces have been created in the sub-model, then the volumes of the sub-model will be displayed alongside the volumes from the parent geological model.

**Editing the Sub-Model**

Work with the sub-model in the same manner described in **Refining a Geological Model**. See **Defining Contact Surfaces** and **Adding Contact Surfaces to the Surface Chronology**.

The sub-model can have resolution settings that are different from those of the parent model. See **Surface Resolution in Leapfrog Geo** and **Surface Resolution for a Geological Model**.

To change the lithology’s resolution settings, double-click on the sub-model ();} in the project tree. The **Geological Model** window appears:

This window has only three tabs:

- There is no **Boundary** tab because the sub-model’s boundary can only be modified by modifying the parent geological model.
- There is no **Fault System** tab because a sub-model cannot have its own fault system.
Building Interpolants

The FastRBF™ algorithm employs interpolation functions to estimate values from known data. From these estimated values, geological surfaces are constructed as part of the model-building process.

With the Interpolant folder, you can create interpolants and change their parameters. There are three different types of interpolant you can work with in the Interpolants folder:

- A numeric interpolant describes a physical quantity that varies continuously in space. A numeric interpolant can be used to model, for example, grade distribution, with isosurface values set to represent both minimum concentrations of interest and regions of high value. See Creating a Numeric Interpolant.

- An indicator interpolant calculates the likelihood that values will fall above and below a specific threshold. An indicator interpolant can be used to produce a volume inside which further modelling is carried out. For example, you can create an indicator interpolant for grade values above a certain threshold, and then use the inside volume as a lateral extent for another model. See Creating an Indicator Interpolant.

- A distance function calculates the distance to a set of points. As with an indicator interpolant, a distance function is useful for restricting processing to a specific region. To do this, create a distance function, select the objects to use, then add at least one buffer. You can then use one of the distance function's isosurfaces as a lateral extent for another model. See Creating and Editing a Distance Function.

Values that can be interpolated include down-drillhole numeric data or points data.

Interpolant Functions

Leapfrog Geo’s powerful 3D interpolation engine can interpolate any numeric data (e.g. ore grade or piezometric head measurements) to describe how a real, numerical quantity varies in three dimensional space. Interpolation produces an estimate or “interpolated value” of a quantity that is not known at a point of interest but is known at other points.

The simplest way to estimate values is to take the average of known values. Using this method, estimated values are the same everywhere, regardless of the distance from known data. However, this is not ideal as it is reasonable to assume that an estimated value will be more heavily influenced by nearby known values than by those that are further away. The estimates for unknown points when varying the distance from known point values is controlled by the interpolant function. Any interpolation function and the various parameters that can be set for each will produce a model that fits all the known values, but they will produce different estimates for

© 2014 ARANZ Geo Limited
the unknown points. It is important to select interpolation functions and parameters that make geologic sense. It may be necessary to identify a location that models predict differently, and plan drillholes to identify the best fit option.

Leapfrog Geo uses two main interpolant functions: the spheroidal interpolant function and the linear interpolant function. See The Spheroidal Interpolant Function and The Linear Interpolant Function for more information.

The Spheroidal Interpolant Function

In common cases, including when modelling most metallic ores, there is a finite range beyond which the influence of the data should fall to zero. The spheroidal interpolant function can be used when modelling in these cases.

The spheroidal interpolant function closely resembles a spherical variogram, which has a fixed range beyond which the value is the constant sill. Similarly, the spheroidal interpolant function flattens out when the distance from X is greater than a defined distance, the range. At the range, the function value is 96% of the sill with no nugget, and beyond the range the function asymptotically approaches the sill. The chart below labels the y-axis interpolant. A high value on this axis represents a greater uncertainty relating to the known value, given its distance from X. Another way to think of this is that higher values on this axis represent a decreasing weight given to the known value.

Known values within the range are weighted proportionally to the distance from X. Known values further from X than the range will all be given approximately the same weight, and have about the same influence on the unknown value.

Here, points A and B are near X and so have the greatest influence on the estimated value of point X. Points C and D, however, are outside the range, which puts them on the flat part of the spheroidal interpolant curve; they have roughly the same influence on the value of X, and both have significantly less influence than A or B:
**Spheroidal Interpolant Parameters**

To edit the parameters for an interpolant, double-click on the interpolant in the project tree and click on the *Interpolant* tab. The graph on the tab shows how the interpolant function values vary with distance and is updated as you change interpolant parameters:

![Interpolant Parameters Graph](image)

The yellow line indicates the **Base Range**. For this interpolant, the value of the interpolant is offset by the value of **Nugget**.

**Sill**

The **Sill** defines the upper limit of the spheroidal interpolant function, where there ceases to be any correlation between values. A spherical variogram reaches the sill at the range and stays there for increasing distances beyond the range. A spheroidal interpolant approaches the sill near the range, and approaches it asymptotically for increasing distances beyond the range. The distinction is insignificant.

**Nugget**

The **Nugget** represents a local anomaly in sampled values, one that is substantially different from what would be predicted at that point, based on the surrounding data. Increasing the value of **Nugget** effectively places more emphasis on the average values of surrounding samples and less on the actual data point, and can be used to reduce noise caused by inaccurately measured samples.
Nugget to Sill Ratio

It is the **Nugget to Sill** ratio that determines the shape of the interpolant function. Multiplying both these parameters by the same constant will result in an identical interpolant. Here, the interpolant on the left has a nugget of 3 and a sill of 10; the one on the right has a nugget of 9 and a sill of 30. Note that because the nugget and sill have been increased by the same factor, the function has the same shape.

Base Range

The **Base Range** is the distance at which the interpolant value is 96% of the **Sill**, with no **Nugget**. The **Base Range** should be set to a distance that is not significantly less or greater than the distance between drillholes, so it can reach between them. As a rule of thumb, it may be set to approximately twice the average distance between drillholes.
Here the effect of different range settings on the value of $X$ is demonstrated using our trivial example of four drillholes:

When the range is set to 1, it is too small to describe any real effect between drillholes. When the range is set to 30, distant drillholes have more influence, reducing the spatial continuity. Also illustrated is the range set to approximately the average distance between drillholes (range = 4) and the range set to about twice the average distance between drillholes (range = 8). Of these, the range set to 8 might be the best choice.
Alpha

The **Alpha** constant determines how steeply the interpolant rises toward the Sill. A low **Alpha** value will produce an interpolant function that rises more steeply than a high **Alpha** value. A high **Alpha** value gives points at intermediate distances more weighting, compared to lower **Alpha** values. This figure charts an interpolant function for each alpha setting, using a nugget of 8, sill of 28, and range of 5000. A spherical variogram function is included for comparative purposes. The inset provides a detailed view near the intersection of the sill and range.

An alpha of 9 provides the curve that is closest in shape to a spherical variogram. In ideal situations, it would probably be the first choice; however, high alpha values require more computation and processing time, as more complex approximation calculations are required. A smaller value for alpha will result in shorter times to evaluate the interpolant.

The following demonstrates the difference between alpha = 3 and alpha = 9:

There is a measurable difference between the estimates at the point being examined, but for many purposes, using a lower alpha will result in satisfactory estimates and reduced processing time.
The effect of the alpha parameter on the spheroidal interpolant in Leapfrog Geo is different to the effect of the alpha parameter in Leapfrog Mining 2.x. If Alpha is set to 9 in Leapfrog Geo, the range corresponds to the range in Leapfrog Mining 2.x. To convert from Leapfrog Mining 2.x to Leapfrog Geo where the alpha is not 9, apply the following scale factors to the Leapfrog Mining 2.x range value to find the corresponding range in Leapfrog Geo:

<table>
<thead>
<tr>
<th>Alpha</th>
<th>Scale factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>1.39</td>
</tr>
<tr>
<td>5</td>
<td>1.11</td>
</tr>
<tr>
<td>7</td>
<td>1.03</td>
</tr>
</tbody>
</table>

For example, if in a Leapfrog Mining 2.x project, the alpha is 5 for a range of 100, the corresponding range in Leapfrog Geo will be 111.

**Drift**

The Drift is a model of the value distribution away from data. It determines the behaviour a long way from sampled data.

- When set to Constant, the interpolant will go to the approximated declustered mean of the data.
- When set to Linear, the interpolant will behave linearly away from data. This may result in negative values.
- When set to None, the interpolant will pull down to zero away from data.
Here, the three Drift options for the interpolant are shown evaluated on grids:

In this example, the boundary is larger than the extent of the data to illustrate the effect of different Drift settings. The data extents are indicated by the pink box.

Away from the data, the value of the interpolant when Drift is Constant and Linear is not reasonable in this case, given the distance from the data. The low value when Drift is None is more realistic, given the distance from the data.

If when using the spheroidal interpolant you get a grade shell that fills the model extents, it is likely that the mean value of the data is higher than the threshold chosen for the grade shell in question. If this occurs, try setting the Drift to None.
**Accuracy**

Leapfrog Geo estimates the **Accuracy** from the data values by taking a fraction of the smallest difference between measured data values. Although there is the temptation to set the **Accuracy** as low as possible, there is little point to specifying an **Accuracy** significantly smaller than the errors in the measured data. For example, if values are specified to two decimal places, setting the **Accuracy** to 0.001 is more than adequate. Smaller values will cause the interpolation to run more slowly and will degrade the interpolation result. For example, when recording to two decimals, the range 0.035 to 0.044 will be recorded as 0.04. There is little point in setting the accuracy to plus or minus 0.000001 when intrinsically values are only accurate to plus or minus 0.005.

**The Linear Interpolant Function**

Generally, estimates produced using the linear interpolant will strongly reflect values at nearby points and the linear interpolant is a useful general-purpose interpolant for sparsely and/or irregularly sampled data. It works well for lithology data, but is not appropriate for values with a distinct finite range of influence.

The linear interpolant function is multi-scale, and, therefore, is a good general purpose model. It works well for lithology data, which often has localised pockets of high-resolution data. It can be used to quickly visualise data trends and whether or not compositing or transforming values will be required. It is not appropriate for values with a distinct finite range of influence as it aggressively extrapolates out from the data. Most ore grade data is not well interpolated using a linear interpolant function.

The linear interpolant function simply assumes that known values closer to the point you wish to estimate have a proportionally greater influence than points that are further away:
In the above diagram, points A and B will have the most effect on point X as they are closer to X than points C and D. Using the linear interpolant function in Leapfrog Geo gives a value of 7.85, which is between the nearby high grade values of A (10) and B (7). Because of their distance from X, the low grade values at C and D have a much weaker effect on the estimate of point X, and they have not dragged the estimate for X lower.

Linear Interpolant Parameters

To edit the parameters for an interpolant, double-click on the interpolant in the project tree and click on the Interpolant tab. The graph on the tab shows how the interpolant function values vary with distance and is updated as you change interpolant parameters:

The yellow line indicates the **Base Range**. For this interpolant, the value of the interpolant is offset by the value of **Nugget**.
Sill and Base Range

A linear interpolant has no sill or range in the traditional sense. Instead, the Sill and Base Range set the slope of the interpolant. The Base Range is the distance at which the interpolant value is the Sill. The two parameters sill and range are used instead of a single gradient parameter to permit switching between linear and spheroidal interpolant functions without also manipulating these settings.

Nugget

The Nugget represents a local anomaly in values, one that is substantially different from what would be predicted at that point based on the surrounding data. Increasing the value of Nugget effectively places more emphasis on the average values of surrounding samples and less on the actual data point, and can be used to reduce noise caused by inaccurately measured samples.

Drift

The Drift is a model of the value distribution away from data. It determines the behaviour a long way from sampled data.

- When set to Constant, the interpolant will go to the approximated declustered mean of the data.
- When set to Linear, the interpolant will behave linearly away from data. This may result in negative values.
Here, the two **Drift** options for the interpolant are shown evaluated on grids:

In this example, the boundary is larger than the extent of the data to illustrate the effect of different **Drift** settings. The data extents are indicated by the pink box.

**Accuracy**

Leapfrog Geo estimates the **Accuracy** from the data values by taking a fraction of the smallest difference between measured data values. Although there is the temptation to set the **Accuracy** as low as possible, there is little point to specifying an **Accuracy** significantly smaller than the errors in the measured data. For example, if values are specified to two decimal places, setting the **Accuracy** to 0.001 is more than adequate. Smaller values will cause the interpolation to run more slowly and will degrade the interpolation result. For example, when recording to two decimals, the range 0.035 to 0.044 will be recorded as 0.04. There is little point in asking Leapfrog Geo to match a value to plus or minus 0.000001 when intrinsically that value is only accurate to plus or minus 0.005.
Creating a Numeric Interpolant

If the data is both regularly and adequately sampled, different interpolants will produce similar results. In practice, however, it is rarely the case that data is so abundant and input is required to ensure an interpolant produces geologically reasonable results. For this reason, only a basic set of parameters are required when a numeric interpolant is first created. Once the model has been created, you can refine the model to factor in real-world observations and account for limitations in the data.

To create a numeric interpolant, right-click on the Interpolants folder and select New Interpolant. The New Interpolant window will be displayed:

![New Interpolant Window](image)

This window is divided into four parts that determine the values used to create the interpolant, the interpolant boundary, any compositing options and general interpolant properties. Each of these options is described below.

If you are unsure of some settings, most can be changed later. However, the Numeric values object selected when the interpolant is created cannot be changed.

Selecting the Values Used

In the Values To Interpolate part of the New Interpolant window, you can select the values that will be used and choose whether or not to filter the data and use a subset of those values in the interpolant.

Selecting the Numeric Values

You can build an interpolant from either:

- Numeric data contained in imported drillhole data.
- Points data imported into the Points folder.

All suitable data in the project is available from the Numeric values dropdown list.
Applying a Query Filter

If you have defined a query filter and wish to use it to create the interpolant, select the filter from the Query filter list. Once the model has been created, you can remove the filter or select a different filter.

Applying a Surface Filter

All available data can be used to generate the interpolant or the data can be filtered so that only the data that is within the interpolant boundary or another boundary in the project influences the model. The Surface Filter option is enabled by default, but if you wish to use all data in the project, untick the box for Surface Filter. Otherwise, you can select the Interpolant Boundary or another boundary in the project. You can use both the Query Filter option and the Surface Filter option together.

Setting the Interpolant Boundary

There are several ways to set the Interpolant Boundary:

- Enter values to set a Custom boundary.
- Use the controls in the scene to set the Custom boundary dimensions.
- Select another object in the project from the Enclose Object list. The extents for that object will be used as the basis for the Custom boundary dimensions.
- Select another object in the project to use as the Interpolant Boundary. Click the Existing model boundary or volume option and select the required object from the dropdown list.

Once the interpolant has been created, you can further modify its boundary. See Adjusting the Interpolant Boundary.

Setting Compositing Options

When numeric values from drillhole data are used to create the interpolant, you can composite the data to simplify the geology for the purposes of interpolating the data. If you do not have specific Compositing values in mind, you may wish to leave this option blank as it can be changed once the model has been created. See Setting Compositing Parameters for an Interpolant for more information.

If the numeric values selected have already been composited, the Compositing settings will not be available for the interpolant.

Setting General Interpolant Properties

The Surface resolution can be changed once the interpolant has been created, so setting a value in the New Interpolant window is not vital. A lower value will produce more detail, but calculations will take longer.

The Volumes enclose option determines whether the interpolant volumes enclose Higher Values, Lower Values or Intervals. Again, this option can be changed once the interpolant has been created.

Enter a Name for the new model and click OK.

The Numeric Interpolant in the Project Tree

The new interpolant will be created and added to the Interpolants folder. The new interpolant will contain five other objects representing different parts of the interpolant, which can be expanded to show the inputs to each
part of the interpolant:

- The Boundary object that defines the limits of the interpolant. See Adjusting the Interpolant Boundary for more information.

- The Trend object that describes the trend applied in the interpolant. See Changing the Trend for an Interpolant for more information.

- A points data values object that contains all the data used in generating the interpolant. See Adjusting the Values Used for more information.

- An Isosurfaces folder that contains all the meshes generated in building the interpolant.

- An Output Volumes folder that contains all the volumes generated in building the interpolant.

Other objects may appear in the project tree under the interpolant as you make changes to it.

You can display the interpolant by dragging it into the scene or by right-clicking on the interpolant and selecting View Output Volumes or View Isosurfaces.

Once you have created an interpolant, you can adjust its properties by double-clicking on it. You can also double-click on the individual objects that make up the interpolant. See Refining an Interpolant for more information.

See also:

- Copying an Interpolant
- Creating a Static Copy of an Interpolant
- Exporting Interpolant Volumes and Surfaces
Viewing Numeric Interpolant Statistics

You can view the approximated mean for each output volume by right-clicking on the interpolant and selecting Properties. Click on the Statistics tab:

You can copy the information displayed in the Statistics tab to the clipboard for use in other applications.

Creating an Indicator Interpolant

An indicator interpolant is a useful way of creating a region of interest in which further processing can be carried out. For example, you can use an indicator interpolant to define a volume that encloses the values that are likely to be above a cut-off threshold and then carry out further interpolation inside that volume.

To create an indicator interpolant, right-click on the Interpolants folder and select New Indicator Interpolant. The New Indicator Interpolant window will be displayed:
This window is divided into four parts, which determine the values used to create the interpolant, the interpolant boundary, any compositing options and general interpolant properties. Each of these options is described below.

If you are unsure of some settings, most can be changed later. However, the **Numeric values** object selected when the interpolant is created cannot be changed.

**Selecting the Values Used**

In the **Values To Interpolate** part of the **New Indicator Interpolant** window, you can select the values that will be used and choose whether or not to filter the data and use a subset of those values in the interpolant.

**Selecting the Numeric Values**

You can build an interpolant from either:

- Numeric data contained in imported drillhole data.
- Points data imported into the **Points** folder.

All suitable data in the project is available from the **Numeric values** dropdown list.

**Setting the Cut-off**

The **Cut-off** value will be used to create two output volumes:

- An **Inside** volume that encloses all values likely to be above or equal to the **Cut-off** value.
- An **Outside** volume that enclose all values likely to be below the **Cut-off** value.

If you are unsure of what **Cut-off** value to use, you can view statistics on the distribution of the data and change the **Cut-off** value once the interpolant has been created.

You can change the names of the **Inside** and **Outside** volumes once the interpolant has been created.

**Applying a Query Filter**

If you have defined a query filter and wish to use it to create the interpolant, select the filter from the **Query filter** list. Once the model has been created, you can remove the filter or select a different filter.

**Applying a Surface Filter**

All available data can be used to generate the interpolant or the data can be filtered so that only the data that is within the interpolant boundary or another boundary in the project influences the interpolant. The **Surface Filter** option is enabled by default, but if you wish to use all data in the project, untick the box for **Surface Filter**. Otherwise, you can select the **Interpolant Boundary** or another boundary in the project.

You can use both the **Query Filter** option and the **Surface Filter** option together.
Setting the Interpolant Boundary

There are several ways to set the Interpolant Boundary:

- Enter values to set a Custom boundary.
- Use the controls in the scene to set the Custom boundary dimensions.
- Select another object in the project from the Enclose Object list. The extents for that object will be used as the basis for the Custom boundary dimensions.
- Select another object in the project to use as the Interpolant Boundary. Click the Existing model boundary or volume option and select the required object from the dropdown list.

Once the interpolant has been created, you can further modify its boundary. See Adjusting the Interpolant Boundary.

Setting Compositing Options

When numeric values from drillhole data are used to create the interpolant, you can composite the data to simplify the geology for the purposes of interpolating the data. If you do not have specific Compositing values in mind, you may wish to leave this option blank as it can be changed once the model has been created. See Setting Compositing Parameters for an Interpolant for more information.

If the numeric values selected have already been composited, the Compositing settings will not be available for the interpolant.

Setting General Interpolant Properties

The Surface resolution can be changed once the interpolant has been created, so setting a value in the New Interpolant window is not vital. A lower value will produce more detail, but calculations will take longer.

An indicator interpolant produces a single isosurface that is used to determine the likelihood of values falling inside or outside of the cut-off threshold. The Iso value can be set to values from 0.1 to 0.9. Clicking the arrows changes the Iso value in steps of 0.1. To use a different value, enter it from the keyboard. Again, this option can be changed once the interpolant has been created.

Enter a Name for the new model and click OK.

The Indicator Interpolant in the Project Tree

The new interpolant will be created and added to the Interpolants folder. The new interpolant will contain five other objects representing different parts of the interpolant, which can be expanded to show the inputs to each part of the interpolant:

© 2014 ARANZ Geo Limited
• The **Boundary** object that defines the limits of the interpolant. See [Adjusting the Interpolant Boundary](#) for more information.

• The **Trend** object that describes the trend applied in the interpolant. See [Changing the Trend for an Interpolant](#) for more information.

• A points data values object that contains all the data used in generating the interpolant. See [Adjusting the Values Used](#) for more information.

• An isosurface set to the specified **Iso value**.

• An **Indicator Volume** legend that defines the colours used to display the volumes.

• An **Output Volumes** folder that contains the **Inside** and **Outside** volumes.

Other objects may appear in the project tree under the interpolant as you make changes to it. You can display the interpolant by dragging it into the scene or by right-clicking on the interpolant and selecting **View Output Volumes** or **View Isosurfaces**. You can also display the values (uestos) used to create the interpolant, which is useful in making decisions about the **Cut-off** value and the **Iso value**:
You can view the statistics for the indicator interpolant by right-clicking on the interpolant and selecting Statistics. Use the information available to adjust the cut-off value and other interpolant properties:

![Statistics Tab](image)

You can copy the information displayed in the Statistics tab to the clipboard for use in other applications. Once you have created an interpolant, you can adjust its properties by double-clicking on it. You can also double-click on the individual objects that make up the interpolant. See Refining an Interpolant for more information.

See also:

- Copying an Interpolant
- Creating a Static Copy of an Interpolant
- Exporting Interpolant Volumes and Surfaces

**Importing a Variogram Model**

Leapfrog Geo can import spheroidal variogram models exported from Snowden Supervisor. The settings that can be imported are:

- The anisotropy settings in the Trend tab
- The Nugget, Sill, Base Range and Alpha settings in the Interpolant tab

To import a variogram model, first create an interpolant. Next, right-click on the interpolant and select Import Variogram Parameters. In the window that appears, navigate to the folder that contains the XML file and select it. Click Open. The interpolant will be updated with the parameters in the XML file.

The imported variogram model overwrites the parameters in the interpolant, which cannot be undone. If you wish to save the original settings, make a copy of the interpolant before importing the new parameters.

Once the interpolant has been updated, you can edit it further as described in Refining an Interpolant.
Refining an Interpolant

To edit an interpolant, you can either double-click on the interpolant in the Interpolants folder or right-click and select Open. The window that appears is divided into tabs that let you change the different objects that make up the interpolant. Many of the options are the same for numeric and indicator interpolants.

When creating an interpolant, only a basic set of parameters is used. The Edit Interpolant and Edit Indicator Interpolant windows provide finer controls over these basic parameters so you can refine the interpolant to factor in real-world observations and account for limitations in the data. See:

- Adjusting the Values Used
- Setting Compositing Parameters for an Interpolant
- Adjusting the Interpolant Boundary
- Clipping and Transforming Values for a Numeric Interpolant
- Setting the Cut-off for an Indicator Interpolant
- Changing the Trend for an Interpolant
- Adjusting Interpolation Parameters
- Changing the Isosurface Parameters for a Numeric Interpolant
- Changing Surfacing and Volume Options for an Indicator Interpolant

Adjusting the Values Used

There are two ways to view the values used in an interpolant:

- Double-click on the interpolant in the project tree. The Edit Interpolant window will appear with the Values tab open.
- Double-click on the Values object for the interpolant in the project tree.

Although you cannot change the values used to create an interpolant, you can filter the values using the Query Filter and Surface Filter options.

To apply a query filter, tick the Query Filter box and select the available queries from the list.

To change the object used as the Surface filter, select the required object from the list. Note that the list contains an object that defines the interpolant’s own boundary, which can be adjusted in the Boundary tab.

Using Contour Lines to Adjust Values Used

You can also adjust the values using contour lines. To do this, expand the interpolant in the project tree. Right-click on the values object and select New Contour Polyline:
In the window that appears, choose whether you will draw a new polyline or use one already in the project:

Only GIS lines, polylines imported into Leapfrog Geo or polylines created using the straight line drawing tool can be used to create contour lines.

Enter the value to be used for the contour and a name for it. Click OK. If you have chosen the New Drawing option, the new object will be created in the project tree and drawing tools will appear in the scene. Start drawing in the scene as described in Drawing in 3D. When you have finished drawing, click the Save button ( ). The new contour will automatically be added to the model and will appear in the project tree as part of the interpolant’s values object.

When you double-click on the interpolant, the contour polylines used in the interpolant are listed in the Values tab, under User contour values:

If you wish to remove a contour polyline from the interpolant, do so from the project tree. Right-click on the polyline under the values object and select Remove.
Setting Compositing Parameters for an Interpolant

An alternative to compositing numeric values in drillhole data is to composite the values used to generate an interpolant. To do this, first create an interpolant from uncomposited data. There are two ways to change an interpolant’s compositing settings:

- Double-click on the interpolant in the project tree and select the Compositing tab.
- Double-click on either the Composited Values or Uncomposited Values object in the project tree. This object is part of the interpolant’s Values object.

The Edit Compositing Values window will appear:

![Edit Compositing Values window]

See for more information on the effects of these settings.

Omitted segments are drillhole segments for which no replacement action have been assigned in the Invalid Value Handling window. Omitted segments are excluded from numeric compositing so that composite values will not be diluted. See for more information.

Adjusting the Interpolant Boundary

There are two ways to view the settings for an interpolant’s boundary:

- Double-click on the interpolant in the project tree and then click on the Boundary tab.
- Double-click on the Boundary object for the interpolant in the project tree.

![Edit Interpolant Boundary window]

Controls to adjust the boundary will also appear in the scene.
Tick the **Use Topography** box to use the topography as a boundary. The topography is normally not used as a boundary for interpolants and so this option is disabled when an interpolant is first created.

The **Boundaries** list shows objects that have been used to modify the boundary. You can disable any of these lateral extents by unticking the box.

Lateral extents can be used to restrict modelling to a particular area of interest; for example, modelling can be restricted to a known distance from drillholes by applying a distance function as a lateral extent.

Extents do not need to be strictly vertical surfaces. For example, an interpolant could use a geological model volume as a lateral extent, which is the case here, where interpolation has been restricted to a volume of interest from a geological model:

In the project tree, we can see that the QzP volume from a geological model has been used as a lateral extent:

Techniques for creating lateral extents for interpolants are similar to those for creating lateral extents for geological models. See [Modifying the Model Boundary](#) for more information.
Using a Model Volume

As described above, a volume from an existing model can be used as a lateral extent. To do this, right-click on the interpolant’s Boundary object and select New Lateral Extent > From Model Volume. The Select Boundary window will appear, showing all the volumes that can be used as a lateral extent:

Select the required volume and click OK. The volume will be added to the interpolant’s Boundary object.

If you are using a volume from a faulted geological model as a lateral extent, ensure that the Merge output lithology volumes setting is enabled for the source geological model. This ensures that the volume being used as an extent has no self-intersections. See Refining a Geological Model for more information on this setting.

Clipping and Transforming Values for a Numeric Interpolant

To clip data and apply a transformation to a numeric interpolant, double-click on the interpolant in the project tree, then click on the Value Transform tab:

The options for Transform Type are None and Log. The logarithmic transform uses the logarithm to compress the data values to a smaller range. This may be useful if the data range spans orders of magnitude. In order to avoid issues with taking the logarithm of zero or negative numbers, a constant is added to the data to make the minimum value positive, which is set in the Pre-log shift field. Before the logarithm is taken, a constant is
added so the minimum (after clipping) value is transformed to 0.0. Flexibility in choosing the pre-log shift is provided since increasing this value away from zero can be used to reduce the effect of the logarithmic transformation on the resultant isosurfaces.

**Bin count** defines the number of bins, where a larger bin count results in a finer histogram. If you tick the **Do pre-transform clipping** option, you can set the **Lower bound** and the **Upper bound** to cut off values that are too low or too high. For example, if you set the **Upper bound** from 14.00 to 10.00, grade values above 10.00 will be regarded as 10.00.

## Setting the Cut-off for an Indicator Interpolant

To change the **Cut-off** value for an indicator interpolant, double-click on the interpolant in the project tree, then click on the **Cut-off** tab. The tab also shows the distribution of the data used to create an indicator interpolate:

![Image of Edit Indicator Interpolant window]

**Bin count** defines the number of bins, where a larger bin count results in a finer histogram. Adjust the **Cut-off** value, if required, and click **OK** to process the changes.

## Changing the Trend for an Interpolant

The easiest way to change the trend applied to an interpolant is using a global trend set from the moving plane. To do this, add the interpolant to the scene, then expand the interpolant in the project tree and double-click on the **Trend** object. The **Edit Trend** window will appear.

You can also view the trend for an interpolant by double-clicking on it in the project tree, then clicking on the **Trend** tab.
Click **View Plane** to add the moving plane to the scene, then click on the plane to view its controls. You may need to hide part of the interpolant to click on the moving plane:

You can also use the **Set to** list to choose different options Leapfrog Geo has generated based on the data used to build the model. **Isotropic** is the default option used when the model is created.

The **Ellipsoid Ratios** determine the relative shape and strength of the ellipsoids in the scene, where:

- The **Maximum** value is the relative strength in the direction of the green line on the moving plane.
- The **Intermed.** value is the relative strength in the direction perpendicular to the green line on the moving plane.
- The **Minimum** value is the relative strength in the direction orthogonal to the plane.

Click **OK** to regenerate the model and view changes.

**Using a Structural Trend**

You can also set the trend in an interpolant from a structural trend. First, you must create or import the required mesh and create a structural trend. See [Creating and Applying Structural Trends](#) for more information.
Once the structural trend has been created, add it to the interpolant by double-clicking on the interpolant in the project tree, then clicking on the Trend tab. Select the Structural Trend option, then select the required trend from the list:

Click OK. The trend will be added to the model and will appear as part of the model, as shown:

When you apply a structural trend, you cannot use the Linear interpolant. See Interpolant Functions for more information.

Once a structural trend has been defined for the model, you can edit it by clicking on the trend hyperlink in the project tree, then opening the structural trend applied to the interpolant. The Structural Trend window will appear. See Creating and Applying Structural Trends for information on the settings in this screen.

The structural trend information included as part of the interpolant is a link to the original structural trend. When you change the structural trend that is part of the interpolant, the changes are also made for the original structural trend.

When a structural trend that is Strongest along meshes or Blending is used, the model will regress to the global mean trend away from the meshes. The global trend that will be used is set in the Global Trend tab for the structural trend.
Adjusting Interpolation Parameters

In Leapfrog Geo, interpolation parameters can be adjusted by double-clicking on the interpolant in the project tree, then clicking on the Interpolant tab:

Two models are available, the spheroidal interpolant and the linear interpolant. See The Spheroidal Interpolant Function and The Linear Interpolant Function for more information on the settings in this tab.

Changing the Isosurface Parameters for a Numeric Interpolant

You can change the parameters used to generate the isosurfaces of an interpolant by double-clicking on the interpolant, then clicking on the Isosurfaces and Volumes tab.

To add a new isosurface, click the Add button and enter the required value. To delete an isosurface, click on it in the list, then click the Remove button. You can also change the colours used to display the isosurfaces by clicking on the colour chips.
If you find that grade shells are overlapping, the resolution may be too coarse. Set Default resolution to a lower value in the Isosurfaces and Volumes tab. See .

Click OK to regenerate the interpolant and view changes.

Changing Surfacing and Volume Options for an Indicator Interpolant

To change the properties of the isosurface for an indicator interpolant, double-click on the interpolant in the project tree, then click on the Volumes tab:

An alternative to double-clicking on the interpolant is to double-click on one of the output volumes, which opens the Edit Indicator Interpolant window with theVolumes tab displayed.

The Iso value can be set to values from 0.1 to 0.9. Clicking the arrows changes the Iso value in steps of 0.1. To use a different value, enter it from the keyboard.

Setting a lower value for Resolution will produce more detail, but calculations can take longer. See Surface Resolution in Leapfrog Geo.

Use Volume filtering to discard smaller parts of the volumes in which you do not wish to carry out further processing.

Creating and Editing a Distance Function

A distance function calculates the distance to a set of points.
To create a distance function, right-click on the Interpolants folder and select New Distance Function. The New Distance Function window will be displayed:

![New Distance Function window](image)

This window is divided into four tabs. If you are unsure of some settings, most can be changed later. For a basic distance function click Select Objects to select from the suitable objects available in the project, then click on the Buffers tab to define at least one buffer so that the distance function can be visualised in the scene.

**Setting the Boundary**

In the Boundary tab, you can set whether the function boundary is clipped or unclipped. No distance buffer clipping is the default setting, but if you choose to clip the buffers, you can choose between:

- Sharing another object’s extents
- Defining a set of extents that is independent of other objects in the project.

When you select the Shared with option, the distance function will be updated when the extents object it shares is updated.

**Setting a Trend**

In the Trend tab, you can set a trend using the moving plane or by entering the required values. You can also use the Set to list to choose different options used in the project. Isotropic is the default option used when the function is created.

The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene, where:

- The Maximum value is the relative strength in the direction of the green line on the moving plane.
- The Intermed. value is the relative strength in the direction perpendicular to the green line on the moving plane.
- The Minimum value is the relative strength in the direction orthogonal to the plane.
Adding Buffers

To add buffers, click on the Buffers tab, then click the Add button:

Enter the required value. To delete a buffer, click on it in the list, then click the Remove button. You can also change the colours used to display the buffers by clicking on the colour chips.

There are two options for Buffer Type that affect how the buffers are calculated when more than one buffer is used. Selecting Concentric produces higher distance buffers that include the lower distance buffers, whereas selecting Intervals produces discrete, non-intersecting buffers.

The Default resolution setting is used for all new buffers and for existing buffers that use the default resolution.

The New Distance Function in the Project Tree

Click OK to create the distance function, which will be added to the Interpolants folder. The new distance function contains objects representing different parts of the function, which can be expanded to show the inputs to each part of the function:

- The Trend object that describes the trend applied.
- Hyperlinks to objects used for the distance function.
- An Isosurfaces folder that contains all the meshes generated in building the distance function.
- A Buffers folder that contains all the distance buffer meshes.

Other objects may appear in the project tree under the function as you make changes to it. Display the function by dragging it into the scene or by right-clicking on it and selecting View Buffers.

Once you have created a distance function, you can adjust its properties by double-clicking on it. You can also double-click on the individual objects that make up the function.
Copying an Interpolant

Creating a copy of an interpolant is a useful way of experimenting with changes to a model. To copy an interpolant, right-click on it in the project tree and select **Copy**. Enter a name for the copy of the interpolant and click **OK**. The copy will be added to the project tree.

Creating a Static Copy of an Interpolant

Creating a static copy preserves a snapshot of an interpolant that does not change, even when changes are made to the data on which the original model was dependent. This is a useful way of storing historical models and comparing models. Static copies can be exported from Leapfrog Geo, as described in *Exporting Interpolant Volumes and Surfaces*.

To create a static copy of an interpolant, right-click on it in the project tree and select **Static Copy**. Enter a name for the copy of the model and click **OK**. The copy will be added to the **Interpolants** folder. In the project tree, the static copy is made up of the interpolant volumes and a **Legend** object:

When displayed in the scene, the copy will appear as a single line in the shape list. To control the colours used to display the different volumes, double-click on the **Legend** object in the project tree or click on the **Edit Colours** button in the shape list:

To view the date the static copy was created, right-click on it in the project tree and select **Properties**. The date the copy was created is in the **General** tab.

Exporting Interpolant Volumes and Surfaces

There are three options for exporting an interpolant's output volumes and surfaces. These are:

- Export an output volume or a surface as a mesh. Right-click on it in the project tree and click **Export**. You will be prompted for a file name and location. See *Exporting a Single Mesh*.

- Export an output volume as a thickness grid. Right-click on it in the project tree and click **Export Thickness Grid**. See *Exporting a Thickness Grid*.
- Export multiple output volumes and surfaces. Right-click on the interpolant in the project tree and select Export. See Exporting Multiple Meshes from Models and Interpolants.
Combining Models

A combined model uses information from up to four geological models, interpolants and distance functions in order to visualise relationships between different types of data in the project. For example, you could combine a geological model with an interpolant to see what lithologies higher grades are occurring in.

To create a combined model, right-click on the **Combined Models** folder in the project tree and select **New Combined Model**. In the window that appears, select the models you wish to combine, then click **OK**:

Once you have created a combined model, you cannot edit it to add new models or remove existing ones.

The next step is to select the output volumes to use in the combined model and arrange them in order of priority. For this combined model, the QzP volume from the selected geological model will be subdivided using information from the Au interpolant:

If you are using a distance buffer with concentric buffers, you will be able to select only one volume. Click **OK** to generate the model, which will appear in the project tree in the **Combined Models** folder.

© 2014 ARANZ Geo Limited
Add the model to the scene to view the results:

In the project tree, the combined model includes hyperlinks to the models used to create the combined model:

Changes made in the original models will be reflected in the combined model. To change how the volumes from the source models are combined, double-click on the combined model in the project tree. Once you have created a combined model, you cannot add new models to it, nor can you remove a selected model.

See also:

- Creating a Static Copy of a Combined Model
- Exporting a Combined Model

Creating a Static Copy of a Combined Model

Creating a static copy preserves a snapshot of a combined model that does not change, even when changes are made to the data on which the original model was dependent. This is a useful way of storing historical models and comparing models. Static copies can be exported from Leapfrog Geo, as described in Exporting a Combined Model.

To create a static copy of a combined model, right-click on it in the project tree and select Static Copy. Enter a name for the copy of the model and click OK. The copy will be added to the Combined Models folder.
In the project tree, the static copy is made up of the model volumes and a Legend object:

When displayed in the scene, the copy will appear as a single line in the shape list. To control the colours used to display the different volumes, double-click on the Legend object in the project tree or click on the Edit Colours button in the shape list:

To view the date the static copy was created, right-click on it in the project tree and select Properties. The date the copy was created is in the General tab.

**Exporting a Combined Model**

There are two options for exporting a combined model's output volumes. These are:

- Export an output volume as a mesh. Right-click on it in the project tree and click Export. You will be prompted for a file name and location. See Exporting a Single Mesh.
- Export multiple output volumes. Right-click on the combined model in the project tree and select Export. See Exporting Multiple Meshes from Models and Interpolants.
Flow Modelling

Geological models created in Leapfrog Geo can be used as the basis for ModFlow and FEFLOW models. You can create flow models directly in Leapfrog Geo and assign hydrological/material properties based on the lithologies in the geological model. Flow models can be exported for use in other applications. You can also import existing flow models and use them as the basis for the construction of new models. Flow models can be displayed in the scene, and time-dependent data can also be visualised.

Working with ModFlow and FEFLOW models is available as part of the Hydrogeology module. Contact Customer Support as described in Getting Support for more information about licensing the Hydrogeology module.

If the Hydrogeology folder appears in the project tree as Restricted, you will be able to display models in the scene and change how they are displayed, but you will not be able to make changes to the models themselves.

All tools for building flow models are accessed by right-clicking on the Hydrogeology folder and the objects in it. Imported objects and objects created while building a flow model are also stored in the Hydrogeology folder, and more complex functions can be carried out by right-clicking on individual objects.
Working with ModFlow Models

These features are only available as part of the Hydrogeology module. See Flow Modelling for more information.

Once you have created a geological model, you can use it as the basis for a ModFlow model. You can also import existing ModFlow models and assign lithologies from a geological model.

Steps for creating a ModFlow model that can be exported and run outside Leapfrog Geo are:

1. Create a geological model.
2. Create the ModFlow model using the geological model to set the grid spacing and layers.
3. Evaluate the new model against a geological model, if it wasn’t when it was created.
4. Edit the hydrological properties.
5. Export the ModFlow model to ModFlow or Groundwater Vistas.

Once the model has been processed outside of Leapfrog Geo, the model can be imported into Leapfrog Geo and visualised in the scene.

Creating ModFlow models in Leapfrog Geo has the advantage that the resolution can be easily changed and the properties of the grid can be made to honour boundaries defined in geological models. See Creating a New ModFlow Model.

See Displaying ModFlow Models for information on options for displaying models in the scene.

Models created in Leapfrog Geo can be evaluated against a geological model when they are created. Models imported into Leapfrog Geo or that were not evaluated when they were created can be evaluated as described in Evaluating ModFlow Models.

Once a model has been defined and evaluated against a geological model, hydrological properties can be assigned and the grid can be exported. See Setting Hydrological Properties for a ModFlow Model and Exporting a ModFlow Model.

Creating a New ModFlow Model

This feature is only available as part of the Hydrogeology module. See Flow Modelling for more information.
To create a new ModFlow model, you must first have at least one geological model defined in the project. Once this has been defined, add the geological model to the scene. Right-click on the Hydrogeology folder and select **New ModFlow Model**. The **New ModFlow Model** window will be displayed, together with controls in the scene that will help you to set the grid extents:

The new ModFlow grid will be based on the geological model in the **Gridding from** setting. If you wish to use a geological model other than the one selected when the window is opened, select it from the dropdown list. The grid dimensions will be updated in the scene.

If the **Evaluate Gridded Model** box is ticked, the selected geological model will be evaluated on the new grid and set as the evaluation for export. If you do not wish to evaluate the geological model on the grid, untick the box. You will still be able to use the layers in the geological model to control the grid layers.

The **Preserve Existing Grid Lines** option is used when setting a non-uniform grid in the scene window. If you are going to define a non-uniform grid in this way, create the model with the **Default Cell Size** set to the smallest cell size you wish to use, then edit it as described in **Editing the ModFlow Model**.

The grid should be slightly smaller than the selected geological model. Any ModFlow cells that exist outside the geological model will be marked as inactive when the grid is exported to ModFlow.
Changing the Horizontal Grid Spacing

By default, the horizontal grid for the model is uniform, with the size of each cell set by the Default Cell Size value. You can change the horizontal grid by editing row and column spacings. When you click on Row Spacings or Column Spacings, the Edit Spacings window will be displayed:

Changes made in the Edit Spacings window will be reflected in the scene.

There are four ways to change the spacings:

- Click on a value to change it.
- Divide a row or column. Click on a row or column, then on the Divide Row or Divide Column button. Two new rows or columns will appear in the list.
- Merge rows or columns. Hold down the Shift key while clicking on each item, then click on the Merge Rows or Merge Columns button. The selected items will be combined.
- Set uniform spacing on selected rows or columns. You will be prompted to enter the number of cells you wish to create from the selected rows or columns.
Click **OK**.

For example, here, the rows and columns away from the model boundary have been divided to provide more detail. The different spacings are reflected in the scene:

![Vertical Grid Layering](image)

Use close spacing for steep gradients and increase or decrease spacing gradually.

**Setting the Vertical Grid Layering**

The vertical grid layers are based on the geological model selected in the **New ModFlow Model** window. Click on the **Layers** tab to view the layers:

![Layers Tab](image)
Initially, there are two layers equally spaced between the topography and the geological model. Change the layers by clicking on **Select Layer Guides** button. The Layer Guides window will appear, showing the layers available in the selected geological model:

If the grid is required to follow a geological model lithology contact surface, move the layer into the **Selected** list and it will be honoured in the gridding process.

Click **OK** to return to the **New ModFlow Model** window, in which the selected layers will be displayed:

Click **OK** to create the new ModFlow grid, which will appear in the Hydrogeology folder. You can edit the model by expanding it in the project tree and double-clicking on the grid object (**`). See [Editing the ModFlow Model](#).

For further information on working with the new model, see:
• **Displaying ModFlow Models**
• **Evaluating ModFlow Models**
• **Setting Hydrological Properties for a ModFlow Model**
• **Importing and Displaying Head Values and MT3D Concentrations**
• **Generating a Head Value Mesh**
• **Exporting a ModFlow Model**

### Editing the ModFlow Model

Once you have created a ModFlow model, you can edit it by expanding the model in the project tree and double-clicking on the grid object ( ). The **Edit ModFlow Grid** window will appear. You can edit the grid spacings as described in [Creating a New ModFlow Model](#), using the information in the scene window as a guide.

Another way to edit the grid is to use the controls in the scene to apply different cell size settings in different parts of the grid. For example, you may want to define a grid that has smaller cells in the centre than at the outer edges:

![Grid Example]

To set cell sizes in this way, it is best to start with a ModFlow model where the **Default Cell Size** is set to the smallest cell size you will use in the model.
For this example, we will start with a new grid with a **Default Cell Size** of 50. We will set the adjacent cell size to 100 and the cell size at the outer boundary to 200.

First, we need to reduce the area that uses the cell size of 50 by using the red handles in the scene:

![Image showing reduction of grid area](image)

The yellow box in the scene is the geological model extents for the model used to define the ModFlow model and represents the unedited boundary of the ModFlow model.

Next, enter the cell size to use for the area adjacent to the 50.0 cells in the **New Cell Size** field. Drag the red handles to enlarge the grid. The centre part of the grid is still set to 50, while the new area is set to 100:

![Image showing cell size adjustment](image)

If the **Preserve Existing Grid Lines** option is enabled, grid lines for cells already defined will not be moved to account for new cells.
Enter the next cell size in the **New Cell Size** field and use the handles to enlarge the grid again:

Click **OK** to update the grid.

For further information on working with the new model, see:

- [Displaying ModFlow Models](#)
- [Evaluating ModFlow Models](#)
- [Setting Hydrological Properties for a ModFlow Model](#)
- [Importing and Displaying Head Values and MT3D Concentrations](#)
- [Generating a Head Value Mesh](#)
- [Exporting a ModFlow Model](#)

**Importing a ModFlow Model**

This feature is only available as part of the Hydrogeology module. See [Flow Modelling](#) for more information.

Leapfrog Geo imports .nam files and .mfi and .mfn variations of .nam files.

To import a ModFlow model, right-click on the **Hydrogeology** folder and select **Import ModFlow Model**. Leapfrog Geo will ask you to specify the file location, and then will display the data in the file in the **Import ModFlow Model** window:

If the world origin is available, the **Grid Position** will be displayed but cannot be edited.

Click **OK** to import the grid. The new ModFlow model will appear in the project tree in the **Hydrogeology** folder. See [Displaying ModFlow Models](#) for information on displaying the model.
If the world origin was not available when the model was imported, you can change the Grid Position. To do this, expand the imported model in the project tree and double-click on its grid object ( ).

To associate lithologies with the grid, see Evaluating ModFlow Models.

### Evaluating ModFlow Models

When a ModFlow model is exported, the evaluated geological model is used to assign lithologies to the cells in the grid. If the grid has not been evaluated against a geological model, you must do so before you can edit the hydrological properties and before you can export the grid.

To evaluate a ModFlow model, expand the model in the project tree, then right-click on the grid object ( ) and select Evaluations. Although you can evaluate an interpolant or distance function, they cannot be exported with the grid and are simply used for displaying the grid in Leapfrog Geo.

A window will appear listing all objects in the project that can be used for an evaluation. Once you have selected one or more objects, click OK. You will then be able to select the evaluations from the view list, as described in Evaluating Objects.

### Assigning an Evaluation for Export

For ModFlow models created in Leapfrog Geo, the evaluation used when creating the model will automatically be assigned as the evaluation for export. A hydrological properties table ( ) will appear in the project tree as part of the model.

If the model was imported into Leapfrog Geo or created without being evaluated against a geological model, you will need to manually set the evaluation for export. To do this:

- Evaluate the grid against one or more geological models, as described above.
- Right-click on the model ( ) in the project tree and select Set Evaluation for Export. The Select Evaluation window will appear showing all geological models evaluated on the grid. Select the required evaluation and click OK.

A hydrological properties table will be added to the model in the project tree. Edit hydrological properties by double-clicking on the table. See Setting Hydrological Properties for a ModFlow Model.

### Using a Combined Evaluation

You can combine geological models and set the priority used for evaluation. This is useful when you have geological models available that describe different parts of the area of interest or if you have a refined geological model for part of the model. To combine geological models for evaluation, select the required models in the Select Models To Evaluate window, then click on the Combined Evaluation button.
In this example, there are three geological models selected:

The GM and GM from contacts models describe similar areas, but GM has more detail. The GM larger model describes a larger area but with less detail. Tick the models to combine them and set their priority. Click OK to create the combined evaluation, then click OK in the Select Models To Evaluate window. The combined evaluation will be available from the view list.

The scene below shows an evaluation of these three geological models on a ModFlow grid, where each model has been set to a single colour to show how the information from each model is combined:

The blue model has the highest priority and is used wherever there is information available. The green model has the lowest priority and is used when there is no information from higher priority models.

This scene shows how the grid changes when the priority of the models is changed:
In this case, the purple model is now higher priority than the blue model and is used in preference to the blue model. The green model remains the lowest priority model.

A combined evaluation can be selected as the evaluation for export.

To delete a combined evaluation, click on the **Delete Combined** button in the **Select Models To Evaluate** window.

### Setting Hydrological Properties for a ModFlow Model

This feature is only available as part of the Hydrogeology module. See [Flow Modelling](#) for more information.

When a ModFlow model is evaluated against a geological model, a hydrological properties table is added to the model in the project tree. You can edit hydrological properties by double-clicking on the table. You can also open the table by right-clicking on the model in the project tree and selecting **Edit Hydrological Properties**.

If the model has been imported into Leapfrog Geo and has not yet been evaluated against a geological model, you will be prompted to do so. Expand the model in the project tree, right-click on the grid object and select **Evaluate Geological Model**. See [Evaluating ModFlow Models](#) for more information.

In the **Edit Hydrological Properties** window, click in a cell to edit a property:

![Edit Hydrological Properties window](image)

When the model is exported, the zone numbers are used to indicate the assignment of lithologies to blocks and are written to the ModFlow zoned layer properties file (*._lpf). In the **Edit Hydrological Properties** window, you can change the zone number for a lithology by clicking in a cell and entering a different zone number. If you reorder the zones in this way, zone number conflicts will be highlighted in red:

![Edit Hydrological Properties window](image)

Zone numbers must be unique and you will not be able to close the window and save data if there are conflicts.

If you click on the **Sort Zone Numbers** button, the zone numbers will be ordered from top to bottom.

Zone numbers should not be sorted once a model has been exported as the new numbers will not be reflected in the exported model.
Hydrological properties are assigned to model blocks based on the position of the block’s centroid relative to the geological model used to evaluate the grid. The position of the centroid is calculated and Leapfrog Geo then determines which lithology the centroid falls inside. The K values for the assigned lithology are assigned to the entire block; there is no averaging.

If more than one object has been evaluated on the grid, you can set hydrological properties separately for each evaluation. Select the required evaluation from the Evaluation dropdown list:

However, the only hydrological properties information that will be exported is that set for the evaluation to be exported.

Click OK to update the grid.

**Displaying ModFlow Models**

In the project tree, ModFlow models are made up of a grid object ( ), a Simulation Outputs folder and a hydrological properties table ( ) object. If there is no hydrological properties table, an evaluation has not yet been set for export. See Evaluating ModFlow Models for more information.

For ModFlow models created in and imported into Leapfrog Geo, dragging the model itself into the scene will display the grid ( ) object. The different parts of the model can also be displayed.
Grid Display Options

Dragging a ModFlow model into the scene displays its grid object. Here, an imported model has been evaluated against a geological model and added to the scene:

The viewing options available are the flat colour option, the evaluated geological model and zone data imported with the model. Other inputs imported with a model will also be available from this list.

Grids can be displayed as points (●) or as cells.
When a geological model evaluation or lithological zone information is displayed, you can also display a legend for the grid.
When Show gaps (●) is enabled, the grid will be displayed with gaps visible between the cells.
The **Show inactive blocks** option displays inactive cells in grey:

To display a single layer, tick the **One layer** box in the shape properties panel, then select the layer to display. Head values and MT3D concentrations can also be imported and displayed. See [Importing and Displaying Head Values and MT3D Concentrations](#).
Viewing Block Information

When a ModFlow model is displayed in the scene, you can view information about the individual cells in the model by clicking on a block. The window that appears shows information about the selected block, including its centroid and the lithology assigned to the block from the evaluated geological model. Information from all geological models and interpolants the grid has been evaluated against will be displayed:

Importing and Displaying Head Values and MT3D Concentrations

Leapfrog Geo imports the following output file formats:

- Head values files in *.hds, *.hhd and *.hed formats
- MT3D concentrations files in *.ucn format

To import head values or MT3D concentration files for a ModFlow model, right-click on the Simulation Outputs folder and select the required option. Navigate to select the file, then click Open.

The information will be added to the ModFlow grid, and you can then select the head values and MT3D concentrations in the shape list when you display the grid in the scene. If the output is time-dependent, a timestep slider will be available from the shape properties panel. Click and drag the slider or click along the timeline to view the different timesteps available:
Imported head values and MT3D concentrations are stored in the project tree in the Simulation Outputs folder:

To delete head values or MT3D concentrations, right-click on the object in the project tree and select Delete. Once head values have been imported, you can generate a head value mesh. See Generating a Head Value Mesh.

Generating a Head Value Mesh

This feature is only available as part of the Hydrogeology module. See Flow Modelling for more information.

Once head values have been imported for a ModFlow model, you can generate a head value mesh. To do this, expand the Simulation Outputs folder. Right-click on the head values object and select Generate Head Value Mesh. The Generate Head Value Mesh window will appear, showing the layers in the model and the timesteps available. Select the layer of the model you wish to generate a head value mesh for, then choose the heads. Click OK to create the mesh, which will be saved to the Meshes folder.

Exporting a ModFlow Model

This feature is only available as part of the Hydrogeology module. See Flow Modelling for more information.

Leapfrog Geo has three options for exporting ModFlow grids:

- Export the grid as a ModFlow file.
- Export for Groundwater Vistas. Use this option the first time you export a grid for use in Groundwater Vistas.
- Export a Groundwater Vistas update. Use this option to generate a set of files that can be imported into Groundwater Vistas as an update.

The Groundwater Vistas options include a zoned layer properties flow (*.lpf) file that includes information about the zones in the grid.

Exporting a Grid as a ModFlow File

To export a grid as a ModFlow file for use in a package other than Groundwater Vistas, right-click on the grid in the project tree and select Export to ModFlow. You will be prompted to choose a File name and location. Select the options required, then click Save.

Exporting a Grid for Groundwater Vistas

To export a grid for use in Groundwater Vistas for the first time, right-click on the grid in the project tree and select Export to ModFlow for GWV. You will be prompted to choose a File name and location. Select the options required, then click Save.

If you have previously exported the grid to Groundwater Vistas and have made changes to the grid, use the Export to GWV Updates option.
Exporting a Grid as a Groundwater Vistas Update

If you have exported a grid to Groundwater Vistas but then make changes to the Leapfrog Geo model, you can export the changes to the model. The set of files containing the changes can then be imported to Groundwater Vistas.

To export a Groundwater Vistas update, right-click on the grid in the project tree and select Export GWV Updates. The Update Groundwater Vistas window will appear listing the files that will be exported. Enter a Base file name to differentiate the original files from the updates. Click Export. The files will be saved in the specified directory.
Working with FEFLOW Models

These features are only available as part of the Hydrogeology module. See Flow Modelling for more information.

In Leapfrog Geo, creating a 3D FEFLOW model requires:

- A geological model that will be used to assign lithologies to the FEFLOW model’s blocks.
- A 2D grid that defines the block size, boundaries and surface features.

Steps for creating a 3D FEFLOW model that can be exported and run outside Leapfrog Geo are:

1. Create a geological model.
2. Create and refine a 2D model in Leapfrog Geo or import a FEFLOW model.
3. Create the 3D model from the 2D model or another 3D model in the project.
4. Evaluate the new 3D model against a geological model.
5. Edit the material types.
6. Export the 3D FEFLOW model.

Once the model has been processed outside of Leapfrog Geo, a results file can be saved that can be imported into Leapfrog Geo and visualised in the scene.

A 2D grid can be created in or imported into Leapfrog Geo. A 3D grid can also be used, in which case the layer information is not used in creating the 3D grid. Creating the 2D grid in Leapfrog Geo provides the most flexibility, as the block sizes can easily be changed, the boundaries modified and features added to provide finer resolution where there is more data available.

For information about creating 2D and 3D grids, see Creating a 2D FEFLOW Model and Creating a 3D FEFLOW Model.

You can also import FEFLOW problem files and result files, visualise them in Leapfrog Geo and use them as the basis for new models. See Importing a FEFLOW Grid.

See Displaying FEFLOW Models for information on options for displaying FEFLOW models in the scene.

3D grids created in Leapfrog Geo can be evaluated against a geological model when they are created. Grids imported into Leapfrog Geo or that were not evaluated when they were created can be evaluated as described in Evaluating FEFLOW Models.

Once a model has been defined and evaluated against a geological model, material types can be assigned and the grid can be exported. See Setting Material Types for a FEFLOW Model and Exporting a FEFLOW Model.

Displaying FEFLOW Models

In the project tree, 3D FEFLOW models are made up of a grid object representing the finite elements, a nodes object and a material types table (object. If there is no material types table, an evaluation has not yet been set for export. See Evaluating FEFLOW Models for more information.

A 2D FEFLOW grid is made up of a grid object and a nodes object. Here, three types of FEFLOW models are shown expanded in the project tree:

- Feflow 3D Simulation is a 3D model created in Leapfrog Geo.
- Feflow 2D Simulation is a 2D model created in Leapfrog Geo.
- Feflow Results is an imported 3D model (DAC file).
From the information in the project tree, we can see that:

- The 3D simulation created in Leapfrog Geo uses the GM geological model to define the layers.
- The 2D simulation created in Leapfrog Geo uses the GM geological model as a boundary and has had collar points added as a feature.
- The imported results model includes a number of simulation outputs.

For each type of FEFLOW model, dragging the model itself into the scene will display the grid object. The different parts of the model can also be displayed.
Displaying a 3D Model

Dragging a 3D simulation into the scene displays its grid object, which represents the finite elements. Here, a 3D model created in Leapfrog Geo has been added to the scene:

There are only two viewing options available from the shape list, a flat colour and the geological model evaluation for the grid. For 3D models imported into Leapfrog Geo, you can display the model using other information available for the grid, such as conductivity data. This is available from the view list:

Grids for 3D models can be displayed as points or as blocks. You can also display a legend for the grid when a geological model evaluation is displayed.

To display a single layer, tick the One layer box in the shape properties panel, then select the layer to display.
You can display the nodes by adding the nodes (ıdır) object to the scene. When a model with results is displayed, the simulation outputs can be displayed when the nodes are viewed in the scene. Here, the nodes for an imported results file have been added to the scene. The heads are displayed for a single layer:

When the results are time-dependent, a timestep slider will be available from the shape properties panel. Click and drag the slider or click along the timeline to view the different timesteps available.

**Displaying a 2D Model**

As with 3D models, dragging a 2D model into the scene displays its grid object. Here, a 2D model created in Leapfrog Geo (ıdır) has been added to the scene and viewed from above:
Also in the scene is a collar points object that shows collar points that have been added to the grid as a feature. 2D grids can be viewed as points or as blocks. As with imported 3D grids, an imported 2D grid can also be displayed using other information available for the grid.

Other viewing options are available for 2D grids created in Leapfrog Geo. These are useful in refining a 2D grid and are described in Creating a 2D FEFLOW Model.

### Viewing Block Information

When a FEFLOW model is displayed in the scene, you can view information about the individual blocks in the model by clicking on a block. The window that appears shows information about the selected block, including its centroid and the lithology assigned to the block from the evaluated geological model:
Information from all geological models and interpolants the grid has been evaluated against will be displayed:

**Importing a FEFLOW Grid**

This feature is only available as part of the Hydrogeology module. See [Flow Modelling](#) for more information.

You can import 2D and 3D FEFLOW grids and use them as the basis for new models. Leapfrog Geo imports two types of FEFLOW files:

- FEFLOW problem files (*.fem) in ASCII format. Importing these files results in a new 2D or 3D model with a grid and nodes.
- FEFLOW results files (*.dac). Importing these files results in a new 3D model with a grid, nodes and simulation outputs.

To import a FEFLOW grid or results file, right-click on the Hydrogeology folder and select one of the **Import FEFLOW** options. Leapfrog Geo will ask you to specify the file location. Click **Open** to import the file.

The new FEFLOW grid will appear in the project tree under the Hydrogeology folder. To use the imported grid or results file as the basis for a new FEFLOW model, see [Creating a 3D FEFLOW Model](#).

To associate lithologies with a 3D grid, see [Setting Material Types for a FEFLOW Model](#).

See [Displaying FEFLOW Models](#) for information about displaying the FEFLOW grid in the scene window.

**Creating a 2D FEFLOW Model**

This feature is only available as part of the Hydrogeology module. See [Flow Modelling](#) for more information.

A 2D FEFLOW model defines the block size, boundaries and surface features for a 3D FEFLOW model. Although existing 2D grids can be imported into Leapfrog Geo and used for creating 3D models, creating the 2D grid in Leapfrog Geo provides the most flexibility, as the block sizes can easily be changed, the boundaries modified and features added to provide finer resolution where there is more data available.
It is not necessary to create a geological model before creating a 2D grid. However, you will not be able to create a 3D grid until a geological model has been created. Therefore, it is a good idea to create the geological model first, and its dimensions can be used in defining the boundary of the 2D grid.

To create a 2D grid, right-click on the Hydrogeology folder and select New 2D FEFLOW Model. The New 2D FEFLOW Grid window will appear:

All settings can be changed once the grid has been created. It is, therefore, reasonable to accept the default settings and create the grid, then add it to the scene and begin refining it. Click OK to create the initial grid.

In the project tree, a 2D FEFLOW grid is made up of a grid object and a nodes object, as described in Displaying FEFLOW Models. Here, a newly-created grid with a rectangular boundary appears in the project tree:

Expand the grid in the project tree and double-click on the grid object (●) to open the Edit 2D FEFLOW Grid window. The Features tab will be displayed. When a grid is first created, this window will be empty, but once features have been added, you can enable them in this tab.

Click on the Boundary tab to modify the boundary:

Click the Apply button to view the effect of changes made without closing this window.
Boundary Options

When setting the Boundary, you can set a rectangular boundary defined by the From rectangle settings. You can use the extents of any other object in the project by selecting from the Enclose Object list, but the grid boundary will always be a rectangle.

To define a non-rectangular boundary, use the From another object options and select from the list of objects available in the project. This is useful if, for example, you wish to define a grid using the boundary of a geological model.

The Simplify boundary option reduces the number of points along the boundary. Reducing the Tolerance value increases the number of points along the boundary. The two settings together let you define a basic boundary with elements that are roughly uniform in size, set by the value of Element size. Here, a grid has been created from a geological model with the Simplify boundary option enabled:

Disabling the Simplify boundary option results in more detail around the edges of the grid:

Element Size Settings

The Element size setting determines the basic size of the triangles that make up the grid, although the size will vary according to features applied to the grid and the Feature vertex snapping distance. The size will also vary if the Simplify boundary option is unticked, in which case the Element size setting is the maximum size of the triangles.

The Feature vertex snapping distance is automatically set to 1 percent of the Element size. To use a smaller snapping distance, untick the Auto box and set the value required. You cannot set a value that is larger than 1 percent of the Element size.

The effects of the Feature vertex snapping distance do not become apparent until features have been added to the grid.
Adding Features to the Grid

To add features to the grid, right-click on the grid in the project tree and select New Feature. The New FEFLOW Feature window will appear:

You can add Point, Line and Polygon features, and the Feature Object list will display all suitable objects available in the project. Ticking the Simplify Feature option will reduce the number of points used. Click OK to add the feature, which will appear in the project tree under the FEFLOW grid object:

You can edit the feature by double-clicking on it or by right-clicking and selecting Open. However, the feature has not yet been applied to the grid. To enable the feature, double-click on the grid to open the Edit 2D FEFLOW Grid window. Tick the box to enable the feature, then adjust the number of Refinement Steps:

More Refinement Steps will produce more detail near the feature. Click Apply or OK to view the effect the feature and its settings have on the grid.

If you want to modify a feature without having to reprocess the grid, untick it in the Features tab. If you want to delete a feature, right-click on it in the project tree and select Delete.
The images below show a grid displayed with collar points (in purple) to demonstrate the effects of no features and collars applied with different refinement steps:

<table>
<thead>
<tr>
<th>No features</th>
<th>Collars with 2 refinement steps</th>
<th>Collars with 10 refinement steps</th>
</tr>
</thead>
</table>

To view all features added to a grid, right-click on the grid and select **View Snapped Features**. A **Snapped Features** object will appear in the shape list that represents all objects used to add features to the grid:

Here, four snapped objects appear in the scene: the three features listed in the **Features** tab and the grid’s boundary.

See [Creating a 3D FEFLOW Model](#) for information on using the 2D grid as the basis for a 3D model.

**Creating a 3D FEFLOW Model**

This feature is only available as part of the Hydrogeology module. See [Flow Modelling](#) for more information.
To create a new 3D FEFLOW model, you must first create or import a 2D FEFLOW grid as described in Creating a 2D FEFLOW Model and Importing a FEFLOW Grid.

Once you have created or imported a 2D FEFLOW grid, right-click on the Hydrogeology folder and select New FEFLOW Model. The Extrude 3D FEFLOW Grid window will appear:

The dimensions and resolution of the grid are set by the 2D or 3D grid selected from the FEFLOW Grid list. See Creating a 2D FEFLOW Model for information on creating and refining a 2D grid that can be used as the basis for a 3D grid.

The Gridding from setting determines the geological model used for layer guides. Ticking the Evaluate Gridded Model box will evaluate the new 3D model against the selected geological model and set it as the evaluation for export. See Evaluating FEFLOW Models for more information. If you do not wish to evaluate the geological model on the grid, untick the box. You will still be able to use the layers in the geological model to control the grid layers.

The FEFLOW grid is initially made up of two layers equally spaced between the topography and the geological model, with the minimum thickness of each layer determined by the Minimum Thickness setting. You can add layers to the grid by clicking on the Select Layer Guides button and then selecting from the layers available in the geological model:
If the grid is required to follow a geological model lithology contact surface, move the layer into the Selected list and it will be honoured in the gridding process.

Click OK to return to the Extrude 3D FEFLOW Grid window. The selected layers will be displayed:

Click OK to generate the new FEFLOW grid, which will appear in the project tree under the Hydrogeology folder.

Once the model has been created, you can edit it by expanding the model in the project tree and double-clicking on its grid object. The layer guides selected, the number defined and the Minimum Thickness can be modified, but the FEFLOW grid on which the model is based and the geological model used for gridding cannot be changed.

The boundaries of the selected geological model must be larger than the FEFLOW grid used as the basis for the new model. If this is not the case, you can change the geological model’s extents so that they enclose the FEFLOW grid.

For further information on working with the new grid, see:

- Displaying FEFLOW Models
- Evaluating FEFLOW Models
- Setting Material Types for a FEFLOW Model
- Exporting a FEFLOW Model

### Evaluating FEFLOW Models

When a 3D FEFLOW model is exported, the evaluated geological model is used to assign lithologies to the blocks in the grid. If the grid has not been evaluated against a geological model, you must do so before you can edit the material types and before you can export the grid.

To evaluate a FEFLOW grid, expand the model in the project tree. Right-click on the grid object ((Grid Tool)) and select Evaluations. Although you can evaluate an interpolant or distance function, they cannot be exported with the grid and are simply used for displaying the grid in Leapfrog Geo.
A window will appear listing all objects in the project that can be used for an evaluation. Once you have selected one or more objects, click OK. You will then be able to select the evaluations from the view list, as described in Evaluating Objects.

Assigning an Evaluation for Export

For 3D grids created in Leapfrog Geo, the evaluation used when creating the grid will automatically be assigned as the evaluation for export. A material types table will appear in the project tree as part of the 3D grid.

If the grid was imported into Leapfrog Geo or created without being evaluated against a geological model, you will need to manually set the evaluation for export. To do this:

- Evaluate the grid against one or more geological models, as described above.
- Right-click on the model in the project tree and select Set Evaluation for Export. The Select Evaluation window will appear showing all geological models evaluated on the grid. Select the required evaluation and click OK.

A material types table will be added to the FEFLOW grid in the project tree. Edit material types by double-clicking on the table. See Setting Material Types for a FEFLOW Model.

Using a Combined Evaluation

You can combine geological models and set the priority used for evaluation. This is useful when you have geological models available that describe different parts of the area of interest or if you have a refined geological model for part of the model. To combine geological models for evaluation, select the required models in the Select Models To Evaluate window, then click on the Combined Evaluation button.

In this example, there are three geological models selected:

The GM and GM from contacts models describe similar areas, but GM has more detail. The GM larger model describes a larger area but with less detail. Tick the models to combine them and set their priority. Click OK to create the combined evaluation, then click OK in the Select Models To Evaluate window. The combined evaluation will be available from the view list.
The scene below shows an evaluation of these three geological models on a FEFLOW grid, where each model has been set to a single colour to show how the information from each model is combined:

The blue model has the highest priority and is used wherever there is information available. The green model has the lowest priority and is used when there is no information from higher priority models. This scene shows how the grid changes when the priority of the models is changed:

In this case, the purple model is now higher priority than the blue model and is used in preference to the blue model. The green model remains the lowest priority model.

A combined evaluation can be selected as the evaluation for export.

To delete a combined evaluation, click on the Delete Combined button in the Select Models To Evaluate window.

**Setting Material Types for a FEFLOW Model**

This feature is only available as part of the Hydrogeology module. See [Flow Modelling](#) for more information.

When a FEFLOW model is first evaluated against a geological model, a material types table is added to the FEFLOW grid in the project tree. You can edit material types by double-clicking on the table. You can also open the table by right-clicking on the grid and selecting Edit Material Types.

If the grid has been imported into Leapfrog Geo and has not yet been evaluated against a geological model, you will be prompted to do so. Expand the model in the project tree, right-click on the grid object and select Evaluate Geological Model. See [Evaluating FEFLOW Models](#) for more information.
In the **Edit Material Types** window, click in a cell to edit a property:

![Edit Material Types window](image)

Material properties are assigned to FLOW blocks based on the position of the block’s centroid relative to the geological model used to evaluate the grid. The position of the centroid is calculated and Leapfrog Geo then determines which lithology the centroid falls inside. The K values for the assigned lithology are assigned to the entire block; there is no averaging.

If more than one object has been evaluated on the grid, you can set material types separately for each evaluation. Select the required evaluation from the **Evaluation** dropdown list:

![Evaluation dropdown list](image)

However, the only material type information that will be exported is that set for the evaluation to be exported. Click **OK** to update the grid.

**Exporting a FLOW Model**

This feature is only available as part of the Hydrogeology module. See **Flow Modelling** for more information.

To export a 3D FLOW model as an ASCII format FLOW file (*.fem), right-click on the grid in the project tree and select **Export To FLOW**. You will be prompted to choose a **File name** and location. Select the options required, then click **Save**.

2D FLOW grids cannot be exported.
Importing and Creating Block Models

The Block Models folder can be used to import Isatis block models and evaluate them against geological models and interpolants. You can also create block models, which can then be exported for use in other applications. Creating block models within Leapfrog Geo has the advantage that the resolution can easily be changed.

Importing a Block Model

Leapfrog Geo imports block models in the following formats:

- CSV + Text header (*.csv, *.csv.txt)
- CSV with embedded header (*.csv)
- Isatis Block Model files (*.asc)

Importing an Isatis Block Model

To import an Isatis format block model, right-click on the Block Models folder and select Import Block Model. Select the file you wish to import and click Open. The model will be imported and added to the Block Models folder.

Importing a Block Model in CSV Format

Block models imported in CSV format must be regular, rotated only about the Z axis. You will also need to map the data in the file to the block model format Leapfrog Geo expects.

To import a block model in CSV format, right-click on the Block Models folder and select Import Block Model. Select the file you wish to import and click Open. An import window will be displayed in which you can map the columns in the file to those Leapfrog Geo expects. Once you have mapped the required columns, click Next to define the grid.

© 2014 ARANZ Geo Limited
In the next window, the data in the file is displayed and you can select the values to use in formatting the grid:

You can select information in the file and drag it to the corresponding values on the lefthand side:

You can also enter the grid definition values manually.
Once all required values have been copied, Leapfrog Geo will check the grid definition against the data in the file and confirm that the centroids match:

Click **Finish**. The block model will appear in the **Block Models** folder.

### Exporting a Block Model

There are two options for exporting a block model created in Leapfrog Geo: exporting the model in one of the supported formats or exporting the model as points.

### Exporting a Block Model in a Supported Format

Block models created in Leapfrog Geo can be exported in the following formats:

- CSV + Text header (*.csv, *.csv.txt)
- CSV with embedded header (*.csv)
- Isatis Block Model files (*.asc)
- Surpac Block Model files (*.mdl)
All evaluations on the block model will be exported as part of the file.
To export a block model in one of the supported formats, right-click on the block model in the project tree and select Export Block Model. You will be prompted to select the file format. Enter a name and location for the file and click Save.

**Exporting a Block Model as Points**

Block models can also be exported as points in CSV format, which does not include the block sizes and model description. To do this, right-click on the block model and select Export as Points. Next, enter a name and location for the file and click Save. You will then be prompted to select the CSV encoding.

**Creating a Block Model**

To create a new block model, right-click on the Block Models folder and select New Block Model. The New Block Model window will appear, together with a set of controls that will help you set the size, location and orientation of the model in the scene:

Use the controls in the scene to adjust the model size and extents or enter the information in the New Block Model window. You can set the extents from any object in the project by selecting that object from the Enclose Object list.
Set the Reference centroid by entering the coordinates in the New Block Model window or you can click on the select button ( ), then on an object in the scene.
The Round Out option rounds out the Base point coordinates and the Boundary size to a whole number of blocks.

When you first create a block model, choose larger values for the Block size as processing time for large models can be considerable. Once you have created a block model, you can change its properties to provide more detail, if required.
You can also evaluate the block model against geological models, interpolants and distance functions in the project. To do this, click on the **Evaluations** tab. All objects available in the project will be displayed. Move the models you wish to use into the **Selected** list.

Enter a **Name** for the block model and click **OK**. The model will appear under the **Block Models** folder. You can make changes to it by double-clicking on it.
Sharing Geochemical Data with ioGAS

With the Geochemistry folder, you can connect to ioGAS and analyse geochemical data. Data in ioGAS can be visualised in Leapfrog Geo and new lithology columns can be created. Data can also be sent to ioGAS for analysis, then visualised in Leapfrog Geo.

The Geochemistry folder and related features are only available as part of the Geochemistry module. Contact Customer Support as described in Getting Support for more information about licensing this module.

To connect to ioGAS, make sure ioGAS is running. Next, right-click on the ioGAS object in the project tree and select Connect:

Once the connection is established, any dataset open in ioGAS will be available from the ioGAS object:

The status of the connection to ioGAS is indicated for the ioGAS object, and data in ioGAS appears in the Geochemistry folder.

You can view the data in the scene by adding the ioGAS data object to the scene. When attributes are changed in ioGAS, the display will be updated in Leapfrog Geo. You can also:

- Import the ioGAS data into Leapfrog Geo. See Importing ioGAS Data as Points.
- Send lithology data to ioGAS. See Sending Lithology Data to ioGAS.

To terminate the connection to ioGAS, right-click on the ioGAS object and select Disconnect. Once the connection to ioGAS is terminated, ioGAS data will no longer be available in Leapfrog Geo.
Sending Lithology Data to ioGAS

This feature is only available as part of the Geochemistry module. See Sharing Geochemical Data with ioGAS for more information.

To send lithology data to ioGAS, you must first create a lithology column from the drillhole data in the project. To do this, right-click on the ioGAS object and select Select Columns To Link:

In the window that appears, select the table you wish to use for the Base table, then select the columns to send to ioGAS:

Enter a Name for the lithology and click Create. The new lithology will appear as part of the ioGAS folder. The data is now ready to be sent to ioGAS.

Opening the Data in ioGAS

Ensure that Leapfrog Geo is connected to ioGAS.

In ioGAS, select File > Open Link Data. If more than one lithology is available, a message will appear prompting you to choose which lithology to open.

Once the lithology has been opened, you can use the tools available in ioGAS to analyse the data. If you have the data visible in the Leapfrog Geo scene, changes made will be displayed in Leapfrog Geo.

Sending a New Data Column Back to Leapfrog Geo

To save the changes and send a new data column back to Leapfrog Geo, select one of the Make Variable From options from the Data menu in ioGAS.

The column will be added to the base interval table used to create the new lithology.

When the connection to ioGAS is terminated, the lithology object will remain in the project tree as part of the ioGAS folder. Data columns created in ioGAS will also be available and will appear in the base interval.
Importing ioGAS Data as Points

This feature is only available as part of the Geochemistry module. See Sharing Geochemical Data with ioGAS for more information.

When Leapfrog Geo is connected to ioGAS and a dataset is open in ioGAS, you can import the ioGAS data as points. To do this, right-click on the ioGAS data object in the project tree and select Import as Points:

In the window that appears, select the data columns you wish to import and how they will be imported:

Click Finish to import the data, which will appear in the Points folder. You can then display the points in the scene and work with them as you would any other points object. The new points object will remain in Leapfrog Geo once the connection to ioGAS is terminated.
Planning Drillholes

In Leapfrog Geo, you can plan drillholes, view prognoses for models in the project and export planned drillholes in .csv format. Leapfrog Geo can also import planned drillholes.

Planned drillholes are added to a project from the Planned Drillholes folder, which is in the Drillhole Data folder. When displayed in the scene, the planned drillhole is made up of a collar point, a target location and a path defined by lift and drift parameters:

You can change the default settings used for defining planned drillholes in the Drillhole Planning Options window. See Drillhole Planning Options.

Adding Planned Drillholes

To plan a drillhole, first add the data objects to the scene that you will use in helping to define the drillhole, such as the topography and any existing drillholes. Next, right click on the Planned Drillholes folder and select Plan Drillhole. In the window that appears, you can define the drillhole by specifying its collar or its target:
You can change whether Collar or Target is selected when this window is opened by clicking on the Defaults button. See Drillhole Planning Options.

A name is automatically generated for the new planned drillhole based on the drillhole IDs in the collar table. If there is more than one phase available, you can select a different phase from the dropdown list.

There are three ways to define the drillhole collar or target:

- Click in the scene to set the collar or target location. First, click on the Select button ( ) for the Collar or Target, then click in the scene to define the Collar or Target. The drillhole will appear in the scene and you can adjust the coordinates using the controls in the Drillhole Planning window. Click the Slice along drillhole button to draw a slice in the scene. This is useful in adjusting the drillhole path and in defining subsequent drillholes.

- Draw the drillhole in the scene. Click on the Select button ( ) for the Collar or Target, then click and drag in the scene to define a basic path for the drillhole. If you are defining the drillhole from the collar down, click first on or near the topography. Likewise, if you are defining the drillhole from the target up, click first at or near the target point.

- Enter the coordinates for the Collar or the Target in the Drillhole Planning window.

Clicking the Move collar onto the Topography button adjusts the elevation of the drillhole so that it lies on the topography.

Click the Next Hole button to create another planned drillhole. The new planned drillhole will be created at a specific distance from the currently displayed planned drillhole using the Path settings for the currently displayed drillhole. The distance is determined by the Offset To Next Hole settings in the Drillhole Planning Options window. See Drillhole Planning Options.

Once you have specified the collar or target, adjust the drillhole path:

- Lift is how much the drillhole deviates upward.

- Drift is how much the drillhole deviates laterally.

- Leapfrog Geo automatically calculates the Depth value when the drillhole is defined by the Target location.

- Adding an End of hole length extends the drillhole past the Target location.

Planned drillholes will appear in the Planned Drillholes folder. You can change a planned drillhole by right-clicking on it and select Edit Drillhole.
Drillhole Planning Options

When planning drillholes using the **Drillhole Planning** window, the **Path** values entered apply only to the current drillhole. If you wish to set default values for these parameters for new planned drillholes, either right-click on the **Planned Drills** folder and select **Edit Planned Drills Defaults** or click on the **Defaults** button in the **Drillhole Planning** window. The **Drillhole Planning Options** window will appear:

![Drillhole Planning Options](image)

Select whether new planned drillholes are specified by the **Collar** or by the **Target**.

In the **Drillhole Planning** window, clicking **Next** adds a new planned drillhole. In the **Drillhole Planning Options** window, the **Offset To Next Hole** values determine how far the new planned drillhole is from the selected planned drillhole.

Enter the information required and click **OK**. The new settings will be applied to the next new planned drillhole added to the project.
Viewing Drilling Prognoses

Planned drillholes can be evaluated against any model in the project. To view drilling prognoses for a drillhole, right-click on it and select Drilling Prognoses. The Drilling Prognoses window will appear:

You can display prognoses for different models by selecting them from the dropdown list. For interpolants, you can view a plot of the data by clicking on the Plot tab.

In each tab, you can copy the information displayed to your computer’s clipboard by clicking the Copy button. The information in the Data tab will be copied as tab delimited text, which can be copied into a spreadsheet application such as Excel. The plot displayed in the Plot tab will be copied as a bitmap image.

Exporting Planned Drillholes

To export planned drillholes, either right-click on the Planned Drillholes object and select Export Planned Drillholes or right-click on a planned drillhole and select Export. The Export Planned Drillholes window will appear:
Selecting a phase from the **Show Phase** list will select all planned drillholes in that phase. The total length will be updated as you add or remove drillholes.

In Leapfrog Geo, positive dip points down for planned drillholes. To invert the dip for exported planned drillholes so that negative dip points down, tick the box for **Invert dip on export**.

Click **Export**. You will be prompted for a filename and location.

## Importing Planned Drillholes

Leapfrog Geo imports planned drillholes from files in CSV format. The columns expected are:

- A drillhole identifier
- X-Y-Z coordinates for the planned drillhole
- Azimuth
- Dip
- Lift rate
- Drift rate
- Distance
- Extension
- Target Depth
- Comment

To import planned drillholes, right-click on the **Planned Drillholes** folder and select **Import Planned Drillholes**. If the drillhole IDs in the file are already in the project, you will be prompted to resolve the conflict:

You can:

- Rename the imported drillholes. Leapfrog Geo will automatically assign new names and import the planned drillholes.
- Exclude planned drillholes that already exist in the project. Planned drillholes will only be imported if they have an identifier that does not already exist in the project.
- Replace existing planned drillholes with the imported drillholes. Use this option if you are importing information previously exported from the project and subsequently updated in an external application.

Click **OK** to process the file.

If there are no conflicts, the planned drillholes will be imported and added to the **Planned Drillholes** folder.
Displaying and Presenting Data

Leapfrog Geo has a number of tools for displaying and presenting data for use in reports and presentations. You can:

- Create and export cross sections, fence sections and serial sections
- Create and export contours
- Render and save images for use outside of Leapfrog Geo
- Save scenes that demonstrate different aspects of the model and the model-building process. These scenes can then be saved as a movie or as a scene file that can be opened in Leapfrog Viewer.
Creating and Working with Sections

There are three types of sections in Leapfrog Geo:

- A typical cross section is a vertical plane with an image or geologic cross section applied to it. In Leapfrog Geo, this type of cross section can be created directly in the scene, from the slicer or from an imported image.

- A fence section deviates. In Leapfrog Geo, a fence section can be created from a polyline drawn in the scene or from any line object in the project.

- A serial section is a series of typical cross sections taken at an offset from a single base section.

Cross sections, fence sections and serial sections can be evaluated against geological models, interpolants and distance functions in the project, as described in Evaluating Objects. Cross sections and fence sections can also be evaluated against surfaces. Objects a section is evaluated on can be included when the section is exported.

There are two options available for exporting sections:

- The first option is to export the section as a DXF file (*.dxf). This option exports a series of DXF lines created from the intersection of the evaluation volumes and the section plane. The lines generated from each volume are saved as separate layers in the file. Right-click on the section in the project tree and select Export. You will be prompted to select an evaluation to export with the section. Enter a filename and location, then click Save.

- The second option for exporting a section is to create a section layout and then export it as a PDF file (*.pdf), Scalable Vector Graphics file (*.svg) or PNG image (*.png). This option is more flexible than exporting the section as a DXF file as you have more control over the section layout. You can customise the page layout and include multiple evaluations and annotations. For typical cross sections and serial sections, you can also display drillholes and planned drillholes. See Creating Section Layouts for more information.

© 2014 ARANZ Geo Limited
Creating a Cross Section in the Scene

To create a cross section in the scene, add a model to the scene. Next, right-click on the Cross Sections and Contours folder and select New Cross Section. The New Cross Section window will appear, together with a section plane and controls in the scene that let you adjust the position of the section plane:

The front (F) and back (B) of the section plane is indicated in the scene. To swap the front and back, click the Swap Front button.

Use the handles in the scene to position the section plane. The handles work in the same manner as the moving plane controls, as described in Using the Moving Plane.

Two buttons in the New Cross Section window let you create a cross section that is aligned north-to-south or east-to-west:

The other two buttons are active when the slicer is in the scene. Clicking the Set section to slicer button creates a cross section from the position of the slicer in the scene. If you then click the Lock section to slicer button, moving the position of the slicer will update the position of the cross section in the New Cross Section window.

If the slicer is already in the scene when you select New Cross Section, the position of the slicer will be used to define the initial orientation of the section. This is an effective way of creating a section from the
slicer: add the model to the scene, draw a slice and then create a cross section.

Once the section plane is positioned as required, click OK to create the new cross section, which will appear in the Cross Sections and Contours folder. Display it by clearing the scene, then adding the cross section to the scene.

Cross sections can be evaluated against geological models, interpolants, distance functions and surfaces in the project, as described in Evaluating Objects. Objects a cross section or fence section is evaluated on can be included when the section is exported.

Creating a Cross Section from an Image

To create a new cross section from an image, the image must first be imported. Right-click on the Cross Sections and Contours folder and select New Cross Section From Image. You will be prompted to select an image.

Next, the Import Image window will be displayed:

Cropping the image to only the area of interest will reduce video RAM usage and may improve graphics performance. To crop the image, click on the Crop Image button ( ), then drag around the part of the image you wish to use. Click on the Remove Crop button ( ) to clear the cropping.

If the image contains georeference data, it will automatically be added to the map and displayed. You can edit the imported georeference data by ticking the Override image's georeference data box, then editing the information.

If the image does not contain georeference information, you will need to add it manually by adding reference markers, as described in Importing Maps and Images. For an image marked as a Vertical Section, only two reference points are required.

Add the markers to the image and enter the coordinates. Selecting either East Facing Section or North Facing Section constrains the points. For example, for an east-facing image, you will only need to enter the East (X) coordinates once.
Once you have set the coordinates for each marker, click OK. The new cross section will be created and added to the Cross Sections and Contours folder. Display it by dragging it into the scene or by right-clicking on the cross section and selecting View Object. The cross section will appear in the scene.

Once you have georeferenced an image, you can export it as a GeoTIFF. To do this, right-click on it in the project tree and select Export. You will be prompted for a filename and location. Click Save.

Once you have created a cross section, you can edit it or use it to evaluate geological models, interpolants, distance functions and surfaces. See Evaluating Objects.

Creating a Fence Section

You can draw a polyline or use any existing line object in the project to create a cross section that deviates. To do this, right-click on the Cross Sections and Contours folder and select New Fence Section. The New Fence Section window will be displayed:

You can draw the polyline in the scene directly by selecting the New Polyline option. You can also use any polyline in the project by selecting the Existing Polyline option.

Only GIS lines, polylines imported into Leapfrog Geo or polylines created using the straight line drawing tool can be used to create fence sections.

Click OK to create the fence section. If you chose to create a New Polyline, the drawing controls will appear in the scene and you can begin drawing, as described in Drawing With the Straight Line Tool.

The fence section will appear under the Cross Sections and Contours folder and you can edit it by double-clicking on it. You can also use it to evaluate geological models, interpolants, distance functions and surfaces, as described in Evaluating Objects.

If you create a section layout for a fence section, you can include multiple evaluations and annotations on the section layout, but you cannot include drillholes and planned drillholes. See Creating Section Layouts.
Creating a Serial Section

A serial section is a series of cross sections taken at an offset from a single base section. To create a serial section, add a model to the scene. Next, right-click on the Cross Sections and Contours folder and select New Serial Section. The New Serial Section window will appear and planes representing the base section and the offset sections will be added to the scene:

Setting the Base Section

The handles in the scene control the position of the base section and work in the same manner as the moving plane controls (see Using the Moving Plane).

The front (F) and back (B) of the base section plane is indicated in the scene. To swap the front and back, click the Swap Front button ( ).

Two buttons in the New Serial Section window let you create a base section that is aligned north-to-south ( ) or east-to-west ( ). The other two buttons are active when the slicer is in the scene. Clicking the Set section to slicer button ( ) creates the base section from the position of the slicer in the scene. If you then click the Lock section to slicer button ( ), moving the position of the slicer will update the position of the base section in the New Serial Section window.

If the slicer is already in the scene when you select New Serial Section, the position of the slicer will be used to define the initial orientation of the base section.
Setting the Offset Sections

The number of offset sections is determined by the value of the Spacing setting and the Front and Back Extents:

You can change the number of offset sections by:

- Changing the Spacing setting. The number of offset sections will be recalculated and updated in the scene.
- Changing the Front or Back settings. For example, increasing the Front setting adds an offset section on the front of the base section, increasing the extents by the value of Spacing.
- Changing the object used to define the extents. Select an object from the Enclose Object list. The base section will be moved to the centre of the selected object.

Creating the Serial Section

Click OK to create the section. In the project tree, the serial section includes the individual cross sections:

The serial section can be evaluated against geological models, interpolants, distance functions and surfaces in the project, as described in Evaluating Objects.
Displaying a Serial Section

When you display a serial section in the scene, you can add the slicer to the scene and use it to move easily between the sections in the stack. To do this, click on the slicer in the shape list, then select the base section from the Set to list:

Next, set the Step size to the Spacing setting used to create the section. You can then use the < and > keys to view each individual cross section.

Exporting a Serial Section

The options for exporting serial sections differ for the section itself and the offset sections:

- A serial section cannot be used to create a section layout. When exported as a DXF file, the serial section will be exported in a single file with a collection of DXF lines based on intersections between the selected evaluation and the section planes.
- The offset sections that make up a serial section can be exported in both ways.

See Creating Section Layouts and Exporting a Cross Section.
Creating Section Layouts

With the Section Layout Editor, you can create a section layout for an existing section and then export the section. You can customise the section layout by:

- Adding models and surfaces the section has been evaluated against
- Adding drillholes and planned drillholes
- Changing the page size, orientation and margins
- Adding titles, a scale bar, legends, annotations and images, such as a standard form or logo

The appearance of all objects can be customised without changing how objects from the project tree are displayed in the scene.

Multiple evaluations can be displayed on the section. For example, here a geological model, an interpolant and multiple drillholes are displayed on the section:

 Formats the section layout can be exported in are:

- PDF file (*.pdf)
- Scalable Vector Graphics file (*.svg)
- PNG image (*.png)
Section Layout Checklist

Once you have created a section but before you start creating the section layout, take the following steps.

1. **Check the section’s extents and orientation.**
   The initial dimensions of the section on the page are determined by the size of the section plane, and its orientation on the page is determined by the front (F) and back (B) faces of the section plane. Here, the front and back faces of the section have been swapped, which results in the section displayed on the page being flipped:

2. **Check that the section has been evaluated against objects you wish to display on the page.**
   To do this, right-click on the section in the project tree and select **Evaluations** or **Evaluate Surface**.

3. **Add planned drillholes to the project.**
   Planned drillholes can be displayed on the section, but these must be defined before you start the process of laying out the section.
Creating a New Section Layout

To create a new section layout, right-click on an existing section in the project tree and select **New Section Layout**. The **New Section Layout** window will appear, together with the **Section Layout Editor**:

The settings in the **New Section Layout** window determine the basic section layout:

- The **Scale** settings determine the scale used to display the section on the page. As you change the scale settings, the layout of the section on the page will be updated in the preview. If you want a specific page size, select **Fit to Page** to set a scale that best fits the page width. You will be able to change the page margins once you have closed the **New Section Layout** window.

- The **Page Properties** settings determine the page size and orientation. If you wish to use a specific **Scale**, select the **Orientation** required, then click **Fit to Section** to choose the best page size.

- For **Evaluations**, select from the models and surfaces the section has been evaluated against. When you select a model or surface, it will be added to the preview. This is a useful way of seeing what objects you wish to include on the section. Note that when you add a model to the page, a legend for the model is also added.

- For **Extents**, choose whether to use the **Section Extents** or **Evaluation Extents**. If you wish to use the extents from a model evaluation, select only that model. Further models can be added to the page once the layout has been created.

All settings in the **New Section Layout** window can be changed once the layout has been created.

Changing how objects are displayed on the section page does not change those objects in the project.

As you add objects to the section, the preview in the **Section Layout Editor** window will be updated.
Click **OK** to close the **New Section Layout** window. You can then make further changes to the page layout in the **Section Layout Editor**. See **Using the Section Layout Editor**.

**Using the Section Layout Editor**

In **Section Layout Editor**, the **Layout Tree** shows the different layers that can be added to the page. The different parts of the **Layout Tree** as they relate to the page preview are shown below:

For more information about working with the different parts of the section layout, see:

- Setting Up the Page
- Organising the Section
- Organising the Legend Group
- Adding and Organising Annotations
Click on an object in the page preview to move or resize it. This will also select the object in the **Layout Tree** and you can see what properties can be changed. For example, in the preview, click on the **Title** to view its styling options:

The **Section** object controls all the models and surfaces displayed on the section:
Models and surfaces selected in the New Section Layout window are automatically added to the page preview:

Further objects can be added by right-clicking on Models, Drillholes or Surfaces. Entries have also been made for models and surfaces in the Legend Group:
Object Names and Colours

The names and colours of objects in the layout are linked to their parent objects in the project tree. You can override them by selecting the object in the Layout Tree, then ticking the Edit box:

If Edit is disabled for an object’s text or colour and changes are made to the parent object while the Section Layout Editor window is open, the changes will not be reflected in the section layout until it is next opened. If Edit is enabled for an object’s text or colour, then that property will not change when the parent object’s colour or title are changed.

Styling Layout Objects

All layout objects are styled by clicking on them in the Layout Tree, then adjusting their appearance in the properties panel.
Text displayed in the section layout is controlled by a style sheet that can be accessed whenever you are editing a text object. For example, clicking on Edit Styles for the Title opens the list of Text Styles with the Title selected, but also allows you to change the appearance of styles used for other text objects visible in the preview:

Line, border and swatch properties are also changed in the properties panel. Swatches for output volumes can be displayed using a hatched fill, which is enabled by clicking on the output volume in the project tree, then changing its properties:
The styling of objects in the Layout Tree controls how they appear in their associated legend. The Legend Group object controls the position and size of the legend, but not the colour, line style and fill used to display each object. For example, the appearance of the volume <0.5 in the interpolant is controlled from the Models object (left):

Whether or not the legend is visible on the page and how it is displayed is controlled from the Legend Group object (right).

When a model or other object is added to the section, a legend for that object is added to the Legend Group.

Some objects, such as models, drillholes and surfaces, occupy the same space on the page. These objects can be organised into layers, and opacity settings changed to emphasise relevant information. To change the order of objects on the page, right-click on them and select how you wish to organise the layers:
To change the opacity of an object, click on it, then adjust the object’s **Opacity** using the slider:

![Opacity slider]

**Setting Up the Page**

**Page Properties** are set in the **New Section Layout** window, but these can be changed in the **Layout Tree**. Click on the **Page** object to change the **Page Size**, **Orientation** and **Margins**:

![Layout Tree]

If you wish to use a specific **Scale**, select the **Orientation** required, then click **Fit to Section** to choose the best page size.

**Organising the Section**

The **Section** object controls the appearance of the section and the objects in the project that are displayed on the section. The properties for the **Section** object itself control the size of the section on the page and how the axes are displayed. Any changes made in these tabs are displayed in the preview so you can experiment with these settings.

- The **Section** tab includes the **Scale** settings from the **New Section Layout** window.
- The **Extents** tab includes the settings from the **New Section Layout** window and additional options for displaying **Additional sky** and end point labels.
The settings in the **X-Axis** and **Y-Axis** tabs determine how the axes are displayed. By default, the axes are displayed only on the lefthand side and along the bottom of the section. To display axes along the righthand side and above the section, tick the **Secondary** option.

The other objects that are part of the **Section** object are used to add models and surfaces that are displayed on the section and to customise how they are displayed. For cross sections and serial sections, you can also add drillholes and planned drillholes.

Changing how objects are displayed on the section layout does not change those objects in the project.

**Adding and Styling Models**

If you selected models and surfaces in the **New Section Layout** window, these are automatically added to the **Models** and **Surfaces** objects in the **Layout Tree**. To add more models, right-click on the **Models** object and select **Add Model**. The models the section has been evaluated on will be listed. Select those required and click **OK**. The new models will be added to the **Models** object and legend items added to the **Legend Group**.

If you selected a geological model with a fault system, the faults will automatically be added to the section and to the **Legend Group**. Change a fault system’s properties by expanding the geological model in the **Layout Tree** and clicking on the **Fault System** and its faults.

When you display multiple models on the section:

- Use the **Opacity** setting for each model to expose and emphasise information.
- Right-click on the models to move them up or down in the layer hierarchy.
- Expand each model in the **Layout Tree** to change the **Fill** and **Hatch** for each output volume to make some volumes more apparent.
- Hide some of the **Output Volumes**.
A single line style is used to display a model’s output volumes. There is, however, a Highlight option that can be enabled to make a volume of interest stand out from the other volumes:

The Opacity setting for each output volume in a model is inherited from the model as a whole. You cannot change the Opacity on a volume-by-volume basis; however, you can hide individual volumes.

For geological models with a fault system, the fault system does not inherit its Opacity setting from the parent model.

Adding and Styling Drillholes and Planned Drillholes

Drillholes and planned drillholes can be added to section layout for cross sections and serial sections, but not for fence sections.

Drillholes and planned drillholes can be added to the cross section. To do this, right-click on the Drillholes object and select either Add Drillholes or Add Planned Drillholes.

For adding drillholes, you will be prompted to select the interval table to display.
For both drillholes and planned drillholes, you can filter the drillholes based on a minimum distance from the section plane:

![Filtering drillholes based on distance](image)

This is the minimum distance to any point on each drillhole trace.

If you tick the **Clip geometry to filter distance** option, only parts of the drillhole within the **filter distance** will be included in the section layout.

Select the required drillholes and click **OK**.
When displaying drillholes, you can display up to three columns of data. This is controlled by the Colourings settings in the Lines tab:
Click the **Options** button for a column to filter values or display data on the drillholes:

**Adding and Styling Surfaces**

To add a surface to the section, right-click on the **Surfaces** object and select **Add Surface**. The surfaces the section has been evaluated on will be listed. Select those required and click **OK**.

The options for styling surfaces are the same as for lines. A surface can be displayed in the legend, if required.
Organising the Legend Group

The **Legend Group** controls how the legend is displayed on the page. When you add a model, surface or drillhole object to the section, a legend for that object will be added to the Legend Group. For example, here, legends have been added for an interpolant, the surfaces and drillhole data objects:

- The **Surfaces** that appear on the section have been added to a single legend.
- Because the drillholes displayed on the section use **Left** and **Centre Colourings**, a legend has been added for each.
Changing the Legend Group Layout

Select the Legend Group itself to change its layout. These settings apply to the Legend Group as a whole. Columns can be laid out vertically or horizontally:

You can also change the swatch size and gradient and add a Boundary box. For each individual legend, you can change the number of Rows used to display the values:

The order in which legends appear in the Legend Group is the order in which they appear in the Layout Tree. To change the order in which the legends appear, right-click on them and select a Move option.

Use the Legend Group Layout > Columns setting and the Rows setting for each individual legend to make the best use of the space available on the page.

Styling Legend Swatches

The colours, line widths, fills and hatches displayed in the Legend Group are controlled by the objects themselves. For example, to change how the < 0.5 shell is displayed for the interpolant, click on the output...
Making Legends Visible and Invisible

If you do not wish to include a legend in the **Legend Group**, click on it in the **Legend Group** and unclick **Visible**:

This does not change whether or not the object itself is visible, it simply excludes it from the **Legend Group**.
Adding and Organising Annotations

Once you have laid out the main Section object and organised the Legend Group, you can add a number of different types of annotation to the layout.

Title

The Title object formats the title displayed on the page. To move the title, click on it in the layout preview. The text used for the Title is the name for the section in the project tree, but this can be changed in the properties panel.

Title Block

The Title Block object adds a title block based on ISO 7200:

To display the Title Block on the section, select it in the Layout Tree, then tick the Visible box.

Scale Bar

The Scale Bar object controls the size and format of the scale bar. Its position is controlled by moving it in the preview.

Location

The Location object controls how location information is displayed.

© 2014 ARANZ Geo Limited
Text Boxes

With the **Text Boxes** object, you can add text boxes and arrows to highlight information and details on the section:

Arrows are connected to text boxes, and so initially only text boxes can be added. Right-click on a text box to add an arrow to it. When the **Automatic anchoring** option is enabled for an arrow, the arrow’s anchor will move when its associated text box is moved. If this option is disabled, the arrow will move when you move the text box, but you will have to place its anchor manually.

Images

If you wish to import an image such as a logo or map, right-click on the **Images** object and select **Add Image**. Navigate to the folder that contains the image file and select the file. Click **Open** to import the file, which will automatically be added to the section layout.

Exporting the Section Layout

Once you have finished adjusting the section layout, you can export it in one of the following formats:

- PDF file (* .pdf)
- Scalable Vector Graphics file (* .svg)
- PNG image (* .png)
Click the **Export** button ( metavariable ) to export the section:

![Section Layout Editor - Layout](image)

You will be prompted for a filename and location.

**Copying a Section Layout**

If you have already created a section layout and wish to reuse it for other sections, you can copy it to other sections.

Copying a section layout copies the evaluations used in the original section layout, together with the page size and orientation and the position of the Layout Tree objects on the page. How models, surfaces and drillholes are copied depends on the section to which the layout is being copied:

- All models and surfaces that can be displayed on the section will be copied.
- The drillholes copied to the layout will depend on whether or not a filter is set for the layout:
  - If no distance filter was set for the original layout, all drillholes selected for the original layout will be copied.
  - If a distance filter was applied to the original section, the filter will be applied and drillholes selected that are within that distance of the section to which the layout is being copied.

To copy a layout, right-click on the section you wish to copy the layout to and select **Copy Section Layout**. In the window that appears, select from the section layouts available in the project. A summary of the information that will be copied is displayed to help you choose which layout to copy. Click **OK** to copy the layout, which will appear in the project tree under the selected cross section. you can edit it by double-clicking on it.

**Exporting a Cross Section**

There are two options available for exporting cross sections:

- The first option is to export the cross section as a DXF file (*.dxf). This option exports a series of DXF lines created from the intersection of the evaluation volumes and the section plane. The lines generated from each volume are saved as separate layers in the file. Right-click on the cross section in the project tree and select **Export**. You will be prompted to select an evaluation to export with the cross section. Enter a filename and location, then click **Save**.

- The second option for exporting a cross section is to create a section layout and then export it as a PDF file (*.pdf), Scalable Vector Graphics file (*.svg) or PNG image (*.png). This option is more flexible than exporting the cross section as a DXF file as you have more control over the layout of the cross section. See [Creating Section Layouts](Link) for more information.

A serial section cannot be used to create a section layout. When exported as a DXF file, the serial section will be exported in a single file with a collection of DXF lines based on intersections between the selected...
evaluation and the section planes. The offset sections that make up a serial section can be exported in both ways.

**Rendering Images**

Leapfrog Geo can render high-quality images that you can save on your computer in a format that can be used in presentations and documents.

To save a rendered image, click on the **Leapfrog Geo** menu and select **Render Image**. Leapfrog Geo renders an image from the current scene window, then displays it in the **Render Image** window:

![Render Image Window](image)

Use the zoom tools at the bottom of the window to view the rendered image. You can change the image settings by:

- Selecting a new image size. To constrain the image's proportions when changing size, tick the **Keep aspect** box.

- Changing **Supersampling** options to smooth jagged edges. The highest sampling option (4x4) will take longer to process than the lowest sampling option or turning **Supersampling** off.

- Viewing the image with or without overlays. See [Changing Overlay Preferences](#) for more information about further customising the overlays displayed in the scene.

Click **Render** to render a new image with the updated settings. Once you are satisfied with the rendered image, click **Save**. You will be prompted to enter a filename and location.
Saving and Editing Scenes

A saved scene is a way of storing the shape list and settings so that the scene can be retrieved later. Saved scenes are the basis of scene files exported to Leapfrog Viewer and are also used in creating movies. See:

- Exporting Scenes to Leapfrog Viewer
- Creating and Exporting a Movie

A saved scene is, in effect, a bookmark of a specific view of the project data. When a scene is saved, comments can be entered documenting what is in the scene.

A saved scene does not maintain an independent copy of the data in the project. If the data changes, then the appearance of the scene will also change.

Saved scenes provide a stable point of reference in a project and can explain important aspects of the project, which is especially useful for explaining aspects of a model to others using the project or viewing scene files. To save the current scene, right-click on the Saved Scenes and Movies folder and select Save Current Scene. The Save Scene window will be displayed:

Enter a name and description for the scene and click OK. The scene will be saved and added to the Saved Scenes and Movies folder.

When you save a scene, the properties settings in the shape list are saved for the objects displayed in the scene. For example, if a lithology table is displayed with the legend in the scene, the legend will be displayed when the scene is restored. However, saved scenes do not store copies of the objects in the project tree, and objects deleted from the project tree are no longer available in saved scenes.

To edit a scene, double-click on it. The Edit Saved Scene window will be displayed and you can update the information.

To display a scene, drag it into the scene.

Creating and Exporting a Movie

Once you have a series of saved scenes (see Saving and Editing Scenes), you can use them to create a storyboard and export a movie.
To create a new movie, right-click on the **Saved Scenes and Movies** folder and select **New Movie**. A tab will open in which you can create a storyboard and edit how each scene and transition is displayed. You can detach the tab from the main window and work on scenes and create new scenes. Click the **Refresh Scenes** button to refresh the scenes in the movie tab when you have made changes.

Select the saved scenes you wish to add to the movie by clicking on them in the list, then click the **Add To Storyboard** button ( ). When subsequent scenes are added, transitions will be added to separate the scenes:

![Storyboard Example](image-url)

Change properties for the selected scene or transition, then click the play button ( ) to preview the settings. To preview the whole movie, click the **Select Whole Movie** button ( ), then click play.

Enter a name and description for the movie and click the **Save** button ( ). The movie will be saved in the **Saved Scenes and Movies** folder.

To export the movie, click the **Save and Export** button ( ). The **Export Movie** window will appear:
If you tick **Export frame images**, individual frames will be saved as images, together with the movie file. Click **Export**. You will be prompted to select a filename and location. Click **Save** to export the movie. Leapfrog Geo will then save the movie in the specified location, which may take some time.

**Exporting Scenes to Leapfrog Viewer**

Once you have a series of saved scenes (see [Saving and Editing Scenes](#)), you can use them to create a scene file that can be opened in Leapfrog Viewer.

To export a scene, right-click on the **Saved Scenes and Movies** folder and select **Export Scenes**. The **Export Scenes** window will be displayed, together with the **Select Scenes To Export** window:

Select the scenes you wish to export by ticking the box for each scene. Once you have selected all the scenes you want, click **OK**. The **Export Scenes** window will be displayed with the selected scenes listed:

If you tick the **Export hidden shapes** box, objects in the shape list that are not visible in the scene window will be included in the exported scene.
You can also export the data associated with the objects in the scene window, if required. To do so, select the **Export all data that appears when I click** option. If viewing the data is not required, or if you wish to keep sensitive data secure, select the **Export shapes only** option.

When the **Export all data that appears when I click** option is selected, all data represented by shapes in the exported scene will be accessible when the scene is opened in Leapfrog Viewer.

You can add more scenes to the list, if you wish, and change the order in which scenes will appear in the exported file. When you have the scenes arranged, click **Export**. You will be prompted for a filename and location.

Exported scenes cannot be reimported to the project.

Links to scene files can be included in HTML files using the following format:

```html
<a href="LeapfrogViewer:[path or URL]">link text</a>
```

Linked scene files will be opened directly in Leapfrog Viewer only from browsers that support custom URI schemes.

### Creating Contour Lines from a Surface

To create contour lines from a surface, right-click on the **Cross Sections and Contours** folder and select **New Contour Lines From Surface**.

The **Surface to contour** dropdown list contains all suitable surfaces in the project. Select the surface to use for the new contour and adjust the **Contour Spacing**, if required.

If you want to offset the contours by a vector, enter a **Contour offset** value.

Click **OK** to generate the surface.

You can edit the contours by double-clicking on them.

The new contours will appear in the project tree under the **Cross Sections and Contours** folder and can be exported to GIS packages.

### Exporting GIS Contours

To export a contour lines object, right-click on the contour lines object in the **Cross Sections and Contours** folder and select **Export**. The **Export GIS contours** window will be displayed:
Click **Export**. You will be prompted for a filename and location.